
 

Avaya™ Interaction Center 
Release 6.0
Avaya Agent User’s Guide

DXX-1001-03
Issue 1.0

June 2002



 2002, Avaya Inc.
All Rights Reserved
Notice
Every effort was made to ensure that the information in this book was complete 
and accurate at the time of printing. However, information is subject to change.

Preventing Toll Fraud
�Toll fraud� is the unauthorized use of your telecommunications system by an 
unauthorized party (for example, a person who is not a corporate employee, 
agent, subcontractor, or working on your company's behalf). Be aware that 
there may be a risk of toll fraud associated with your system and that, if toll 
fraud occurs, it can result in substantial additional charges for your telecommu-
nications services.

Avaya Fraud Intervention
If you suspect that you are being victimized by toll fraud and you need technical 
support or assistance, call Technical Service Center Toll Fraud Intervention 
Hotline at +1 800 643 2353.

Providing Telecommunications Security
Telecommunications security (of voice, data, and/or video communications) is 
the prevention of any type of intrusion to (that is, either unauthorized or mali-
cious access to or use of your company's telecommunications equipment) by 
some party.

Your company's �telecommunications equipment� includes both this Avaya 
product and any other voice/data/video equipment that could be accessed via 
this Avaya product (that is, �networked equipment�).

An �outside party� is anyone who is not a corporate employee, agent, subcon-
tractor, or working on your company's behalf. Whereas, a �malicious party� is 
anyone (including someone who may be otherwise authorized) who accesses 
your telecommunications equipment with either malicious or mischievous 
intent.

Such intrusions may be either to/through synchronous (time-multiplexed and/or 
circuit-based) or asynchronous (character-, message-, or packet-based) equip-
ment or interfaces for reasons of:

� Utilization (of capabilities special to the accessed equipment)
� Theft (such as, of intellectual property, financial assets, or toll-facility 

access)
� Eavesdropping (privacy invasions to humans)
� Mischief (troubling, but apparently innocuous, tampering)
� Harm (such as harmful tampering, data loss or alteration, regardless of 

motive or intent)
Be aware that there may be a risk of unauthorized intrusions associated with 
your system and/or its networked equipment. Also realize that, if such an intru-
sion should occur, it could result in a variety of losses to your company (includ-
ing but not limited to, human/data privacy, intellectual property, material assets, 
financial resources, labor costs, and/or legal costs).

Your Responsibility for Your Company's Telecommunications 
Security
The final responsibility for securing both this system and its networked equip-
ment rests with you - an Avaya customer's system administrator, your telecom-
munications peers, and your managers. Base the fulfillment of your 
responsibility on acquired knowledge and resources from a variety of sources 
including but not limited to:

� Installation documents
� System administration documents
� Security documents
� Hardware-/software-based security tools
� Shared information between you and your peers
� Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and your 
peers should carefully program and configure your:

� Avaya-provided telecommunications systems and their interfaces
� Avaya-provided software applications, as well as their underlying 

hardware/software platforms and interfaces
� Any other equipment networked to your Avaya products.

Avaya National Customer Care Center
Avaya provides a telephone number for you to use to report problems or to ask 
questions about your contact center. The support telephone number 
is 1-800-242-2121.

Ordering Information
Avaya Publications Center 
Voice: +1 800 457 1235 
International Voice: 410 568 3680 
Fax: +1 800 457 1764 
International Fax: 410 891 0207 
Email: totalware@gwsmail.com

Write: GlobalWare Solutions 
Attention: Avaya Account Manager
200 Ward Hill Avenue 
Haverhill, MA 01835 USA 

Order: Document No. DXX-1001-03, Issue 1.0, June 2002

To order product documentation online, go to 
http://www.avayadocs.com, click on Online Services, and select the appropri-
ate product group.

Warranty
Avaya Inc. provides a limited warranty on this product. Refer to the �Limited 
Use Software License Agreement� or other applicable documentation provided 
with your package to establish the terms of the limited warranty.

Avaya Web Page
http://www.avaya.com 

Trademarks
Avaya, Conversant, CustomerQ, Definity, DefinityOne, Nabnasset, Quintus, 
and WebQ are registered trademarks or trademarks of Avaya Inc. in the United 
States or other countries or both.

Portions of Avaya Interaction Center include technology used under license as 
listed below, and are copyright of the respective companies and/or their licen-
sors:

ActivePerl is a trademark of ActiveState Tool Corp. This product includes 
software developed by the Apache Software Foundation 
(http://www.apache.org/). Cognos, Impromptu and Powerplay are registered 
trademarks of Cognos Incorporated. YACC++ is a registered trademark of 
Compiler Resources, Inc. APEX, ComponentOne, VideoSoft, True DBGrid, 
VSVIEW, SizerOne, VS-OCX, VSFlexGrid, VSFORUM, VSREPORTS, 
VSDOCX, VSSPELL, and TrueDBList are either registered trademarks or 
trademarks of ComponentOne LLC. CT Connect, Dialogic, Intel, and Pentium 
are trademarks or registered trademarks of Intel Corporation or its subsidiaries 
in the United States and other countries. Hummingbird is a registered 
trademark of Hummingbird, Ltd. SearchServer is a trademark of Hummingbird, 
Ltd. RISC System/6000 and DirectTalk/2 are trademarks of International 
Business Machines Corporation in the United States or other countries or both. 
IBM, OS/2, AS/400, CICS, WebSphere, CT, VisualAge, and DirectTalk are 
registered trademarks of International Business Machines Corporation in the 
United States or other countries or both. Lotus and Lotus Sametime are 
trademarks or registered trademarks of Lotus Development Corporation and/or 
IBM Corporation in the United States, other countries, or both. VisualX is a 
registered trademark of Intergroup Technologies, Inc. ActiveX, Visio, Internet 
Explorer, Windows, Windows NT, Windows 2000, Win32s, SQL Server, 
Visual Basic, Visual C++, Outlook, and FrontPage are either registered 
trademarks or trademarks of Microsoft Corporation in the United States and/or 
other countries. TimesTen is a registered trademark of TimesTen Performance 
Software. Oracle is a registered trademark, and Oracle8i and 
Oracle® SQL/Services are trademarks or registered trademarks of Oracle 
Corporation. Rogue Wave and .h++ are registered trademarks of Rogue Wave 
Software Inc. SourcePro is a trademark of Rogue Wave Software, Inc. Siebel is 
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BEFORE YOU BEGIN

Typographical Conventions
This guide uses the following font conventions: 

Notes, Tips, and Cautions
Note:  A note calls attention to important information.

Tip:  A tip offers additional how-to advice.

Caution:  A caution points out actions that may lead to data loss or other serious problems.

Contacting Technical Support
If you are having trouble using Avaya software, you should:
1 Retry the action. Carefully follow the instructions in written or online documentation.

2 Check the documentation that came with your hardware for maintenance or hardware-related 
issues.

Font Type Meaning

code This font signifies commands, information that you enter into the computer, or 
information contained in a file on your computer.

italics This font is used to add emphasis to important words and for references to other chapter 
names and manual titles.

It also indicates variables in a command string.

jump Blue text in online documents indicates a hypertext jump to related information. To view 
the related material, click on the blue text.

!
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3 Note the sequence of events that led to the problem and the exact messages displayed. Have the 
Avaya documentation available.

4 If you continue to have a problem, contact Avaya Technical Support by:

� Logging in to the Avaya Technical Support Web site http://www.avaya.com/support/qq 
� Calling or faxing one of the following numbers from 8:30 a.m. to 8:30 p.m. (Eastern 

Standard Time), Monday through Friday (excluding holidays):
� Toll free in the U.S. only: 1-888-TECH-SPT (1-888-832-4778)
� Direct line for international and domestic calls: 512-425-2201
� Direct line for faxes: 512-997-4330

� Sending email with your question or problem to crmsupport@avaya.com. You may be asked 
to email one or more files to Technical Support for analysis of your application and its 
environment.

Note:  If you have difficulty reaching Avaya Technical Support through the above URL or email 
address, please go to http://www.avaya.com for further information.

Product Documentation
Most Avaya product documentation is available in both printed and online form. However, some 
reference material is available only online, and certain information is available only in printed 
form. A PDF document with detailed information about all of the documentation for the Avaya 
Interaction Center is included in the Doc directory on the product CD-ROM. This PDF document is 
also included on the separate documentation CD-ROM.

Readme File
The Readme file is an HTML file included on the Avaya Interaction Center software CD-ROM. 
This file contains important information that was collected too late for inclusion in the printed 
documentation. The Readme file can include installation instructions, system requirements, 
information on new product features and enhancements, suggested work-arounds to known 
problems, and other information critical to successfully installing and using your Avaya software. 
You may also receive a printed Addendum to the Readme, containing similar information 
uncovered after the manufacture of the product CD-ROM. You should review the Readme file and 
the Readme Addendum before you install your new Avaya software.

Electronic Documentation
The electronic documentation (in PDF or HTML format) for each Avaya Interaction Center 
product is installed automatically with the program. Electronic documentation for the entire Avaya 
product suite is included on the product CD-ROM and the documentation CD-ROM.

You can also view the documentation set online at http://www.avayadocs.com.

http://www.avaya.com/support/qq
http://www.avaya.com
http://www.avayadocs.com
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Printed Documentation
You can purchase printed copies of these manuals separately. For details, see �Ordering 
Information� on the back of this manual�s title page.

License to Print the Electronic Documentation
Online copies of documentation are included on the CD-ROM that accompanies every software 
release. An Avaya customer who has licensed software (a �Licensee�) is entitled to make this 
online documentation available on an internal network or �intranet� solely for the Licensee's use 
for internal business purposes. Licensees are granted the right to print the documentation 
corresponding to the software they have purchased solely for such purposes.

Right-To-Print License Terms 

Documents must be printed �as-is� from the provided online versions. Making changes to 
documents is not permitted. Documents may be printed only by any employee or contractor of 
Licensee that has been given access to the online documentation versions solely for Licensee's 
internal business purposes and subject to all applicable license agreements with Avaya. Both 
online and printed versions of the documents may not be distributed outside of Licensee enterprise 
or used as part of commercial time-sharing, rental, outsourcing, or service bureau use, or to train 
persons other than Licensee's employees and contractors for Licensee's internal business purposes, 
unless previously agreed to in writing by Avaya. If Licensee reproduces copies of printed 
documents for Licensee's internal business purposes, then these copies should be marked �For 
internal use only within <Licensee> only.� on the first page or cover (where <Licensee> is the 
name of Licensee). Licensee must fully and faithfully reproduce any proprietary notices contained 
in the documentation. The copyrights to all documentation provided by Avaya are owned by 
Avaya and its licensors. By printing any copy of online documentation Licensee indicates its 
acceptance of these terms and conditions. This license only governs terms and conditions of 
printing online documentation. Please reference the appropriate license agreement for terms and 
conditions applicable to any other use, reproduction, modification, distribution or display of Avaya 
software and documentation.

Educational Services
Avaya University provides excellent training courses on a variety of topics. For the latest course 
descriptions, schedules, and online registration, you can get in touch with us:
� Through the web at http://www.avaya-learning.com/logon_form.asp
� Over the telephone at 800-288-5327 (within the U.S.) +001 303-406-6089 (outside of the U.S.)
� Through email at Avaya.U.Helpdesk@accenture.com 

http://www.avaya-learning.com/logon_form.asp
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CHAPTER 1
OVERVIEW

The Avaya Agent, and its integrated component the Web Agent, are installed on your computer 
desktop, as part of the Avaya� Interaction Center (Avaya IC) software suite. The Avaya Agent 
and Web Agent make it possible for you to interact with your contact center�s customers. You may 
use one or more of the following media or features of the Avaya Agent and the Web Agent: 
Telephony, Email Management, Web Management, Outbound List Processing, and Avaya� 
Outbound Contact Management. 

This chapter briefly describes how the Avaya Agent and the Web Agent display customer contacts 
to you for these media. Subsequent chapters present instructions on how to use the two software 
components to handle your customer contacts.

With the Avaya Agent and the Web Agent, you can interact with customers in the following ways:
� Speak with customers whose inbound telephone calls are assigned to you (Telephony).
� Speak with customers who are called on the telephone by the software (Outbound Contact 

Management).
� Speak with customers whom you call on the telephone (Outbound List Processing).
� Reply to customer emails (Email Management).
� Chat with customers over the Web. If desired, speak to these customers on the phone while in a 

chat session with them, or share Internet browsers with them (Web Management).

Note:  In this manual, the illustrations show the Avaya Agent framework displayed on the right 
side and across the bottom of the desktop. The frames, panes, and dialog boxes that you see on 
your desktop may look different from the illustrations. Contact your system administrator if you 
need help understanding the setup of Avaya Agent that you see on your desktop. 
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Avaya Agent
The Avaya Agent is the application that enables you to handle incoming and outgoing contacts 
with customers. The Avaya Agent is displayed as a framework that surrounds the desktop on your 
computer monitor. You may see one or all of the following components on the Avaya Agent on 
your desktop:
� Media tab, which contains:

� Task lists where you receive telephone calls, emails, and chat requests assigned to you
� Softphone for speaking with customers who have called (inbound calls)

� Outbound Lists tab for manual outbound calling
� Outbound Contact tab for automated outbound calling
� Contact History Browser for information about previous contacts your customers have had 

with your company
� Prompter tab (located on the Contact History Browser) for scripts telling you what to say to 

customers
� EDU (electronic data unit) Viewer for information about your current contacts

The Web Agent opens within the Avaya Agent framework when you handle emails and chat 
sessions. For overview information about the Web Agent, see �Web Agent,� on page 24.

You may also work with other Avaya applications, such as CallCenterQ, HRQ, and Siebel Call 
Center, which open within the Avaya Agent framework. Similarly, other applications that you 
work with, such as Microsoft Word, may be set to open within the Avaya Agent framework.

Tip:  Press Alt+Tab to proceed through these applications while looking at the contact information 
displayed in the Avaya Agent. You can move the Avaya Agent behind the other applications by 
clicking to remove the check mark beside Always on Top in the Avaya Agent menu (see �Avaya 
Agent Menu,� on page 16). 
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The Avaya Agent with CallCenterQ in the desktop and the Email task list in the Media pane may 
look like this:

CallCenterQ application running in 
the desktop area

Contact History Browser

Avaya Agent menu 
button

Status Control bar in 
Media pane

EDU Viewer

Media tab

Email task list

Phone task list 

Chat task list 
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Using Avaya Agent with Multiple Languages
You may be able to communicate with customers in more than one language. The main features of 
the Avaya Agent and the Web Agent in which you may be able to use more than one language are 
as follows:
� CallCenterQ application
� Unified Agent Directory
� Email 
� Chat
� Spell checking of email and chat contents
� Auto-Sync and Page Push
� Global Resources and Agent Resources
� Email Templates
� Suggested Responses
� Web Self-Service database
� DataWake
� Chat transcripts that are emailed to customers

Avaya Agent Menu
You access the Avaya Agent menu by clicking the Avaya Agent button at the top of the right 
frame. The Avaya Agent menu includes the options shown in the following illustration and 
described in the following table:
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Avaya Agent Status Control Bar
When either the Media tab or the Outbound Contact tab of the Avaya Agent is selected, you see a 
Status Control bar with icons or buttons that display or control your current state and the work you 
can do. 

The Status Control bar displays different icons and buttons, depending on whether the Media tab 
or the Outbound Contact tab is selected. 

Media Tab

When the Media tab is selected, the Status Control bar displays an Agent button and a button (or 
icon) for each inbound media channel (Voice, Email, and Web Chat). (A button is different from an 
icon. You can press a button, which has a frame around it, to control your status. An icon does not 
have a frame around it and you cannot press it.)

The text below the Status Bar displays the following information:
� Your login ID 
� Your channel load in the media channels (the maximum number of customer contacts of each 

media channel that you can handle at a time)

Menu Item Action

Always on top When this item has a check mark, it ensures that the Avaya Agent always 
remains on top of other applications on your desktop. If you want the Avaya 
Agent to go behind other applications, click this menu item to remove the check 
mark.

Focuses Lets you select a new Business Application focus to display on your desktop. A 
focus is a window containing information that you use to complete a particular 
job. For example, CallCenterQ is a focus containing information you use when 
you respond to a request from a customer. It includes Request, Fulfillment, 
Order Entry, Locator, Task, Returns, Customer, and Prompter information.

Help Displays the Avaya Agent online help.

About Avaya Agent Displays information about this Avaya Agent application release.

Minimize Minimizes the Avaya Agent. To restore the Avaya Agent, click the Avaya Agent 
icon on the Windows task bar.

Exit Closes Avaya Agent, the Web Agent, and all open Avaya focuses.
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In the example below, Agent01 is currently available for Voice, Email, and Chat. This agent can 
handle up to one voice contact, one email contact, and three chat contacts at the same time.

Outbound Contact Tab

Click the Outbound Contact tab to see a Status Control bar with buttons related to outbound jobs.
 

 The Status Control bar buttons indicate whether you are available to handle outbound calls and 
identify the activities that you can complete during the call. The buttons guide you through the 
process of handling calls to customers that Outbound Contact Management initiates.

For more information on agent states, see �Changing Your Agent State,� on page 46. For more 
information on channel loads, see �Setting Your Channel Loads,� on page 49.

Task Lists
Depending on your company and your responsibilities, you may see any or all of the following 
task lists in the Media pane of your Avaya Agent:
� �Using the Phone Task List,� on page 73
� �Using the Email Task List,� on page 88
� �Using the Chat Task List,� on page 123

When incoming contacts are assigned to you, they are displayed in the appropriate task list. The 
task list also displays relevant information, such as the time the contact was assigned to you and 
the state of the contact. Some of the information is indicated by the icons that represent the 
contacts. 

Tip:  If you select a contact and hold your mouse over it for a moment, you will see a �tool tip� 
with some of the same information about the contact. This tool tip may be easier to read than the 
information within the task list and it may contain additional information.

Agent 
button

Channel loadsLogin ID

Avaya 
Agent
button
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To begin responding to an incoming contact, you must select the contact in the task list and 
double-click.

Softphone
Softphone makes it possible for you to perform standard telephone operations using your computer 
instead of a physical telephone. Your Softphone interface is in the Media pane of Avaya Agent. 
This interface contains the Phone task list and the telephony buttons that you use to manage your 
incoming and outgoing voice contacts.

The out-of-the-box Softphone interface in the Media pane is shown in the following illustration. 
Your Softphone may resemble the following illustration, or it may have a different set of buttons.

With the telephony buttons, you can perform various Softphone functions. These buttons can 
include:
� Answer 
� Hang Up 
� Hold
� Reconnect 
� Ready 
� Busy 
� Directory

Telephony buttons may be available or unavailable to you, depending on the current state of the 
active voice contact and on your agent state. For example, the Hold and Hang Up buttons are 
available only if the active voice contact is in an InCall state. If it is not in an InCall state, the Hang 
Up button is disabled (greyed out), and the Hold button is either disabled or replaced by the 
Reconnect button.

Hang up voice contact and 
enter WrapUp state

Phone task list with 
information about current 
voice contacts

Put voice contact on hold

Display Unified Agent Directory (UAD)
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By clicking the Directory button, you can access the Unified Agent Directory (UAD). From the 
UAD, you can do such things as transfer a voice, email, or chat contact; set up a conference call; 
initiate a telephone call to a colleague; look up agent information; address an email to a colleague. 

For information about the UAD, see �Using the Unified Agent Directory,� on page 56. For 
information about using the Softphone, see �Handling a Basic Voice Contact,� on page 75.

Outbound List Processing
The Outbound List Processing component is available through the Outbound Lists tab, which is 
beside the Media tab. Outbound List Processing gives you access to customer lists that you use 
with customer contact campaigns, such as outbound calling campaigns to notify customers about 
upcoming sales and marketing events.

Your system administrator creates the outbound lists in CallCenterQ, which then passes the lists to 
the Outbound Lists pane. Each outbound list contains a group of customers that are related in some 
way, such as customers located in the same area, or customers who have purchased the same 
product. The lists provide you with information like the following, which you can use during your 
interaction with the customer:
� Campaign name
� Marketing event
� List name
� Customer information
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The out-of-the-box Outbound List Processing component is in the Outbound Lists pane of Avaya 
Agent. When you click the Outbound Lists tab, the default Outbound Lists tab looks like this:
 For information about using the Outbound List Processing component, see Chapter 8, �Managing 
Outbound Lists�.

Avaya� Outbound Contact Management
Avaya� Outbound Contact Management (Outbound Contact) automates outbound calling 
activities. The software runs outbound jobs that dial customer telephone numbers and display 
customer information for you. A job is a list of customers to be called. When you join a job, you 
manage automated outbound calls. With Outbound Contact, you can spend more time helping 
customers and less time trying to call them.
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The Outbound Contact Management component is available through the Outbound Contact tab. 
The Outbound Contact tab display looks like this:

Outbound Contact Management enables and disables Status Control Bar buttons to guide you 
through the tasks as you handle calls. The coffee cup icon identifies your current agent state and 
indicates whether you are available to speak with customer. Your agent state can be one of the 
following three positions:
� Off Break (Available) � The coffee cup toolbar button is raised, indicating that you are 

available to handle outbound calls and speak with customers. 
� On Break (Unavailable) � The coffee cup toolbar button is depressed, indicating that you are 

unavailable to handle outbound calls or speak with customers.
� Disabled � The coffee cup toolbar button is greyed out, indicating that you have not joined a 

job.

The Outbound Contact tab displays the following information:
� Customer information in the CallCenterQ
� Other contacts with this customer in the Contact History Browser
� Agent script on the Prompter tab 
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For more information about using Outbound Contact Management, see Chapter 7, �Managing 
Outbound Contact Calls�. For information about setting your agent state, see �Changing Your 
Agent State,� on page 46.

Contact History Browser and EDU Viewer
You use the Contact History Browser and the EDU (electronic data unit) Viewer to locate 
information about the contacts in your task lists. Each tab in the Contact History Browser contains 
the history of a current contact in your task lists. Each tab in the EDU Viewer contains information 
about a different current contact in your task lists. The EDU Viewer identifies each contact by the 
EDU assigned to the contact by the Business Application.

The bottom frame of the Avaya Agent also contains buttons that you use to access the following:

Contact History Filter � Filters the records in the Contact History Browser to access only 
the historical information you need for the current customer contact.

Active Contact Viewer � Displays information about an active email contact from the same 
customer that was assigned to another agent.

Prompter Scripts
Your system administrator develops Prompter scripts to assist you while you handle contacts. Each 
script is designed to provide a consistent method for you and other agents to communicate with 
customers. It ensures that you obtain information from customers and give them other information, 
as your company requires. Prompter scripts may contain statements for you to say to customers. 
They may also contain radio buttons and text fields you use to indicate a customer�s answers, and 
a selection of reasons that explain the customer�s question and how you handled the contact.

You may use Prompter scripts to do the following:
� Collect information about customers
� Provide answers and information to customers
� Enter wrap-up information about a contact with a customer
� Contact a customer for a marketing or sales campaign

Each answer that a customer gives determines the next step in a Prompter script. For example, if a 
customer calls with a problem about a product they purchased from your company, the script is 
different for a customer who has a valid product warranty than for a customer who does not. 

A Prompter script may be displayed automatically at certain times, for example when you answer 
a customer contact or when you press the Next Call button in the Outbound Lists pane. 



Chapter 1   Overview

24 Avaya Agent User�s Guide

As shown in the following example from a Prompter wrap-up script,
Prompter scripts are displayed in the Prompter pane. In the out-of-the-box Avaya Agent, the 
Prompter pane is displayed in the frame that runs across the bottom of your desktop.

Web Agent
The Web Agent is the component of Avaya IC that makes it possible for you to interact with 
customers using Email Management or Web Management. With Web Management, you conduct a 
chat session with customers. While in a chat session, you can use the following features:
� Text Chat (exchanging typed messages with your customer in real-time)
� Voice Chat (talking to your customer, using either Chat & Phone or Chat & VoIP) 
� Shared Browsing (viewing the same Web pages with your customer, using the Auto-Sync, Page 

Push, and Collaborative Form Filling features) 

Customers send an email or initiate a chat session by clicking an appropriate button on your 
company�s Web site. According to your availability for email or chat, some of these emails and 
chat requests are assigned to you as email contacts or chat contacts. When you double-click a 
contact in your Email task list or your Chat task list, the Web Agent is displayed. The Web Agent 
is where you compose your email responses and conduct your chat sessions. 

When you log in to Avaya Agent, you log in to the Web Agent automatically. The Web Agent is 
minimized when you log in and appears as an icon in the Windows task bar, as shown in the 
following illustration. 

You can click the Web Agent icon to restore the Web Agent to its normal size at any time. The Web 
Agent also opens whenever you click an email contact or a chat contact in the task lists in Avaya 
Agent.
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Avaya Agent with the Web Agent and an active chat contact in the desktop looks like this:

The appearance of the Web Agent changes, according to what you are doing. This section explains 
the features of the Web Agent window while you are handling email or chat contacts. The section 
contains the following topics:
� The Web Agent While Handling Email
� The Web Agent While Handling Chat
� The Web Agent in Supervisor Mode
� The Web Agent Status Bar
� The Web Agent Information Bar
� Web Agent Menus
� The Web Agent Toolbars

Contact History Browser and Prompter EDU Viewer

Web Agent

Softphone

Email
task
list

Chat
task
list

and
Phone
task
list
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The Web Agent While Handling Email
If you are enabled for email, you will use the Web Agent together with the Avaya Agent to handle 
email contacts from customers. You will use two email views in the Web Agent:
� Email Preview � This is a read-only view of the customer�s email. If you click the Reply, Reply 

to All, or Forward buttons in the email toolbar, the view changes to the Email Compose mode. 
� Email Compose � This is where you write a reply to an email, forward an email you have 

received, or originate an email. 

You can switch between the two views by clicking the Preview tab or the Compose tab. If you are 
handling multiple emails simultaneously, each email will have its own Compose tab for your reply.

The following illustration shows an email reply that an agent is composing in the Web Agent.

The features of the Web Agent window that are common to the Preview and Compose views are as 
follows:
� Menu Bar � The names of three menus containing commands: Contact, Resources, and Tools. 

Click the name of a menu to open it and display the commands.
� Main Toolbar � Buttons below the menu bar for quick access to frequently used commands. 

The toolbar remains the same, whether you are currently in Email mode or a Chat mode. See 
�The Main Toolbar,� on page 34.

� Resource Toolbar and Filters � Buttons for resource-related commands and a Filter menu for 
displaying only the type of resources you want to see. See �Resource Toolbar,� on page 39.

Message
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Tabs for active email
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� Resource Area � Frame of window that contains resources, previously prepared text responses, 
emails, and URLs (Internet addresses), which you can send to customers. It may contain folders 
for each of the following: Agent Resources, Global Resources, Email Templates, and 
Suggested Responses. 

� Resource Preview Scroll Box � When you select a resource from a folder and then click the 
Preview Contents check box, a scroll box displays the contents of the resource. 

� Information Bar � An area that displays important information about the current email. If you 
switch to a chat contact, it displays information about your active chat. See �The Web Agent 
Information Bar,� on page 32.

� Status Bar � Icons that indicate certain aspects of your current Web Agent status. See �The Web 
Agent Status Bar,� on page 30.

The following areas are displayed only in Email Preview mode:
� Company Logo � Area that displays a logo that represents a company. If your contact center 

supports different companies or tenants, the logo may change, according to the Web site from 
which the customer sent the active email.

� Email Preview Toolbar � Toolbar with buttons that let you perform various actions to the email, 
such as reply to, forward, defer, resolve, or transfer the email, or view previous emails this 
customer sent to the contact center. See �Email Toolbars,� on page 35.

� Customer Email Header Area � Information about the customer�s email, consisting of the email 
address of the customer, any other addresses to which the email was sent, the date and time the 
email was sent, and the subject that the customer entered for the email. UAD buttons display 
the Unified Agent Directory to let you find and add addresses of people in your company. For 
detailed technical information on how the email was routed, click the Headers button.

� Customer Message Area � Box where you can read the customer�s email. You cannot edit the 
text in the message in Email Preview mode.

The following areas are displayed only in Email Compose mode:
� Email Compose Toolbar � The Email Compose toolbar contains buttons that let you perform 

various actions to the email, such as reply to, forward, defer, resolve, or transfer the email, or 
view previous emails this customer sent to the contact center. See �Email Toolbars,� on 
page 35.

� Drop-down Menu and Send Button � The menu lets you choose whether this is a normal reply, 
a message to an external agent, or a request to the customer for additional information. (An 
external agent is a person outside the company who has been designated as a subject matter 
expert who can help customers when agents request their assistance.) The Send button sends 
the email that is currently in the Message Composition area to the addresses in the header 
fields.

� Outbound Email Header Area � Tab that displays information about the email you are 
composing, with the addresses to which the email will be sent and the subject of the message.

� Attachments Area � Tab that lets you attach files to the email and displays information about 
any files you have attached.
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� Message Composition Area � Area where you compose an email. It may contain the message 
that you are replying to in addition to the message that you compose.

The Web Agent While Handling Chat
The following illustration shows the Web Agent window during a chat session.

The features of the Web Agent window in Chat mode are as follows:
� Menus � The names of menus that contain commands. Click the name of a menu to open it and 

display the commands.
� Main Toolbar � Buttons below the menu bar for quick access to frequently used commands for 

email or chat. See �The Main Toolbar,� on page 34.
� Resource Toolbar and Filters � Buttons for resource-related commands and a Filter menu for 

displaying only the type of resources you want to see. See �Resource Toolbar,� on page 39.
� Resource Area � Pane that contains resources, which are previously prepared text responses, 

emails, and URLs (Internet addresses) that you can send to customers. The resource area may 
contain folders for each of the following: Agent Resources, Global Resources, Email 
Templates, and Suggested Responses.

� Resource Preview Scroll Box (not shown) � When you select a resource from a folder and then 
click the Preview Contents check box, a scroll box displays the contents of the resource. 

� Company Logo � Area that displays a logo that represents a company. If your contact center 
supports different companies or tenants, the logo may change, according to the Web site from 
which the customer requested the current chat session.
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� Chat Toolbars � The main chat toolbar contains buttons for controlling the current chat session. 
Additional toolbars are added when you conduct a Chat & Phone or a Chat & VoIP session. See 
�Chat Toolbars,� on page 37.

� Send Bar � Buttons for sending a URL that opens in your customer�s browser and for sending 
the text you entered in the Text Entry area to your customer.

� Information Bar � An area that displays important information about your active chat session. 
If you switch to an email contact, it displays information about your active email. See �The 
Web Agent Information Bar,� on page 32.

� Customer Question � Area that displays the original question typed by the customer on the Web 
site. This area also displays other information about the customer and the site from which the 
customer requested the chat. This information can also help you identify guest users (people 
who log on to the company Web site without a user account).

� Transcript Area � Area that displays the chat conversation that has occurred so far between you 
and the customer.

� Text Entry � Area where you enter text or URLs to send to the customer.
� Status Bar � Icons that indicate certain aspects of your current Web Agent status.
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The Web Agent in Supervisor Mode
If you are a supervisor, you can click the Supervisor Mode button whenever you want to monitor a 
chat session. The Web Agent displays a Supervisor Mode panel, as shown in the following 
illustration, showing all the chat sessions that agents in your workgroup are currently conducting. 

When you select the session you want to monitor, the Transcript and Text Entry areas display the 
chat session. See �Monitoring a Chat Session (Supervisors Only),� on page 147 for more 
information.

The Web Agent Status Bar

The bottom of the Web Agent, as shown in the above illustration, contains a Status Bar with icons 
that show aspects of your current Web Agent status. The Status Bar remains the same, whether you 
are currently in Email mode or Chat mode.

Current chat sessions
Agent

Workgroup

Customer

Your workgroup 
Your login ID and status

Your current chat contact load
Connection to Email Server

Your supervisor�s login ID and status Your current email contact load

Connection to WebACD Server



Web Agent

Issue 1.0 June 2002 31

The following table describes the icons on the Web Agent Status Bar, from left to right.

Icon Description

WebACD 
Connection status

Shows the status of your connection to the WebACD Server (Web Automatic Call 
Distribution Server) with the following colors:
� Red � Your Web Agent is not connected to the WebACD server.

� Orange � Your Web Agent is in the process of connecting to the WebACD 
server.

� Green � Your Web Agent is connected to the WebACD server.

Email Server 
Connection status

Shows the status of your connection to the Email Server, which handles your email 
contacts. The colors are the same as for the WebACD Server.

Supervisor status

If you are an agent, shows your supervisor�s login ID and indicates whether the 
supervisor is currently online. The supervisor icon has a stripe on the shirt so you 
can distinguish it from your own icon. The shirt color indicates your supervisor�s 
login status, as follows:
� Grey � Your supervisor is not online.

� Red with yellow stripe � Your supervisor is online.

If you are a supervisor, the Status Bar does not have a Supervisor icon. 

Workgroup

The name of the workgroup to which you belong. The icon does not change color.

Agent status

Displays your login ID and login status with the following shirt colors: 
� Grey � You are not logged in to the Web Agent.

� Red/Yellow � You are logged in and available to take at least one contact.

Chat status

Shows your availability for chat and, if you are available, your chat channel load 
(the maximum number of chat customers you can currently handle at the same 
time). Zero means that you are currently unavailable to help chat customers. The 
icon does not change color.

Email status

Shows your availability for email and, if you are available, your email channel load 
(the maximum number of email customers you can currently handle at the same 
time). Zero means that you are currently unavailable to receive email contacts. The 
icon does not change color.
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The Web Agent Information Bar

The Web Agent has an Information Bar to call your attention to important information, whether 
you are in an email contact or a chat contact. The Information Bar may display messages like the 
following:
� �New inbound email from a customer.� 
� �New chat request from customer.�
� �This email will be sent to customer.�
� �Response rejected during quality assurance.�
� �Transfer request successful.� 

Web Agent Menus

The Web Agent has three menus, available from the menu bar at the top of the window: Contact, 
Resources, and Tools. Many of the menu options perform the same action as buttons in the 
toolbars. 

Tip:  You can use shortcut keys to access menus and their options quickly. To open a menu, press 
the Alt key and then the letter that is underscored in the menu name (Alt-T opens the Contact 
menu, Alt-R opens the Resources menu, and Alt-O opens the Tools menu). When the menu opens, 
you can use the shortcut key beside the option you want to select.

The menus are as follows:
� Contact menu � This menu displays commands related to chat and email contacts. The Print 

command prints whatever is displayed in the current window. When you have an active chat 
contact, you can use the Auto-Sync, Join Us, and Lotus Sametime (if installed) commands. See 
Chapter 5, �Managing Chat Sessions� for information on these features. You can use the Spell 
Check option at any time to check an email or a chat. You can use options to transfer, wrap, and 
complete a contact.

� Resources menu � A set of commands related to resources (pre-written text, URLs, and emails) 
that you can send to customers. With one set of options, you can create, delete, save, and view 
your own Agent resources. With the Expand All and Collapse All options, you can determine 
whether you view all resource folders or only the main folder (or folders). With the Filter 
option, you can limit the display to the types of resources you want to see. Note that a 
Resources toolbar above the Resource area has some additional commands related to resources.



Web Agent

Issue 1.0 June 2002 33

� Tools menu � A set of commands that help you do your work. The Agent Home command 
opens your Internet browser to Web pages designed for agents. The commands in the middle 
section of the menu are all related to the Web sites that customers visit. One command takes 
you to the current customer�s DataWakeTM record, which lists the URLs the customer has 
visited since they opened their browser. One command opens your browser to the customer 
Web Self-Service site where you can submit a document to be included on the database of 
frequently asked questions (FAQ). Another command lets you search the FAQ database for 
information. The Preferences command displays the preferences dialog box where you can 
customize the look of the Web Agent and set various options related to chat and email. 

The Web Agent Toolbars
The Web Agent has several toolbars containing buttons that you can click to perform commands. 
The main toolbar is always present near the top of the Web Agent. The other toolbars depend on 
your current customer interaction. There are toolbars for the following:
� Email Toolbars
� Chat Toolbars
� Voice Chat Toolbars
� Resource Toolbar 

Tip:  Any time you do not remember what a button does, hold your cursor over the button for a 
moment. The Web Agent displays either the name or a description of the button, as shown in the 
following illustration. It also shows the keyboard shortcut that you can use to perform that 
command, such as pressing the Control key, the Alt key, and then the letter �c� to switch to Chat 
Management.
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The Main Toolbar

You use the main toolbar in the Web Agent for both Email Management (email) and Web 
Management (chat). The buttons in the main toolbar let you quickly access frequently used 
commands that are also available in the menus. The buttons in the main toolbar, from left to right, 
are as follows:

Button Action

Chat Mode

Switches the Web Agent to the Chat mode. If a chat contact is selected in the 
Chat task list, the current chat session is displayed. If you are currently 
handling more than one chat session, you can switch from one session to 
another by changing the chat contact that is selected in the Chat task list.

Chat & Phone Mode

Switches the Web Agent to the Chat & Phone mode. This makes it possible 
for you to speak with a customer over the telephone while the customer 
remains in the chat session with you.

Chat & VoIP Mode

Switches the Web Agent to the Chat & VoIP Mode. This makes it possible for 
you to speak with your customer through a connection between your 
telephone and the customer�s Internet connection. While you speak with 
each other, you and your customer remain in the chat session together.

Email Mode

Switches the Web Agent to the Email Mode. If an email contact is selected in 
the Email task list, the current email is displayed. The email may be 
displayed in Email Preview mode or Email Compose mode, depending on 
your latest view of this email. If you are currently handling more than one 
email, you can switch from one email to another by changing the email 
contact that is selected in the Email task list.

Supervisor Mode

(Supervisors only. If you are not a supervisor, the button is disabled.) In this 
mode, a panel displays icons for the chat sessions that agents in your 
workgroup are currently conducting.

Agent Home Page

Opens your Internet browser and displays the Agent Home page, where you 
can search for documents to the frequently asked questions (FAQs) on the 
Web Self-Service pages or submit your own documents to these pages. Your 
documents will be reviewed by an administrator and may be accepted or 
rejected.
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Email Toolbars

The email toolbar has a different set of buttons, depending on whether you are looking at the 
customer�s email (in Email Preview mode) or composing an email reply (in Email Compose 
mode). 

Email Toolbar in Preview Mode

When you click an email contact in your Email task list, the Web Agent displays the customer�s 
email in Email Preview mode, as indicated by the tab above the email. This is a read-only view of 
the email. Above the tab is the Email Preview toolbar. The buttons in this toolbar, from left to 
right, are as follows:

Button Action

Print

Prints a paper copy of the text that is currently displayed in the Information Bar, the 
Header fields, and the Message Composition Area.

Reply

Displays the Email Compose mode of the Web Agent window. The default window 
in Email Compose mode is a Normal Reply, which addresses your reply to the 
sender of the email, and no one else. You can change this to Send to External 
Agent or Request Additional Information to compose those special types of email.

Reply to All

Displays the Email Compose mode of the Web Agent window and addresses your 
reply to the sender of the email and to all the people listed in the Cc (Copy) or Bcc 
(Blind Copy) fields of the message you are replying to.

Forward

Forwards a copy of this email to the people whose addresses you enter in the To, 
Cc, and Bcc fields. See �Forwarding an Email,� on page 107 for information.

Resolve

Lets you apply a status to the email. For example, you may use a status of Dismiss 
if a customer sends you a �thank you� and all the customer�s questions have been 
answered. See �Resolving an Email,� on page 112 for information.

Email History

Displays a dialog box with information about a specific email or information about 
any previous emails sent from the current customer�s email address. You can also 
see copies of the emails. See �Viewing Email History,� on page 91 for more 
information.
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Email Toolbar in Compose Mode

When you are viewing an incoming email in Email Preview mode and you click Reply or Reply to 
All, the Web Agent displays the email in Email Compose mode, as indicated by the tab above the 
email. This is where you compose your reply to the customer. Above the tab is the Email Compose 
toolbar. The buttons in this toolbar, from left to right, are as follows:

Transfer

Displays the Unified Agent Directory (UAD) so you can transfer this email contact. 
You can transfer it to a queue and let Avaya IC route the email to the first available 
agent in that queue. You may also be able to transfer it to a particular agent, 
supervisor, or external agent. 
For information, see �Transferring an Email Contact,� on page 105.

Defer

Puts the current email message on hold, giving you a chance to research the 
customer�s question or problem. The message you have composed is saved as a 
draft. For more information, see �Deferring an Email,� on page 106.

Wrap

Puts you in WrapUp state. While in WrapUp state, you cannot receive another email 
contact to replace this contact. You may be asked to fill out information about this 
email contact while you are in WrapUp state. For more information, see �Wrapping 
Up and Completing an Email Contact,� on page 120.

Complete

Closes this email contact and removes it from the Email task list. For more 
information, see �Wrapping Up and Completing an Email Contact,� on page 120.

Button Action

Print

Prints a paper copy of the text that is currently displayed in the Information Bar, the 
Header fields, and the Message Composition Area.

Save Draft

Saves a draft of the current email reply that you are composing. 
Note: Immediately after you save a draft, if you want to leave the email for a period 
of time and come back to it, use the Defer button.

Cancel

Cancels and deletes the email reply that you are composing.

Button Action
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Chat Toolbars

When you are engaged in a chat session, the main chat toolbar is located on the right side of the 
Web Agent above the chat transcript area. This toolbar contains buttons you use to control the chat 
session. The buttons in the toolbar, from left to right, are as follows:

Attach

Displays a dialog box where you can locate a file and attach it to the current email 
reply.

Spell Check

Displays a dialog box that helps you check the spelling of the current email reply, 
interactively.
Note: You can set a preference to have this spelling dialog box come up 
automatically after you click Send. See �Setting Preferences,� on page 165.

Email History

Displays a dialog box with information about a specific email or information about 
any previous emails sent from the current customer�s email address. You can also 
see copies of the emails. See �Viewing Email History,� on page 91 for more 
information.

Button Action

Print

Prints a paper copy of the text that is currently displayed in the Information Bar, the 
Transcript area, and the Text Entry area.

Start Auto-Sync

(You see this button when Auto-Sync is off.) Starts an Auto-Sync session so that your 
customer�s browser will display the same Web pages as your browser as you navigate 
through Web pages. See �Using Auto-Sync,� on page 129 for more information.

Stop Auto-Sync (You see this button when Auto-Sync is on.) Stops an Auto-Sync session.

Join-Us

Starts a Join Us session in which friends of your customer can join the chat session. See 
�Handling a Join Us Conference,� on page 144 for more information.

Button Action
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Voice Chat Toolbars

When you are in a chat session, you can handle two types of �Voice Chat�:
� Chat & Phone � You and your chat customer speak to each other over the telephone.
� Chat & VoIP � You speak to your chat customer over your telephone while your customer 

speaks to you over the Internet.

When you click the Chat & Phone button or the Chat & VoIP button to use those features, the chat 
toolbar displays a toolbar for those features. The Chat & VoIP toolbar is shown in the above 
illustration.

Sametime

Starts a Lotus Sametime session with your current chat customer. You can only use 
Sametime if it is installed and configured on your desktop. See �Setting Preferences,� on 
page 165.

Spell Check

Displays a dialog box that helps you check the spelling of text that you have typed in the 
Text Entry area before you send it.
Note: You can set a preference to have this spelling dialog box come up automatically 
after you click Say. See �Starting a Lotus Sametime Session,� on page 149.

Transfer

Displays the Unified Agent Directory (UAD) so you can transfer this chat contact. You 
can transfer it to a queue and let Avaya IC route the chat to the first available agent in 
that queue. You may also be able to transfer it to a particular agent, supervisor, or 
external agent. For information, see �Transferring a Chat Contact,� on page 142.

Wrap

Puts you in WrapUp state. While in WrapUp state, you cannot receive another chat 
contact to replace this contact. You may be asked to fill out information about this chat 
contact while you are in WrapUp state. For more information, see �Wrapping Up and 
Completing a Chat Contact,� on page 153.

Complete

(This button is only available after you have wrapped up the contact.) Closes this chat 
contact and removes it from the Chat task list. For more information, see �Wrapping Up 
and Completing a Chat Contact,� on page 153.

Button Action
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Resource Toolbar

Resources in the Web Agent are previously prepared text, emails, and URLs (Internet addresses) 
that you can send to customers whenever the information is needed. This saves you the time and 
the tedium that it would take to type the same information repeatedly. The Resources toolbar sits 
above the Resource area on the left side of the Web Agent. The buttons in this toolbar, from left to 
right, are as follows:

Button Action

Save

Saves the resources that you have created or modified.

Collapse All

Hides all resource folders under the single folder that contains them.

Expand All

Shows all resource folders and all their contents (subfolders and the resources 
themselves).

View

When you select a resource and then this button, the Resource dialog box opens to 
display the contents of the resource. You cannot modify the resource when you 
select this option.

Edit

When you select a resource and then this button, the Resource dialog box opens 
and lets you modify the contents of the resource if you want.

Delete

When you select a resource and then this button, the resource is deleted.
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CHAPTER 2
MANAGING AVAYA AGENT

This chapter provides you with step-by-step instructions for tasks that you do in Avaya Agent. 
These tasks apply to the three media channels (Voice, Email, and Chat). 

The tasks include: 
� Logging In and Logging Out 
� Setting Your Availability 
� Opening an Application Focus
� Viewing Customer and Contact Information
� Reloading Layouts in the EDU Viewer
� Using the Unified Agent Directory
� Using Screen Pops
� Wrapping Up Contacts

The chapter concludes with a Troubleshooting section with information about what to do if the 
Avaya Agent software stops responding. 

Note:  Depending on how your system administrator defined Avaya Agent for your company, 
some of the Avaya Agent components discussed in this chapter may not be available to you. 

Logging In and Logging Out
You must log in to Avaya Agent for every work session and log out to end the session. You must 
use a login ID and password to log in. You may need to choose a new password within certain 
periods of time, such as every 30 days.
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Your Avaya Agent and Avaya� Business Applications may use �free seating.� With free seating, 
your personal settings and preferences are attached to your login ID and password. Therefore, you 
can log in to different workstations at your contact center, and Avaya Agent and your Avaya 
Business Applications will open with your personal settings and preferences. 

Caution:  With free seating, you should only log in to one workstation at a time. If you want to 
change from one workstation to another, be sure to log out of the first workstation before you log in 
to the second one.

Note:  For information about your login ID and password, see your administrator.

When you log in to Avaya Agent, you also log in automatically to your other Avaya applications, 
such as an Avaya Business Application and Web Agent. Within Avaya Agent, you also log in to 
either Avaya� Outbound Contact Management (Outbound Contact) or the media channels (Voice, 
Email, and Web Chat).

Logging In to Avaya Agent
To log in to Avaya Agent: 
1 Double-click the Avaya Agent icon on your desktop.

If your desktop does not have an Avaya Agent icon, click Start > Programs > Avaya Interaction 
Center 6.0 > <name of the Business Application, such as CallCenterQ, CustomerQ, or HRQ>. 
Your login dialog box may look like this:

!

This area displays any 
status messages 
generated when you 
log in.
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2 In the Avaya Agent Login tab, enter your login ID and your password in the appropriate text 
box.

Tip:  The IC Data Source field has been set for you. You can ignore this field unless 
system administrators indicate that you should change it.

Note:  You may be required to change your password.

Avaya Agent automatically adds your login ID and password to the appropriate text boxes in 
the other tabs to log you in to the other channels. 

3 If your system includes Softphone, you may need to complete the additional fields in the 
Softphone tab. These fields may include the following:

4 Click OK.

If your login ID and password are valid, Avaya Agent is displayed on your desktop. Status 
messages show the progress of your login.

Note:  To use Outbound Contact, you must log in to Avaya Agent at the workstation 
that has the Phone Type assigned to your login ID. Contact your administrator if you 
cannot log in to Outbound Contact.

5 Check your Avaya Agent Status Bar, located at the top right of your screen, to confirm that you 
do not have all zeros for your channel loads. Your channel loads are the number of contacts in a 
media channel (Voice, Email, or Chat) that you can handle at the same time.

Note:  If your channel loads across all available channels are set to zero, contact your 
system administrator to make sure that the servers are running. If the servers are 
running, re-set your channel load (see �Setting Your Channel Loads,� on page 49). 

Field Name Field Description

Agent ID Logs you on to the telephone switch and makes sure that all voice contacts 
assigned to your Agent ID are sent to your telephone.

Agent Password Confirms your identity to the Automatic Call Distributor (ACD) telephone system.

Station ID Identifies the station or equipment number of your telephone.
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Logging In and Out of Media Channels
When you log in to Avaya Agent, you log in to all the media channels (Voice, Email, or Chat) for 
which you are enabled. However, you can also log in and out of individual media channels if you 
want to limit your contacts to one or two channels at a particular time. For example, you may want 
to log in to the voice channel and log out of email and chat channels. Then you will receive new 
voice contacts only. 

The login and logout options in the Avaya Agent pop-up menu change, depending on your current 
state in a media channel. For example, if you are logged in to the Email media channel, you see the 
Email Logout option in the menu, not the Email Login option.

Tip:  If you are logged in to either email or chat, you can see the following Web Agent icon 
displayed in the task bar. You can double-click this icon at any time to bring up the Web Agent.

Note:  When you log in to Outbound Contact, you cannot log in to the channels on the Media tab. 
For more information, see �Logging In to Outbound Contact,� on page 181 and �Logging Out of 
Outbound Contact,� on page 194.

To log in or out of a media channel:
1 Right-click any blank area of Avaya Agent to display the pop-up menu, shown in the following 

illustration.

Note:  If you are logged in to a channel, the menu option for that channel says 
�Login.� If you are logged out of the channel, the menu option says �Logout.�

2 From the pop-up menu, click one of the following:

� Email - Login (or Logout) � Lets you log in to (or log out of) the email channel and respond 
to email contacts.

� Softphone - Login (or Logout) � Lets you log in to (or log out of) the voice (telephony) 
channel and respond to voice contacts.

Click the appropriate menu option 
to log in or out of a media channel
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� Web - Login (or Logout) � Lets you log in to (or log out of) the chat channel and respond to 
chat contacts.

Note:  Only log out of a media channel if instructed to do so by your administrator or 
if you will be handling automated outbound calls using Outbound Contact.

3 In the Avaya Agent Login dialog box, enter your login ID, password, and any other information 
required for the media channel.

4 Click OK.

Logging Out of Avaya Agent
When you log out of Avaya Agent, you automatically log out of all your Avaya applications also. 
You may need to enter the reason that you are logging out of Avaya Agent.

To log out of Avaya Agent:
1 Click the Avaya Agent button at the top of the Avaya Agent.

2 Select Exit from the Avaya Agent menu.

3 If a Logout dialog box is displayed, select a reason. Then click OK.

Setting Your Availability
At any point in time, you are either available or unavailable to handle contacts in the media 
channels. If you are available, contacts are assigned to you by the system.

You can set two basic types of availability:
� Your channel loads � The maximum number of contacts you can handle in a media channel at 

any one time. For example, if you have a channel load of 3 emails, you could have a maximum 
of three emails assigned to you at one time.

� Your agent state � Whether you are available at a particular moment to handle contacts. Agent 
states are Available, Aux-work (Busy), and Init. aux-work (Transition between Available and 
Aux-work). Your agent state may apply to all media channels or to a single media channel.

You control your channel loads and your agent state through the Avaya Agent media frame, shown 
below

Right-click a channel button (voice, email, or chat) to

Maximum channel loads

change a channel load. 
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Changing Your Agent State
You can make yourself available or unavailable to receive voice, email, or chat contacts or to make 
outbound calls. Your current state of availability to handle contacts is called your agent state. 

The Agent button in the Status Control bar indicates your current agent state. If you are in 
automatic mode, when you click the Agent button, you set your agent state for all channels 
simultaneously. See �Changing State Across All Media Channels,� on page 47 for more 
information.

If your administrator has given you permission to enter manual mode, you can also change your 
agent state for single channels individually. This would allow you to click media channel buttons 
to make yourself Available for one channel (Voice, for example), while you are in Aux-work 
(Busy) for other channels (Email and Web Chat, for example). See �Changing State in a Single 
Media Channel,� on page 47 for more information.

The three agent states are shown in the following table:

For information on making yourself available for outbound calling through Outbound Contact, see 
�Joining Outbound Jobs,� on page 182.

Agent State Agent Button Description

Available You are available to accept new contacts. In manual mode, some 
media channels may be unavailable, as shown by an X on the 
buttons.

Aux-work (Busy) You are busy and are unavailable to accept contacts. In 
automatic mode, you are unavailable in all media channels so 
the Agent button and all media channels have an X. In manual 
mode, the Agent button and any unavailable media channels 
have an X. 
Click to enter Aux-work when you go to lunch, handle Outbound 
Contact calls, research a customer�s problem, or do any activity 
where you cannot handle a contact. Wrapping up a contact is not 
considered Aux-work.

Init. aux-work 
(Transition)

You are in a transition state between Available and Aux-work. 
For example, you have attempted to log out with one or more 
contacts that need to be wrapped up. In both automatic and 
manual modes, the Agent button has a grey X when you are in 
this state. 
At your contact center, you may need to enter the reason for 
entering Aux-work and wrap up all active contacts on your 
desktop.
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Changing State Across All Media Channels

Your mode of operation determines how much control you have over your agent state. Depending 
on how Avaya Agent is configured, you may work in either of the following modes of operation: 
� Manual mode
� Automatic mode

In automatic mode, the Agent button is the only one you can click. Click the Agent button until the 
icon changes to the desired agent state. The other media channels change to the same state. 

The Status Control bar for an agent in automatic mode set to Aux-work (Busy) in all media 
channels looks like this:

Changing State in a Single Media Channel

To change your agent state for one media channel (manual mode only):
� Click the media channel button on the Status Control bar until the button changes to the desired 

agent state:
� Available � The button does not have a yellow X.
� Aux-work (Busy) � The button has a yellow X.
� Init. aux-work (Transition) � The button has a grey X as your state changes between 

Available and Aux-work.

OR

� Right-click the media channel button in the Status Control bar. Then click the pop-up menu 
option to change your agent state for that media channel.

The pop-up menu options change according to your agent state for each media channel.

Click one of these menu options to 
change your agent state for that 
media channel
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Manual Mode
If your administrator has given you permission to use manual mode, you can set your agent state 
and channel loads manually. This means that you can reduce your channel loads if you want. In 
manual mode, you can also change each of the Voice, Email, and Web Chat channels individually 
from Available to Busy, and from Busy to Available. In other words, you can be Busy in one 
channel while Available in other channels. 

You must select a check box to enter manual mode. When you are in manual mode, the Status 
Control bar contains channel buttons that you can click. The following illustration shows the 
Status Control bar in manual mode:

In manual mode, you can do the following things:
� Set your agent state across all media channels
� Set your agent state for only one media channel
� Set your channel load

To enter manual mode:
1 Right-click in the Avaya Agent Status Control bar.

2 Click Options in the menu to open the Channel Load dialog box.

3 In the Channel Load dialog box, select the Manual Mode check box. 

4 Click Apply.

Note:  If you cannot access the Manual Mode check box, your administrator has set your channel 
load. Contact your administrator for further assistance.

Automatic Mode
In automatic mode, when you click the Agent button, you can only change your agent state across 
all media channels at the same time. You cannot change your agent state for a single channel. 
Therefore, you are always in the same agent state in all media channels. 

When you are in automatic mode, the Status Control bar on the Media tab has only button�the 
Agent button. The Voice, Email, and Web channels are icons that you cannot click.
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Setting Your Channel Loads
For each type of contact that you handle, you have a channel load, which is the number of contacts 
in that media channel that you are enabled to handle at one time. You may be able to adjust your 
channel loads, but they can never be higher than channel ceilings that your administrator set for 
you. (The channel ceiling is the absolute maximum number that you can ever handle at one time.)

For example, if your administrator has set up your account so that the channel ceiling for chat 
contacts is three, you may be able to set your chat channel load to three, two, one, or even zero. 
But with a ceiling of three, you can never handle four chat contacts. 

To be able to adjust your channel loads, your user account must be set up for permission to work in 
manual mode. If you can select the Manual Mode check box in the Channel Load dialog box, that 
means that you have permission to adjust your channel load.

To set your channel loads:
1 Right-click a media channel button in the Avaya Agent Status Control bar.

2 Click Options from the pop-up menu.

The Channel load dialog box is displayed.

3 Select the Manual Mode check box if it is not already selected. 

Note:  If you cannot select the Manual Mode check box, you cannot adjust your 
channel load. Contact your administrator for further assistance.



Chapter 2   Managing Avaya Agent

50 Avaya Agent User�s Guide

4 Enter the maximum number of contacts you want to be able to handle in the text box next to the 
appropriate channels. Click the up arrow to increase the number or the down arrow to decrease 
the number.

If the number stops changing when you click the arrow, you have reached the ceiling that your 
administrator set for you. For example, you may not be able to set more than 1 or 2 chats.

If any field is disabled, you are not set up to handle sessions in that channel.

5 Click Apply.

The Avaya Agent Status Control bar shows the channel loads that you entered, which is the 
maximum number of contacts that you can handle for each channel. The following illustration 
of the Avaya Agent Status Control bar shows that the agent can handle a maximum of 1 voice 
contact, 1 email contact, and 1 chat contact.

The Web Agent Status Control bar shows your current contact loads for chat and email, as set 
by the program rules. The routing servers can reduce this number at any time according to 
program rules that consider the number and type of contacts you are handling, the number of 
contacts currently in the system, and so on. Therefore, the numbers can change while you are in 
your current login session. Your current contact loads as shown in the Web Agent may be less 
than the channel loads shown in the Avaya Agent. The following illustration of Web Agent 
Status Control bar icons indicate a current contact load of 0 emails and 1 chat session. At the 
current time, this agent cannot receive any email contacts, but later he may be able to receive 
one again.

Opening an Application Focus
You can open a new Avaya Business Application focus from the Avaya Agent menu. (A focus is a 
window containing information that enables you to complete a particular job.) The first time you 
open a focus, it is maximized to use all available desktop space. If you resize the focus and save 
the settings (from the application�s Focus menu), the focus automatically opens in the size that you 
specified whenever you open the focus. 

Whenever you open Avaya Agent, your initial focus remains minimized on your task bar until 
Avaya Agent is running. Then the focus opens in the desktop. 

If you open a new focus, it opens on top of any open focuses in your desktop. For example, if the 
Avaya Agent focus is open in CallCenterQ and then you open the Customer focus, the Customer 
focus opens on top of the Avaya Agent focus.
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To open a new Avaya Business Application focus:
1 Click the Avaya Agent button. 

2 In the Avaya Agent menu, click Focuses.

3 From the Focuses submenu, click the desired application focus. 

Viewing Customer and Contact Information
When a contact arrives in the Avaya� Interaction Center (Avaya IC) contact center, an electronic 
data unit (EDU) is created for that contact. The application then forwards the contact to an 
available agent, using the rules that have been set up by your system administrator. 

The Avaya Agent on your desktop displays information about the currently active contacts that 
have been assigned to you. The task lists in the Media pane display the basic information about 
each contact. The Contact pane that is displayed near the bottom of the Avaya Agent contains three 
areas where you can access more detailed information: 
� The EDU Viewer displays detailed information about the active contact, including the creation 

date and time.
� The Contact History Browser provides information about previous contacts with the same 

customer.
� The Active History Browser becomes available only when another agent is currently handling 

an email contact with the same customer. The Active History Browser provides information 
about the other active email contact or contacts. 

To view the information in the Contact pane, click a contact in the task list to bring it into focus. 

Contact History Filter

Active Contact ViewerContact History Browser

EDU Viewer
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Viewing Active Contact Information
You can use the EDU Viewer for most information about your active contacts. You may need to 
check the Active Email Viewer to see all active email contacts.

Using the EDU Viewer Information

When you select a contact in a task list, the EDU Viewer brings the tab containing information 
about the active contact to the front.

Using the Active Contact Viewer

Another agent may have deferred an email contact from a customer that you are handling by voice, 
email, or chat. The agent who has deferred the email plans to reply to the customer at a later time. 
The deferred email remains in the other agent�s Email task list. Deferred emails are not displayed 
in the Contact History Browser because they have not been completed.

You can see information about the deferred email contacts in the Active Contact Viewer. For each 
active email contact from that customer in another agent�s Email task list, the Active Contact 
Viewer displays: 
� The date and time when the email contact was created
� Whether there are any attachments
� The contents of the �To� field 
� How many times the email contact has been forwarded
� The sender�s email address 
� The subject line

If the customer has several active email contacts in the system, information about each contact is 
displayed in a separate tab.

To view information about a deferred email contact:
1 Double-click the new email contact to open it in your desktop and view information about that 

contact in the EDU Viewer.

2 Click the Active Contact Viewer button, which is located between the two boxes in the Contact 
pane. 

Note:  If the button is disabled, there is no other active email contact from the customer in the 
contact center. 

If any deferred email contacts from this customer exist, the Active Contact Viewer dialog box 
opens and displays information about them.
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Viewing Contact History Information
The Contact History Browser contains information about completed contacts that your current 
customer has had with the contact center. Contacts that have not yet been wrapped up are not 
listed. 

The Contact History Browser contains a tab for each of your current contacts. Each tab contains 
the history of that contact, that is, the previous contacts the customer has had with the contact 
center. Avaya Agent automatically brings the tab for the active contact to the front of the Contact 
History Browser. To view information about another contact, click the appropriate tab. To view 
more details of a previous contact, double-click the email or chat contact in the Contact History 
Browser. 

Note:  Current information about an active customer contact does not appear in the Contact 
History Browser until you have wrapped up that contact.

The information you see depends on the type of contact:
� Voice contact � Provides only the information shown in the Contact History Browser.
� Email contact � When you double-click, displays the History dialog box, which contains two 

tabs: 
� Tracking Number History tab, which provides a more detailed description of each contact
� Customer History tab, which provides a detailed customer history

� Chat contact � When you double-click, displays your Internet browser and displays a transcript 
of the previous chat session.

Filtering Contact History Information

If the current customer has a large number of contacts in the Contact History Browser, you can use 
the Contact History Filter to filter records before they are displayed. For example, if you click 
Email in the Media Type filter and enter May 1, 2002 and May 31, 2002 in the Time filter, the 
Contact History Browser displays only email contacts received from a customer in the month of 
May. 

You can filter and display records by:
� Media type
� Date and time the contacts were received
� Last x contacts made by a customer (for example, the last five contacts)
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To filter contacts in the Contact History Browser:
1 Click the Contact History Filter button. This is the top button between the two boxes of the 

Contact pane. 

The Contact History Filter dialog box is displayed.

2 Select the Enable Filter check box for the desired filter or filters.

3 Complete the required fields for the selected filter or filters, as follows:

� Media Type Filter � Select Phone, Email, or Web from the Media Name list.

If you want to view contacts of all media types, do not click this filter.
� Time Filter � Click a start date and an end date in the drop-down lists. 
� Last N Contacts Filter � Enter a numerical value for the last number of contacts you want to 

view (for example, enter 10 to view the customer�s last ten contacts).

4 Click Set.

Clearing Contact History Filters

To clear all contact history filters:
1 Click the Contact History Filter button.

2 In the Contact History Filter dialog box, click Reset.



Reloading Layouts in the EDU Viewer

Issue 1.0 June 2002 55

Reloading Layouts in the EDU Viewer
In addition to displaying details of your current contacts in your task lists, the EDU Viewer 
contains the instructions that the software uses to display them. (The instructions are not visible to 
you.)

If your administrator instructs you to clear all current contacts from the EDU Viewer or to reload 
updated layouts, you use options in a pop-up menu to do these tasks, as described in the following 
sections.

Clearing Current Contacts in the EDU Viewer
You use the EDUViewer - Reset command to clear all tabs of the EDU Viewer.

Note:  Only use the EDUViewer - Reset command if your administrator instructs you to do so.

To clear your current contacts:
1 Right-click in an empty part of the Avaya Agent.

2 Click EDUViewer - Reset from the menu. 

3 Click OK.

Reloading EDU Viewer Layouts
You use the EDUViewer - Reload Layouts command to reload the EDU Viewer formats onto your 
desktop after your administrator has changed them.

Note:  Only use this command if your administrator instructs you to do so.

To reload the EDU Viewer formats:
1 Right-click an empty part of the Avaya Agent.
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2 Click EDUViewer - Reload Layouts from the menu. 

The revised templates are loaded onto your system.

3 Click OK.

Using the Unified Agent Directory
The Unified Agent Directory (UAD) is a directory full of information about resources in your 
contact center. Depending on the set-up at your company, the UAD may contain information about 
the following:
� Queues, which are groups of agents with certain similar skills or knowledge that are used for 

routing contacts
� Agents, including: 

� Administrators
� Supervisors
� External agents, who are people, usually outside of your company, who possess special 

knowledge or skills
� Agents with particular skills, such as speaking other languages or knowing a particular 

operating system
� �Devices� that handle customers automatically, such as IVRs (Interactive Voice Response 

Units)

The UAD offers several methods of looking up information, such as using the Find dialog box to 
do a search for specific types of agents and saving your search as a new tab on the UAD. It is a 
good idea to become familiar with these methods. See �Looking Up Information,� on page 58.
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You can use the UAD in various ways, depending on how it is set up at your contact center and 
what you want to do. An agent is using the UAD in the following illustration to initiate a voice 
contact:

You can use the UAD for the following purposes:
� �Looking Up Information,� on page 58
� �Initiating a Voice Contact,� on page 81
� �Transferring a Voice Contact,� on page 77
� �Transferring a Chat Contact,� on page 142
� �Sending an Email to an External Agent,� on page 103
� �Transferring an Email Contact,� on page 105
� �Originating an Outbound Email,� on page 113

Task description

Selected item

Text field for name, address,
telephone number

Command buttons for various operations, depending on media and task you are performing

Tenant

Tabs

Workgroup
Agent

Site menu Menu of current contacts
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Looking Up Information
Whether or not you are currently handling contacts, you can use the UAD to look up information 
about resources at your company. You may be able to find contact information, such as email 
addresses and phone numbers, of other agents, supervisors, external agents, or agents with 
particular skills. 

This section explains how to look up information in the UAD, under the following topics:
� �Looking Up Queues with the Queues Tab,� on page 58
� �Looking Up Agents with the Agents Tab,� on page 59
� �Looking Up Agents with the Find Option,� on page 62
� �Filtering Data Displayed in Tabs,� on page 60
� �Updating UAD Information,� on page 66

To display the UAD, click the Directory button on the Avaya Agent. Your UAD may have the 
following tabs:
� Queues tab � The UAD always has a Queues tab. When this tab is selected, the UAD displays 

queues. For example, there may be a Hardware Sales queue, a Software Sales queue, a 
Hardware Support queue, and a Software Support queue, each containing agents who handle a 
particular type of customer.

� Agents tab � The UAD on your desktop may or may not have an Agents tab. If the tab is 
present, it contains lists with many items of information about the Avaya IC users in your 
contact center. 

� Contact list tabs for individual workgroups � Your contact center may have set up contact list 
tabs in the UAD. Each contact list tab contains information about agents in a specific 
workgroup. For each agent, the contact list shows the agent�s login name, display name, and 
primary email address.

Looking Up Queues with the Queues Tab

The Avaya IC software routes incoming customer contacts to various queues. A queue is a group 
of agents with similar skills and knowledge assigned to handle specific types of customer contacts. 
For example, there may be a Hardware Sales queue, a Hardware Support queue, a Software Sales 
queue, and a Software Support queue, each containing agents who handle a particular type of 
customer. 

The Queues tab of the UAD lists the queues that administrators at your contact center have set up 
in the database and marked for inclusion in the UAD (marked as �addressable�). Queues include 
agents enabled to handle a single media type (Voice, Email, or Chat) or the combination of Voice 
and Chat. 

You use the Queues tab when you want to transfer a voice contact or email contact to a queue. The 
transfer will be assigned to the first available agent in that queue. (Chat is the exception. You 
cannot transfer a chat contact to a queue.) For information, see �Transferring an Email Contact,� 
on page 105 or �Transferring a Voice Contact,� on page 77.
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By default, the Queues tab displays only the queues that handle the same media channels that you 
are currently handling. If you want to change what is displayed in the Queues tab, see �Filtering 
Data Displayed in Tabs,� on page 60.

Looking Up Agents with the Agents Tab

If your UAD has an Agents tab, you can use it to look up information about people who work for 
the contact center. Typically, you will find the following types of information about each person 
who is listed in the Agents tab: General agent information (such as last name, first name, login ID)
� Telephone numbers (such as primary, secondary, mobile, pager, and fax)
� Email addresses (such as internal and personal)

If your UAD does not have an Agents tab, use the instructions in �Looking Up Agents with the 
Find Option,� on page 62.

To look up agent information in the Agents tab of the UAD:
1 Click the Directory button in the Avaya Agent Media pane.

The UAD is displayed.

Your Unified Agent Directory may look like this when you open it.
 



Chapter 2   Managing Avaya Agent

60 Avaya Agent User�s Guide

2 Click the Agents tab (or the tab of a workgroup, if you have one you want to use).

The tenant and workgroups that you belong to, and the agents within these groups, are 
displayed in a tree structure in the left side of the window. A house icon represents tenants and 
an icon of a folder beside an agent represents workgroups.

Note:  A tenant may be a company, a location (such as New York or Boston), or a 
workgroup (such as Sales or Support). 

3 If the person you are looking for does not belong to this tenant or these workgroups, make an 
appropriate selection from the Site drop-down menu. If you are not certain which of these 
tenants and workgroups the person belongs to, select All Sites.

4 Navigate through the tree structure on the left. Click on the plus button (+) beside any tenant or 
workgroup to display its contents. Use the scroll bars as necessary to see more information. 

A red icon of a person represents an agent. There may be two side-by-side icons for an agent. 
Agents who have logged in have an agent state, and the first icon indicates that agent state, as 
follows:

� Agent head with check mark = Available
� Agent head with a yellow X = Aux-work (Busy)
� Shaded out agent head = Logged-out

5 When you find the name of a person you want information about, right-click the name and click 
Properties.

The Properties dialog box is displayed for this person. 

6 Click the appropriate tab in the Properties dialog box to find the desired information about this 
person.

Tip:  If you leave the UAD open for awhile, the information may not be current. You can right-
click a workgroup and select Update to update the information in that workgroup. For more 
information, see �Updating UAD Information,� on page 66.

Filtering Data Displayed in Tabs

You can use the Filter dialog box to modify what you see in the Queues tab and the Agents tab of 
the UAD, as follows:
� Queues tab � You can filter queues displayed in the Queues tab by media type only. By default, 

the Queues tab displays only the queues that handle the media that you are currently handling. 
For example, if you are currently handling a voice contact, you only see queues of agents who 
handle Telephony. If you are currently handling both Voice and Chat, you only see queues for 
those two media. If you change your active contact from one media type to another while 
displaying the UAD, the queues that you see change to that media type as well.

� Agents tabs � You can filter agents displayed in the Agents tab by the media type that they 
handle, their current agent state, and their agent type. 
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To filter queue or agent information:
1 Click the Directory button on the Avaya Agent to display the Unified Agent Directory (UAD). 

2 Click View > Filter.

The Filter dialog box is displayed. 

Note:  If you do not see a Filter item in the UAD View menu, or if the Filter item is 
not enabled, your contact center does not use this feature.

3 If you want to modify the display of the Queues tab, take the following steps:

a In the Media Type frame of the dialog box, select or de-select the types of media whose 
queues you want to be displayed.

b In the Agent Type frame, select Specific Agents and then Device. 

Note:  This is the only selection that applies to the Queues tab. Any other selections 
in this dialog box are ignored when you select Device.

c Click Apply.

4 If you want to modify the display of the Agents tab, do the following:

a Click the Media Type check boxes as desired. Agents who handle the media types that are 
checked will be displayed in the Agents tab.
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b If you want to narrow your search to display only external agents or supervisors, select 
Specific Agents and then select either of those check boxes, or both check boxes.

Note:  The Devices selection is related to the display of the Queues tab, not the 
Agents tab. External agents are people, usually outside of your company, who have 
possess special knowledge or skills. They have been appointed as external agents to 
assist agents with customer questions and problems.

c If you want to include only those agents who are currently Available, Busy (in Aux-work), 
or Logged Out, select those agent states.

5 Click Apply.

The tabs are updated according to your selections.

Looking Up Agents with the Find Option

The Find option offers another method of looking up information about agents at your contact 
center. With this dialog box, you can search for agents in the following ways:
� Media type (Voice, Email, or Chat)
� Agent type (External, Supervisor, or Device)
� Current agent state (Available, Busy, or Logged Out)
� Skills (such as knowledge of a language or an operating system) and skill proficiencies
� Personal information (First Name, Last Name, and so on)

The Find option finds three pieces of information about each agent: login ID, display name, and 
media types that are enabled. 

You can save the results of each search as a tab that is added to the main UAD dialog box. The tab 
lists all the agents found in the search but provides only their login ID. This can help you find an 
agent for a specific need when you need one, such as an agent who is proficient in a specific 
language. For example, if you occasionally receive voice contacts from people who speak 
German, you could create a German tab for all available agents who speak German proficiently 
and who handle Voice. Then when you need to transfer a call to a German speaker, you can find 
one in your tab.

Note that the agent state is not updated in the tabs you create. An agent who was available when 
you created the tab may not be available when you use it later. See �Updating UAD Information,� 
on page 66.
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To look up agent information with the Find option:
1 Click the Directory button on the Avaya Agent to display the Unified Agent Directory (UAD). 

2 Click View > Find.

The Specify Search Criteria dialog box is displayed. 

Note:  If you do not see a Find item in the UAD View menu, or if the Find item is not 
enabled, your contact center does not use this feature.

3 From the Site menu, select the location that you want to include in the search.

Tip:  You can use any of the three tabs (Agents, Skills, or General) in the Specify 
Search Criteria dialog box to select the criteria that will be used to search for the 
person you are looking for. The tabs are cumulative, that is, the search will only find 
agents that meet the criteria you select in all the tabs when you click the Find Now 
button. 

Note:  Go the appropriate step below about the tabs you want to use. Skip the steps 
about tabs you do not want to use.

4 Agents tab � Select all the criteria that you want to include in the Agents tab, as follows:

a In the Media Type section, select the media that agents you are looking for are enabled to 
handle.

b In the Agent Type section, select External or Supervisor if you want to find only external 
agents or supervisors. Select Device only if you want to find or non-human resource like an 
IVR queue.

Search Results 
Number will appear 
here. Change to a 
name for new tab.
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c If you want to include agents who are currently Available, Busy (in Aux-work), or Logged 
Out, select those agent states.

5 Skills tab � If you want to search for agents with certain skills, such as agents who speak 
certain languages or agents who support a certain operating system, click the Skills tab and do 
the following:

a If necessary, navigate through the folders. 

b When you find the skill you want, double-click to select it. 

The selected skill moves to the right side of the dialog box. 
c Select a Range (> for greater than; = for equal to, or < for less than) and a Proficiency rating 

(Expert, High, Low, or Medium) to indicate the level of proficiency you desire, by clicking 
in the appropriate columns to bring up a menu and making your selections.

6 General tab � If you want to find a specific person, click the General tab and enter any 
information that you know about the person in the appropriate text box.

Note:  The information is case-sensitive. If a person�s name is Bob, your search will 
not find him if you type bob instead of Bob. 

Search status

Proficiencies
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7 Click Search Now whenever you have entered all the desired search criteria.

When the search is complete, the dialog box expands to display your search results. 

Tip:  You can always see the status of your searches by looking at the Search Status 
near the top of the dialog box.

8 Look at the results of the search at the bottom of the dialog box. If you think that the results will 
be useful another time, create a tab with this data, as follows:

a In the text box at the right side of the dialog box, where �Search #X� is displayed, select the 
text and type over it to create a name for the new tab.

b Click Save Results.

A tab is added to the main screen of the UAD displaying the information found in the 
previous search. 

9 If you did not get exactly the results you wanted, change any of your selections in the Specify 
Search Criteria dialog box as desired. Then click the Find Now button again. 

Caution:  Use the New Search button only if you want to clear the previous search criteria and 
begin again.

Search status

Save name

 Results

Search criteria

!
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Deleting Search Results Tabs

If you saved information you found in the Find option, new tabs were created in the UAD with the 
results. You can delete any tabs that were created this way.

To remove search results tabs from the UAD:
1 Select the tab that you want to delete.

2 Click View > Delete tab.

The tab is deleted. 

Updating UAD Information
The information in the UAD changes over time. New queues or agents may be added, existing 
queues or agents may be removed, and information about agents may change. Agent state data 
changes frequently as agents log in and become available or unavailable for contacts.

If there is a delay between the time you first open the UAD and the time that you are ready to use 
it, the information may not be current. If you have left the UAD open for awhile, you should 
�refresh� it to get the most up-to-date information. 

If your contact center is large, it may take a moment to refresh all the data. If you only need 
information about agents� current availability, you may prefer to update agent state data only.

Refreshing the Entire UAD

To update all data displayed in the UAD:
1 Click View > Refresh.

The UAD brings in all the latest information.

Updating Agent State Only

To update agent state data in members of a group:
1 Right-click the name of a workgroup in the box on the left side of the UAD.

2 Select Update State from the pop-up menu.

The latest agent state information for members of this workgroup is displayed.

3 Repeat with other workgroups, as desired.
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Using Screen Pops
If your contact center has set them up, you may see screen pops, like the one in the following 
illustration, when new incoming contacts arrive in your task lists. If you click Yes in a screen pop, 
the new contact becomes active. If you are using a Business Application, such as CallCenterQ, 
information about that contact is automatically imported into your Business Application. 

If you are already responding to a contact when the new contact arrives, and you click No in the 
screen pop, Avaya Agent does not display a second screen pop because the new screen pop might 
interrupt your current contact. You can manually display a screen pop for the second contact 
through the pop-up menu in the Avaya Agent Media pane. 

Note:  Depending on how your administrator configured your system, you may not see screen 
pops.

To perform a manual screen pop for an incoming contact:
1 Click the new contact to make it active. 

2 Right-click in any open area of the Avaya Agent. 

3 Click Screen Pop in the pop-up menu. 

Avaya Agent opens the focus window (for example, the CallCenterQ Agent focus) with 
customer information about the incoming contact.

Wrapping Up Contacts
After you complete an incoming voice, email, or chat contact or an Outbound Contact call, your 
contact center may require you to wrap up the contact or call by entering information in a WrapUp 
dialog box or a Prompter script. The information you enter is added to the contact information in 
the database to assist the next agent who handles a contact from that customer. Because each 
contact center handles wrap-up information differently, your system administrator determines the 
following:
� Whether you are automatically placed in the WrapUp state after completing a contact
� Whether you enter information in a dialog box or click buttons in a script to enter customer and 

contact information 
� Whether you must record wrap-up information for every contact
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Using the WrapUp Dialog Box
Most contact centers document the reason and outcome of customer contacts through the use of 
one or more of the following wrap-up fields:
� Category
� Reason
� Outcome

The lists on the left side of the WrapUp dialog box contain information available for you to select, 
as shown in the following example. The lists on the right side contain the information you selected 
and previous entries that you or another agent selected to wrap up previous contacts with the same 
customer. 

You may need to enter information in one of the following areas, or any combination of these:
� Category � You may see a category for each of the media channels in this drop-down menu. Of 

you may see another type of grouping of a set of reasons (for example, Balance Inquiry or 
Cancellation Request). 

� Reason � This information specifies the purpose of a customer�s contact or the intent of the 
work you performed. 

� Outcome � This information specifies the action you took or the result of your activity on a 
contact. 

The Previous Entries field provides the following information:
� The login ID of the agent who entered the wrap-up information

Information 
you selected

Category 

Reason 

Outcome Previous 
Entries
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� The name of the agent who entered the wrap-up information
� A description of the category, reason, or outcome

If the Previous Entries field is blank, there are no previous wrap-up entries associated with the 
contact.

To wrap up a contact using the WrapUp dialog box:
1 Complete your contact. 

The WrapUp dialog box opens automatically.

2 From the lists on the left side of the WrapUp dialog box, click the correct information in one or 
more of the following lists:

� Category
� Reason
� Outcome

3 Click the right-arrow button to add this item to the Selections list. 

4 Click OK.

To close the WrapUp dialog box without adding information, click the Cancel button.

Note:  If your Avaya Agent is configured for more than one type of information, you may need to 
choose from all available lists before you can add the entries to the Selections list.

To de-select an item and remove it from the Selection list:
1 Click the item in the Selection list.

2 Click the left-arrow button. 

3 Click OK.

Using a WrapUp Prompter Script
If your system is configured for a WrapUp Prompter script, the script is displayed in the Prompter 
pane when you wrap up a contact.

The WrapUp Prompter script contains a series of questions about contacts specifically designed by 
your company. You proceed through the script by clicking radio buttons, selecting check boxes, or 
typing text in fields to provide information about the contact. Generally, the answers to the script 
questions require you to select reason, category, and outcome information, similar to the 
information fields in the WrapUp dialog box (see �Using the WrapUp Dialog Box,� on page 68). 

Note:  Because WrapUp Prompter scripts are designed by your company, the script you follow 
may look and function differently from the example presented below.
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To wrap up a contact using the WrapUp Prompter script:
1 Click the HangUp button to complete the voice contact.

You automatically enter the WrapUp state, and the WrapUp Prompter script opens in the 
Prompter tab of the Contact pane.

2 If necessary, click the Prompter tab to bring it to the foreground of the Contact pane.

Follow the script, selecting or entering the appropriate information. The following illustration 
shows a Prompter script. Your script may not resemble this example.
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Troubleshooting
On occasion, Avaya Agent may fail to work properly. Follow the set of instructions that applies to 
your situation to return your Avaya Agent to normal

Avaya Agent Stops Responding
Occasionally, you may have trouble with the display of the Avaya Agent. You may not be able to 
use the software as you usually do. You can restore the Avaya Agent to its normal condition by 
ending certain processes that your computer�s operating system uses to support the Avaya Agent.

You must have administrative privileges to do the following procedure. Contact your administrator 
if you do not have these privileges or if you need assistance with the following procedure. If you 
cannot get an administrator�s assistance, shut down your machine and restart it.

To restore the Avaya Agent to its normal condition:
1 Exit from the Avaya Agent if you can.

Note:  If you cannot exit from the Avaya Agent, open the Windows Task Manager 
and end the application task.

2 Open the Windows Task Manager.

3 In turn, end the qui, vtel, and mshta processes.

4 Log in to the Avaya Agent.

5 If the Avaya Agent is too large, take the following steps:

a Hold your cursor over the Windows task bar until you see an arrow with two ends, one 
pointing up and one pointing down. 

b Click your mouse and drag the cursor upwards, until the task bar becomes larger.

c Repeat Step a.

d Click your mouse and drag the cursor downwards, until the task bar returns to its original 
size.

 The Avaya Agent should operate correctly and it should be the normal size again.
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Avaya Agent Stops Responding with Outbound Contact
If the Avaya Agent suddenly stops working or suddenly exits while you are making calls with 
Outbound Contact, take the following steps.

To restore Avaya Agent and return to your Outbound Contact jobs:
1 Exit from Avaya Agent if it is running and if you exit.

Note:  If you cannot exit from the Avaya Agent, open the Windows Task Manager 
and end the application task.

2 Log in to Avaya Agent.

3 If you get an error message when trying to log back in, wait a moment and then try again.

4 Change your agent state for the incoming media channels.

5 Select and join jobs, as you did before. 
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CHAPTER 3
MANAGING INBOUND VOICE CONTACTS

This chapter provides step-by-step instructions on using Avaya� Computer Telephony for IC to 
manage your inbound telephone (voice) contacts. 

When customers make telephone calls that come in to the contact center, their calls are routed by 
the Avaya� Interaction Center (Avaya IC) software to agents who are available to handle voice 
contacts. Voice contacts that are routed to you are displayed in your Phone task list. 

This chapter includes the following topics:
� Using the Phone Task List
� Handling a Basic Voice Contact
� Initiating a Voice Contact
� Using Softphone with DEFINITY Switches

Using the Phone Task List
When your contact center application forwards a voice contact to your desktop, the contact is 
displayed in the Phone task list, which is located in the Softphone interface, as shown in the 
following illustration:

The status of the new contact in the task list is Ringing.
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The Phone task list displays information about all voice contacts you are currently handling. Each 
entry in your Phone task list corresponds to a different voice contact. The information about each 
contact that is displayed in your Phone task list depends on the telephone switch used by your 
contact center. The Phone task list can display the following information about each contact: 
� Caller�s Number � Telephone number of the contact to whom you are speaking.
� Call ID � Number that identifies the contact to the software.
� Call State � State of the contact (such as Ringing, Ready, Busy, OnHold, InCall, WrapUp)

Note:  The terms used to describe telephone states vary among contact centers and 
telephony equipment. For example, Ready may be known as Available. Busy may be 
known as Auxiliary Work or Idle. The WrapUp state may be known as After Call 
Work.

� Time-in-call � The period of time that you have been on the call with the customer in minutes 
and seconds. 

Tip:  If you select a contact and hold your mouse over it for a moment, you will see a �tooltip� 
with some of the same information about the contact. This tooltip may be easier to read than the 
information within the task list and it may contain additional information.

You double-click a contact in the Phone task list to answer a call (unless you are using Auto 
Answer, which answers the call for you). Then you begin talking. The contact becomes 
highlighted in the task list. A closed angle bracket (<) shows that this is the active voice contact.

You use the buttons in Softphone to control the active voice contact. All Softphone buttons affect 
the active contact. For example, if you click the HangUp button, the system hangs up the active 
voice contact, but any other contacts in your Phone task list remain. 

If you receive a second voice contact while you are still handling your first voice contact, you can 
select the second voice contact by clicking it one time. This allows you to see information about 
the second contact in the EDU Viewer or Contact History Browser while you are still engaged with 
your first contact.

If you double-click the second voice contact, it becomes the active contact, while the first contact 
is put on hold. You should tell your first customer that you will put them on hold before you 
double-click a second voice contact.

If you move your cursor away from the Phone task list, the current voice contact is no longer 
highlighted. Even when it is not highlighted, you can tell which contact is the active contact by the 
angle bracket.

If you see �CTI - Server Failure� in the Phone task list, contact your administrator.
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Handling a Basic Voice Contact
This section explains how to handle a basic incoming voice contact, under the following topics: 
� Handling Contacts With Auto Answer
� Handling Contacts Without Auto Answer
� Placing a Voice Contact on Hold
� Transferring a Voice Contact

Handling Contacts With Auto Answer
If you have Auto Answer turned on, Softphone automatically answers an incoming voice contact 
and makes that your active contact. Softphone does the following:
� Answers the voice contact.
� Makes it the active contact. 
� Highlights the contact in the list and adds an open angle bracket (>) to help you identify this as 

the active contact.
� Changes the contact�s status in the Phone task list to InCall. 
� Opens the CallCenterQ Agent focus and displays the customer�s information.

To answer a new Softphone contact with Auto Answer turned on:
1 Begin speaking with the customer. 

2 When you have finished the call, click the HangUp button in Softphone.

Handling Contacts Without Auto Answer
If you do not have Auto Answer turned on, follow this procedure.

To answer a new Softphone contact:
1 Double-click the new voice contact in the Phone task list.

2 Begin speaking with the customer.

3 When you have finished the call, click the HangUp button in Softphone.

Note:  If you see �CTI - Server Failure� in the Phone task list, contact your administrator.
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Placing a Voice Contact on Hold
You can place a voice contact on hold while you look up information, answer another contact, or 
transfer the voice contact to another agent. The contact�s status in the Phone task list changes to On 
Hold, as shown in the following illustration:

A button in Softphone changes its label between Hold and Reconnect. When you click the Hold 
button, the label changes to Reconnect. When you click the Reconnect button, the label changes to 
Hold.

Note:  If you are using an Aspect switch, you cannot use the Hold and Reconnect buttons. Instead, 
to put a current voice contact on hold and connect to a new voice contact, double-click the new 
contact. To reconnect to the first voice contact and put the second contact on hold, double-click the 
first contact.

To place a customer on hold while you speak to another customer:
1 Ask the customer with whom you are speaking if you may put them on hold for a moment. 

2 Click the Hold button.

3 Double-click the new voice contact in the Phone task list.

4 Begin speaking with the second customer.

5 Return to the first customer as soon as possible, as follows:

a Either finish the call with the second customer or tell that customer you will put them on 
hold.

b Click Hold if you did not finish the call with the second customer.

c Select the first phone contact in the Phone task list.

d Click Reconnect.

e Continue your conversation with the first customer.

6 If the second customer is on hold, return to that customer as soon as possible.

When you click this button to 
reconnect to a customer, the button 
label changes to Hold. 
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For more complete information on handling two simultaneous phone calls, see �Handling Two 
Voice Contacts,� on page 86.

Transferring a Voice Contact
At certain times, you may need to transfer a voice contact to another agent who is more qualified 
to handle it or to your supervisor to handle a customer who needs more attention.

You use the Unified Agent Directory (UAD) to transfer calls. The UAD opens with the following 
information:
� The location name assigned to your contact center is displayed in the Site drop-down menu. 

The other site names so that you can transfer a call to agents at other locations. 
� The telephone number of the current contact is displayed in the Current Tasks field. This field 

lists all of your currently active contacts. When you complete a contact, it is removed from this 
list.

Note:  Always tell the customer that you are transferring them before proceeding.

Transfer Options

The UAD provides the following call transfer options:
� Blind Transfer � To transfer the call and have the telephone contact removed from your Phone 

task list immediately. The call waits in a queue until the agent to whom you transferred the call 
is available to answer it. 

� Conference � To transfer the call, have the ability to remain on the call with the customer and 
the selected agent, and have the ability to add other agents to the call. 

� Cons Transfer (Consultative Transfer) � To transfer the call and have the ability to speak as you 
transfer the telephone contact. You can introduce the customer to the other agent and explain 
the nature of the call. 

You can transfer a call to:
� A queue, which is a group of agents with similar skills, to route the transfer to anyone currently 

available in that queue
� A specific agent
� An agent with a specific skill, such as someone who speaks a particular language or supports a 

particular product
� Multiple agents, by conference call

Note:  If you want to transfer a call to someone with a particular skill, use the Find option instead 
of the following procedure. See �Looking Up Agents with the Find Option,� on page 62.

Caution:  When using Outbound Contact, do not transfer a call to another outbound agent or 
create a conference call. See �Caution About Transferring a Call,� on page 190 for information.!
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To transfer a call to a queue or an agent:
1 Tell the customer that you are going to transfer them to someone who will help them.

2 Click the Directory button on the Avaya Agent to display the Unified Agent Directory (UAD). 

The Site drop-down menu displays the site where you are located. The Current Tasks drop-
down menu displays your current voice contact.

3 If the queue or agent to whom you want to transfer the call is located at a different site, select 
the site from the Site drop-down menu. Select All Sites if you do not know where the agent or 
queue is located. 

4 Check that the contact that you want to transfer is displayed in the Current Tasks field. By 
default, the Current Tasks field displays the telephone number of the current caller.

5 If you are certain you know the telephone number of an agent to whom you want to transfer the 
voice contact, you can enter the number in the To field, and then skip to Step 9 in this 
procedure.

6 Click the Queues tab to transfer the call to the first available agent in a queue or the Agents tab 
to transfer the call to a particular agent. Then follow the step below that applies to the tab you 
selected.

7 Queues tab � Double-click the name of the queue or agent you want (or select it and click the 
>> button).

The name moves to the box on the right of the UAD.

Tip:  If you discover that this is the wrong person, click the << button to remove the 
person from this box.

8 Agents tab � Open the tenant or workgroup to which the agent belongs. Then double-click the 
name of the agent to whom you want to transfer the call to move the agent to the box on the 
right side of the UAD.

Tip:  Tenants are represented by a house icon, workgroups are represented by an icon 
of a folder beside an agent head, and agents are represented by an agent head or two 
agent heads side-by-side.

Tip:  If you do not see the name of the person you are looking for in the list, that 
person may not be logged in or may not be available for a telephone call.

Tip:  If you are not certain about the name (login ID) of the person to whom you 
want to transfer the call, right-click the name. The Properties pop-up menu is 
displayed with only the menu title. Click this to display a dialog box with information 
about this person.
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9 Click one of the following buttons and follow the instructions for that button:

� Blind Transfer � To transfer the call to the selected person and have the voice contact 
removed from your Phone task list immediately. The call waits in a queue until the agent to 
whom you transferred the call is available to answer it. If the agent is busy and cannot take 
the contact, you can cancel the transfer or remain in session with the call until the agent is 
available.

� Conference � To transfer the call and have the ability to remain on the call with the customer 
and the selected agent or agents. In the dialog box that is displayed, click Complete to 
complete the transfer. To add more agents to the call, repeat the above procedures. Use the 
Softphone HangUp button to hang up whenever you want.

� Cons Transfer (Consultative Transfer) � To transfer the call and have the ability to speak as 
you transfer the voice contact. You can introduce the customer to the other agent and 
explain the nature of the call. In the dialog box that is displayed, click Complete to complete 
the transfer. Use the Softphone HangUp button to hang up whenever you want.

Using the Softphone Menu
With the Softphone component of Avaya Agent, you can perform standard telephone functions 
without a physical telephone. The Softphone menu is part of the Avaya Agent pop-up menu. You 
see this menu if you right-click (use the right mouse button to click) any blank section of Avaya 
Agent. The pop-up menu contains the following menu options:
� Softphone - Login/Logout
� Softphone - Refresh
� Softphone - Reset

This section explains the Refresh and Reset options. For information on logging in and out of 
Softphone, see �Logging In and Out of Media Channels,� on page 44.
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Refreshing Your Softphone Data
You use the Softphone - Refresh option in the pop-up menu to refresh the data in the WrapUp 
dialog box and, if it is used, the DEFINITY Log/Aux dialog box.

When you log in to Avaya Agent, the Softphone retrieves the data for the WrapUp and DEFINITY 
Log/Aux dialog boxes from the database and stores them in your workstation�s memory. Because 
administrators may make changes to the data during the course of the day, you may need to refresh 
your Softphone data frequently to ensure that you have access to the most current information.

To refresh your Softphone data:
1 Right-click in an empty part of the Avaya Agent frame. 

2 In the pop-up menu, click Softphone - Refresh. 

Your Softphone data is refreshed with the updated information.

3 Click OK. 

Reconnecting to Your Physical Telephone
You use the Softphone - Reset option to re-establish and synchronize the connection between your 
Softphone and your physical telephone when communications are disrupted and your Softphone 
fails to function properly. 

You can identify a communication failure when:
� Softphone cannot perform a telephone operation.
� Softphone appears to be �locked up� for any length of time.

Note:  If your Softphone and your physical telephone are set differently, Softphone may become 
unresponsive when you use both your physical telephone and Softphone. To avoid this problem, 
ask your administrator to confirm that the preset state settings for your physical telephone and 
Softphone are identical.

To reset the communication between your Softphone and the telephone:
1 If you are in a voice contact, complete your voice contact with the physical telephone.

2 Set your agent state to Unavailable (see �Changing Your Agent State,� on page 46).

Note:  The Softphone - Reset option clears all current activity from the Softphone 
and terminates all calls. You must complete Steps 1 and 2 before using Softphone - 
Reset.

3 Right-click in an empty part of the Avaya Agent.

4 In the pop-up menu, click Softphone - Reset. 

5 Click OK.

If this does not resolve the problem, contact your administrator. 
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Initiating a Voice Contact
If you are enabled for voice contacts, you can use your contact center telephones to make a voice 
contact. You can use the UAD to find the telephone number of another agent, supervisor, or 
external agent who works for your company.

Note:  If you are looking for information about making outbound calls as part of your job duties, 
see Chapter 7, �Managing Outbound Contact Calls� or Chapter 8, �Managing Outbound Lists�.

To initiate a call:
1 Click the Directory button on the Avaya Agent to display the Unified Agent Directory (UAD). 

2 Select <New Call> from the Current Tasks menu, if this option is not already displayed.

3 If you know the telephone number of the person you want to call, enter that number in the To 
box at the bottom of the UAD. Then skip to Step 9 of this procedure.

4 If you want to call a specific agent, and there is an Agents tab above the scroll box on the left 
side of the UAD, click on that. If you do not see an Agents tab, search for the person as 
described in �Looking Up Agents with the Find Option,� on page 62 or �Filtering Data 
Displayed in Tabs,� on page 60.

5 If the person is not located in your site, select the name of the site from the Site drop-down 
menu. If you do not know where the person is located, select All Sites.

6 Navigate through the tree structure in the scroll box on the left. Click any group to display the 
agents in that group. Use the scroll bar as necessary.

7 When you see the name of the person you want to call, you may want to check that this is the 
correct person. To do so:

a Right-click the name and click Properties in the pop-up menu. 
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b Click the Phone and E-mail tabs of the dialog box as necessary so you can check that this is 
the person you want to call.

8 When you find the correct name, double-click the name to move it to the scroll box on the right.

9 Click Initiate (or Dismiss if you change your mind and do not want to make the call).

10 When you are finished speaking, click the Softphone HangUp button.

Using Softphone with DEFINITY Switches
If your Softphone system uses an Avaya� DEFINITY telephone switch, you may need to do the 
following tasks:
� Softphone�s DTMF (Dual-Tone Multi-Frequency)
� DEFINITY reasons
� The Auto-In work mode
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Sending Numerical Information with DTMF
If your Softphone uses a DEFINITY telephone switch, your administrator may have implemented 
DTMF. You use DTMF to enter numerical information, such as a customer�s account or 
identification number, on the numeric keypad of the Dial Pad dialog box. DTMF sends this 
numerical information to a selected device, such as an Interactive Voice Response (IVR) unit, as if 
you had dialed the tones on your telephone.

To send numerical information with DTMF:
1 In Avaya Agent, click the DTMF button.

2 In the Dial Pad dialog box, enter the numbers in either of the following ways:

� Click in the entry field. Then type the digits on your keyboard.

OR 
� Click the numeric buttons in the keypad window.

If you type an incorrect number, click the CE (Clear Entry) button to clear one number at a time 
or click the Clear button to completely clear everything that is displayed.

3 Click the Send button to transmit the number across the telephone line.
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Entering Reasons for Becoming Unavailable
If your Softphone uses a DEFINITY telephone switch, you may see a DEFINITY dialog box 
whenever you log out or click the Busy button on the Softphone.

In this dialog box, you must select a reason before you can log out or set your telephone to the 
Busy state.

To select a DEFINITY Reason:
1 Click the desired reason in the Select Reason field.

2 Click OK.

To clear the dialog box and select another reason, click the Cancel button.

Using the Auto-In Work Mode
This section applies to you only if you are using a DEFINITY telephone switch and you can set the 
Auto-In and Manual-In work modes. You may set these work modes by pressing buttons on your 
telephone, by entering codes on your telephone, or by using Softphone. The work modes have 
been set up at your contact center to correspond to agent states in specified ways. For example, the 
AuxWork button on the telephone corresponds, in part, to the Aux-work agent state. See the table 
below for the exact changes in agent state that happen when you push the work mode buttons.

The Auto-In work mode automatically assigns you to specific Automatic Call Distributor (ACD) 
queues. It makes you available immediately after the end of a call. Therefore, with Auto-In, you 
may get another call as soon as you hang up. 

If you plan to take a break after your current call while in Auto-In mode, you can change your 
work mode or agent state while on the call. The operation does not take effect, however, until you 
complete the call. For example, while on a call, you can click the Agent button in the Avaya Agent 
to change your agent state to Aux-work. You are placed in Aux-work only after the current call is 
completed.
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In Auto-In mode, you cannot preset the Softphone while in a call to change from a Busy telephone 
state to an Available telephone state. You see an error message if you try to do this. You must reset 
the Softphone to change to and from the Aux-work state. See �Reconnecting to Your Physical 
Telephone,� on page 80.

Be aware of the following issues when using Auto-In mode:
� You should not use this mode when you are handling outbound calls.
� If you are logged in to email or chat, you should log out of those media before using Auto-In. 
� Presets from your physical telephone while your voice contact is in the InCall state do not 

work.
� If your Avaya Agent is not configured for WrapUp, you cannot set a WrapUp preset on your 

physical telephone while in automatic mode. (For an explanation of automatic and manual 
modes, see �Changing State Across All Media Channels,� on page 47.)

� Other buttons you push on your physical telephone while wrapping up in automatic mode may 
not work. 

� If your system uses the WrapUp dialog box and you press the AutoIn and ManualIn buttons, a 
voice contact may be assigned to you while you are handling another call. You will see a 
WrapUp dialog box for the first call after it ends, but a second call may arrive before WrapUp is 
complete. This will not happen on subsequent calls. 

The following table shows how your agent state changes when you press a telephone button in 
either manual or automatic mode.

Initial Agent State Phone Button Pushed Changed Agent State

Available AutoIn
ManualIn
AfterCall
AuxWork

No change
No change
No change
Aux-work

Aux-work AutoIn
ManualIn
AfterCall
AuxWork

Aux-work
Aux-work
No change
No change

Init aux-work AutoIn
ManualIn
AfterCall
AuxWork

Available
Available
No change
No change

Outbound AutoIn
ManualIn
AfterCall
AuxWork

Available
Available
No change
Aux-work
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Handling Two Voice Contacts
With Softphone, you can handle more than one incoming voice contact at the same time, using 
either the telephony buttons or keyboard shortcuts. By following this example, you can take two 
incoming voice contacts using the Softphone telephony buttons. 

The following example assumes that you are using Avaya Agent with CallCenterQ as your 
Business Application. A voice contact comes into the contact center. Your Softphone is in the 
Ready state. CallCenterQ routes the voice contact to you. Your Phone task list displays the caller�s 
telephone number and the contact�s status as Ringing.

To answer two simultaneous voice contacts:
1 If Auto Answer is not turned on, double-click the contact to answer it manually.

2 Ask for information from the customer, who is following up on a previous contact. Use the 
Contact History Browser to look up the record on the previous contact.

While you are looking up the customer�s history, another voice contact is assigned to you. 

3 Click the Hold button to place the first voice contact on hold so that you can answer the second 
voice contact.

4 Double-click the new incoming voice contact to answer it. 

5 Click the Hold button to place the second voice contact on hold while you complete the first 
voice contact.

6 To return to the first voice contact, select it in the Phone task list. Then click the Reconnect 
button. 

7 When you have completed the first voice contact, click the HangUp button. 

8 If your company requires you to enter wrap-up information for each contact, you enter the 
WrapUp state, and the WrapUp dialog box is displayed. Select the reason and click OK.

When you complete WrapUp, this information is entered into the customer�s record. (For more 
information about wrapping up contacts, see �Wrapping Up Contacts,� on page 67.)

9 Click the second voice contact in the Phone task list to make it the active contact. Click the 
Reconnect button to speak to the customer.

If you do not have the information the customer needs, click the Directory button to open the UAD 
and transfer the second voice contact to another agent (see �Transferring a Voice Contact,� on 
page 77). 
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CHAPTER 4
MANAGING EMAIL

If your account is enabled for Email Management, you use the Web Agent to interact with 
customers by email. 

Some customers send email from the company�s Web site while others send it from a corporate or 
personal mail account. The email is routed by the Avaya� Interaction Center (Avaya IC) software 
to agents who are available to handle email. Email contacts that are routed to you are displayed in 
your Email task list.

This chapter explains the features you can use with Email Management under the following topics:
� Being Alerted to a New Email Contact
� Using the Email Task List
� Viewing Email History
� Composing a Normal Email Reply
� Addressing Emails with the UAD
� Using Resources in Email
� Using Suggested Responses
� Sending an Email to an External Agent
� Transferring an Email Contact
� Deferring an Email
� Saving a Draft
� Forwarding an Email
� Spell Checking Your Emails
� Requesting More Information from Customer
� Responding to an Email Alert
� Resolving an Email
� Originating an Outbound Email
� Approving or Rejecting an Email
� Handling a Rejected Email
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� Using Multiple Languages with Email
� Wrapping Up and Completing an Email Contact

Being Alerted to a New Email Contact
Email that customers send from the company Web site may be routed to you whenever you are 
available for email. 

Depending on how the Avaya IC software has been set up at your contact center, you may be 
alerted to an incoming email in two ways:
� By a sound. For information on changing the way that you are alerted, see �Contact 

Preferences,� on page 168.
� By a screen pop. This is a dialog box that asks if you want to suspend your other contacts to 

begin handling the new email contact. You may be able to control whether you receive this 
dialog box, with the �Wait for confirmation before accepting a contact� preference. For 
information, see �Contact Preferences,� on page 168.

Note:  If you are alerted to an email contact but do not acknowledge it within a preset amount of 
time, the contact is assigned to another agent and removed from your Email task list. The amount 
of time is set by the administrator of the WebACD Server configuration.

Using the Email Task List
The Email task list displays the email contacts currently assigned to you. A typical Email task list 
is shown in the following illustration: 

If you click a contact in the Email task list, it becomes selected. The subject line of the selected 
contact is displayed when you click the contact. All tasks that you perform to the email in the Web 
Agent apply to the selected email contact. (When you double-click a contact, the Web Agent 
window opens and displays this contact to the Email Preview mode.) 

Subject line of 
selected email contact

Oldest contact
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A good deal of information about your email contacts is displayed in the small space of the Email 
task list by visual cues, including icons and text. 

Icons in the Email Task List
If you pay attention to the icons in the task list, you can see at a glance a lot of useful information. 
There are three columns of icons in the Email task list, which are as follows:
� First column � The icon in the first column is an envelope to indicate that this is an email. If the 

email has been transferred, an arrow is displayed to the side of the envelope.
� Second column � The icons indicate the source of the email, such as a reply from an external 

agent or an email that has been rejected during Quality Assurance.
� Third column � The icons in the third column show the status of the email, such as whether it is 

deferred or wrapped.

The icons in the first column of your Email task list tell you the state of each email contact, as 
shown in the following table:

The icons in the second column give you information on the source of each email contact. You 
may see icons representing the following sources:

Icon Description

The email contact is active.

You have transferred this email to your supervisor or to another agent. The contact remains in 
your task list until you wrap it up.
Note: If �malformed error� is displayed when you transfer an email to another agent, contact 
your administrator to validate that this agent has been assigned a valid email address in IC 
Manager.

Icon Description

A reply to a normal email sent to the customer by the agent

A reply from an external agent

A reply from a customer to a request for additional information

A reply to an email you forwarded.

An email composed by another agent and forwarded to you for approval (Quality Assurance)
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The third column indicates the current status of each email contact, as shown in the following 
table.

Text in the Email Task List
The following areas give you text information about a selected email contact:
� Origin � The email address from which the email was sent.
� Age � The length of time the contact has been assigned to you. The time runs continuously 

until you complete the contact.
� Customer question � The text the selected customer typed in as the subject of their email.

An email rejected during Quality Assurance and sent to you for correction

A reply to an email that you originated.

An email alert, notifying you that an email requested from a customer or an external agent is 
overdue.

A reply from an automatic response email that was sent to the customer from the Avaya IC 
system.

Icon Description

New, unopened email contact.

Open, active email contact. This is the contact you are currently handling in the Web Agent.

Deferred email contact. You must return to it when you can and complete it. 

Email contact in WrapUp state. You are wrapping up this email in the Web Agent. 

Icon Description
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Viewing Email History
If you want to see tracking information about an email contact in your contact list or copies of 
recent emails sent by the current customer, you can use the Email History dialog box, which has 
the following tabs:
� Tracking History � Detailed tracking information about this email and other emails sent from 

this customer
� Customer History � Copies of previous emails the customer has sent to your company and 

copies of the emails themselves

Note:  Another agent may have deferred an email contact from this customer. You cannot see 
deferred email contacts in the Email History dialog box but you can see them in the Active Contact 
Viewer. It is a good idea to check the Active Contact Viewer when you are looking for information 
about a customer�s recent contacts. See �Viewing Active Contact Information,� on page 52.

To see the tracking history or previous emails of an email contact:
1 Display the email you want information about in the Email Preview mode.

2 Click the Email History button in the email toolbar to display the Email History dialog box.

The Email History dialog box opens with the Tracking History tab displayed.

3 To see the maximum amount of information in the Tracking History tab, do any of the 
following:

� To see all available information in a table column, hold your cursor at the right edge of any 
column title. When you see a two-sided arrow, click and drag to the right.

� To see tracking information about past emails sent by this customer, click the View Full 
Email History check box.
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4 To see complete technical information about the routing of any email selected in the table, click 
the Header check box. When there is a problem, this information may be helpful for 
supervisors or administrators.
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5 To see copies of emails this customer sent to your company in the recent past, click the 
Customer History tab. Select any email in the box at the top to see a copy of the email itself in 
the scroll box at the bottom, as shown in the following illustration.

6 Check your dialog box to see the time range of the emails displayed. For example, the dialog 
box may display emails that were received in the past three months. If you want to see emails 
that arrived before this time range, clear the check box to specify a longer time range.
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Composing a Normal Email Reply
The following procedure explains how to compose a normal reply to a customer email using 
features available in the Email reply screen.

To compose a basic email reply to a customer:
1 Make sure that you are available to handle email by looking at the Email Channel button in 

Avaya Agent. If the button shows a yellow X, click the button to make yourself available for 
email. 

You are now available to receive the number of email contacts that is set for you in your 
channel load. See �Setting Your Channel Loads,� on page 49 for information about channel 
loads. After you become available, any email contacts that are routed to you show up in the 
Email task list.

2 In Avaya Agent, select a contact in the Email task list. If there is more than one contact, the 
contacts are listed in reverse chronological order, that is, with the oldest contact at the top. 

For information about the meaning of the icons, and the text displayed in the Origin and Time 
columns, see �Being Alerted to a New Email Contact,� on page 88.

The Web Agent window opens in the Email Preview mode to show you information about this 
email. The Information Bar displays �New inbound message from customer.�

3 Read the message using the scroll bar, if necessary, to see the entire message. 

4 Before you begin your reply, you can use any of the following buttons in the email toolbar, as 
needed. You can also return to this Preview tab later to use these buttons.

� Print � Prints a paper copy of the text that is currently displayed in the Information Bar, the 
Header fields, and the Message Composition Area.

� Resolve � Lets you apply a status to the email. See �Resolving an Email,� on page 112 for 
information.

� Email History � Displays a dialog box with tracking information about this email or copies 
of previous emails sent from the current customer�s email address. See �Viewing Email 
History,� on page 91 for more information. 

� Transfer � Displays the Unified Agent Directory so you can transfer this email contact to a 
particular agent, or transfer it to a queue and let Avaya IC route the email to the first 
available agent in that queue. For information, see �Transferring an Email Contact,� on 
page 105.

� Defer � Defers your reply to this email contact until a later time. The contact remains in 
your Email task list but you are available for another email to replace this one. For more 
information, see �Deferring an Email,� on page 106.

� Wrap � Wraps up this email contact. See �Wrapping Up and Completing an Email Contact,� 
on page 120 for information.

� Complete � This button is only available when you are in WrapUp state.
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5 To begin your reply, click one of the two reply buttons in the email toolbar:

� Reply to customer � Addresses your reply to the sender of the email and no one else.
� Reply to all � Addresses your reply to the sender of the email and to all the people listed in 

the Cc (Copy) or Bcc (Blind Copy) fields of the message you are replying to. See Step 6 of 
this procedure for an explanation of these fields.

The window changes to the Email Compose mode where you will write your email reply. Note 
that the drop-down menu indicates that this is a Normal Reply.

6 If you want to add the email address of anyone in your company, so that they will receive a 
copy of this email, add their email address easily to any of the address fields by using the UAD. 
See �Addressing Emails with the UAD,� on page 97 for information.

7 Look in the Resource area of the window to see if there are any Suggested Responses. If you 
see Suggested Responses, refer to �Using Suggested Responses,� on page 102 for instructions 
about choosing a response or responses.

8 If you do not see Suggested Responses, look for any resources that are relevant to the 
customer�s question in the Email Templates folder, Global Resources folder, or Agent 
Resources folder. For information on viewing resources, see �Viewing Your Resources,� on 
page 161. 

9 If you found a resource that you want to use, add it to your message. For information on adding 
resources to an email, see �Using Resources in Email,� on page 100.

10 If you added a resource, read the message in the Message Composition area and modify it 
appropriately, if necessary.

11 Type your message to the customer in the Message Composition area. Be sure that you address 
the customer�s question or problem.

Tip:  If you added a resource or an attachment, you may want to begin with a short 
introduction to explain the resource or the attachment. 

12 Look over the buttons in the email toolbar to decide whether you want to execute any of the 
commands before you send your message. The buttons are as follows:

� Print � Prints a paper copy of the email as it is currently displayed.
� Save � Saves a draft of your message. The contact remains in your Email task list. The next 

time you click this contact and then begin to reply to this customer�s email (by clicking 
Reply, Reply to All, or Forward), the Email Compose window opens with the message you 
saved. 

� Cancel � Cancels the reply. A dialog box asks if you wish to save a draft of the reply you are 
composing. 
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� Add Attachments � Attaches a file from your computer�s hard drive or from the hard drive 
of any computer that you can access on the network. When you press the Attach button, a 
window is displayed where you can browse to the file and select it. You can click the View 
button to open the file in the program associated with that type of file on your computer. 
Contact your administrator if you do not know what type of file this is and you want to open 
it.

� Spell Check � Helps you check and correct the spelling of your message. For information, 
see �Spell Checking Your Emails,� on page 109. 

Tip:  You can select an option in the Preferences dialog box (available under the 
Tools menu) to bring up the Spell Checker automatically before your messages are 
sent. If you select this option, you will not forget to spell check your messages. See 
�Email Preferences,� on page 169.

13 When the message is complete, click the Send button. 

If the �Spell check before sending an email� option is selected in your Preferences, the Spell 
Checker is displayed so you can check the spelling in your message. Check the spelling, 
referring to �Spell Checking Your Emails,� on page 109 if necessary.

If the Confirm Before Sending option is selected, a dialog box like the following asks if you are 
sure you want to send the message. Click Yes.
 

To change the preferences that determine whether the Spell Checker or the confirmation dialog 
box are displayed whenever you start to send an email, see �Setting Preferences,� on page 165.

Your response is sent to the customer. The window switches to the WrapUp state. The email 
you just sent is still displayed, but now it is read-only. 

14 If you see information in the Prompter window in Avaya Agent, fill in any requested 
information as appropriate. For information about filling in a Prompter script, see �Using a 
WrapUp Prompter Script,� on page 69.

15 Wrap up and complete the email contact, using the following buttons:

� Wrap � Puts you in WrapUp state. While in WrapUp state, you cannot receive another email 
contact to replace this contact. You may be asked to fill out information about this email 
contact while you are in WrapUp state. 

� Complete � Closes this email contact and removes it from the Email task list. For more 
information, see �Wrapping Up and Completing an Email Contact,� on page 120.
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Addressing Emails with the UAD
When you address emails to people at your contact center, the Unified Agent Directory (UAD) can 
help you find and add the addresses quickly and easily, and without errors. The UAD opens in a 
special Email Addressing mode for this purpose. This is useful for the following tasks:

� Composing a Normal Email Reply
� Sending an Email to an External Agent
� Transferring an Email Contact
� Forwarding an Email
� Originating an Outbound Email

Note:  In the Email Addressing mode, the UAD displays only queues and agents that are enabled 
for email and it contains only their email addresses.

Note:  The following procedure explains how to add email addresses, not how to do other tasks 
such as transfer emails or send them to external agents. See the appropriate sections for those 
procedures.
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To address an email using the UAD:
1 Display the email you are responding to in the Email Compose window.

2 Click the button beside the Cc or Bcc fields to display the UAD. 

The UAD is displayed in Email Addressing mode, as shown in the following illustration:

The meaning of these fields is as follows:

� To � If enabled, this field is for the address of anyone to whom you want to address this 
message directly. 

Note:  The �To� field is disabled for a Normal Reply and for a Request for Additional 
Information because the email is automatically addressed to the customer to whom 
you are replying.

� Cc (Copy) � This field is for the address of any person (or any queue) that you want to 
receive a copy of this email.

� Bcc (Blind Copy) � This field is for the address of any person (or any queue) that you want 
to receive a copy of this email, without anyone else seeing their address.

3 If the queue or person you are looking for is not located in your site, select the name of the site 
from the Site drop-down menu. If you do not know where the queue or person is located, select 
All Sites.
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4 Navigate through the Queues, Agents, or any other tab available to you, opening groups as 
necessary, until you find the queue or person to whom you want to address this email. In the 
following illustration, the administrator has been selected in the To field:

5 Select the desired name and then click the To, Cc, and Bcc button to add that person�s email 
address to the box on the right side of the window. (You can double-click to automatically add 
the name to the To box.)

Note:  The �To� field is disabled for a Normal Reply and for a Request for Additional 
Information because the email is automatically addressed to the customer to whom 
you are replying.

Note:  If you want to remove a name you added to the right side of the window, select 
it and press the Delete key on your keyboard.

6 Repeat the above steps as desired to add the addresses of all the intended recipients to your 
email.

7 Click Ok.

The email addresses are added to the email you are composing.

8 If you are doing any of the following tasks, return to the appropriate section to finish your 
email and send it:
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� �Composing a Normal Email Reply,� on page 94
� �Sending an Email to an External Agent,� on page 103
� �Transferring an Email Contact,� on page 105
� �Forwarding an Email,� on page 107
� �Originating an Outbound Email,� on page 113

Using Resources in Email
Resources are previously prepared text, emails, and URLs (Internet addresses) that you can send 
repeatedly to different customers by chat or email. Resources save you the time and tedium of 
typing the same things again and again. Text and email resources may contain such things as 
greetings, closings, and answers to frequently asked questions. Email resources may have 
information already entered in the To, Cc, and Bcc fields, and they may contain attachments. URL 
resources may be links to company Web pages. For example a URL may link to a page about 
exchange policies. 

When you are composing an email, you may see any or all of the following types of resource 
folders:
� Global Resources � This folder is for email, text, and URL resources created for you and other 

agents by administrators or supervisors. If you are an agent, you cannot create or modify these 
resources. 

� Agent Resources � This folder is for email, text, and URL resources that you create for 
yourself. These resources are saved with your login ID. You are the only person who can see or 
use the resources you create.

� Email Templates � This folder is for a type of email resources called email templates. These are 
created for you and other agents by administrators. An email template is a prewritten email 
response that becomes customized when you use it. For example, your current customer�s 
name and the current date may be automatically entered into the email resource whenever you 
use it. Your company may also send a copy of an email template when you apply a status to a 
customer�s email. For information, see �Resolving an Email,� on page 112. 

� Suggested Responses � (If your company is not using the Content Analyzer, you never see this 
folder.) This folder is for email resources that are created by an Avaya software product, called 
the Content Analyzer, in response to a particular email. When these resources exist, you must 
consider using them before you consider using resources in any of the other folders. For more 
information, see �Using Suggested Responses,� on page 102.

� Migrated Resources � You see this folder after you import migrated resources. Your 
administrator will inform you if you need to do this. See �Importing Migrated Resources,� on 
page 164. 
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The resources in the Global Resources folder and the Agent Resources folder can be any of three 
types�email, text, or URL. The Email Templates and Suggested Responses folders, when these 
exist, are always email resources. Email, text, and URL resources are described in detail in 
�Resource Types and Examples,� on page 156. 

Using Global, Agent, or Email Template Resources in an Email
To use a global, agent, or email template resource in an email: 
1 While composing an original email or an email reply, look through the resources available to 

you. See �Viewing Your Resources,� on page 161 for information.

2 Right-click the resource that you want to use.

The resource opens in the Edit Resource dialog box. 

a Add or change the information in the Header fields.

b If you want to add an attachment, use the Attachments tab.

c Click OK to save your changes to the resource or cancel if you do not want to save any 
changes.

3 Click View if you only want to look at the resource.

The resource opens in the View Resource dialog box. You cannot edit the resource from this 
dialog box. 

4 To use a resource, right-click it and select the appropriate option, depending on the resource 
type. The options are as follows:

� Email, Email Templates, and Suggested Responses � �Use� is the only option. When you 
select this option, the entire email resource is used, including all header information and text 
in the resource. You can edit this information as needed. 

� Text � Insert and Insert Quoted are the options. Insert places the text of the resource into the 
email you are composing. Insert Quoted does the same as Insert but adds a special character 
at the start of every line to indicate that the text was pasted into the email. If you want to 
choose a different character to be inserted, see �Email Preferences,� on page 169.

� URL � Insert and Insert Quoted are the options. Insert pastes a copy of the URL from the 
resource into the email you are composing. Insert Quoted does the same as Insert but adds a 
special character to indicate that the URL was pasted into the email. 

Caution:  You may be able to send a resource directly to the customer by double-clicking it, 
depending on the way Avaya IC has been configured at your contact center. If double-clicking 
sends a resource to the customer, be careful not to double-click before you are ready.

!
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5 If this is an email resource, email addresses in the To, Cc, and Bcc fields of the resource are 
added to your email, along with any addresses already in your email reply, such as the 
customer�s reply address. Modify or delete these addresses (except for the To field, as 
explained in the following note), and add new ones if you want. 

Note:  In a Normal Reply or a Request for Additional Information, you cannot edit 
the To field because the email is automatically addressed to the customer.

6 If there is no information in the Subject field, enter an appropriate subject.

7 Modify any text that was inserted from the resource into the body of your email, as necessary.

8 Finish composing the email. 

9 Click Send when you are ready to send the message.

Using Suggested Responses
Suggested Responses are generated automatically, either by Avaya IC or by software called the 
Avaya� Contact Analyzer. The software is guessing that these responses may appropriately 
answer the current customer�s question. 

When an incoming email in your Email task list has been analyzed, you will see a Suggested 
Responses folder in the Web Agent. The resources are �dynamic,� that is, the resources and the 
folder that contains them are only available when the email contact they were created for is active. 
When you complete that email contact, the resources that apply to it are removed. 

You must read the email from the customer and decide which of the Suggested Responses best 
answers the customer�s question or problem. If you see a score for the responses, this may help 
you decide. The higher the number, the more likely it is that this is a proper response to the 
customer�s question.

To select and send Suggested Responses:
1 Double-click an email contact in the Email task list.

The Web Agent window displays the customer�s message in the Email Preview mode.

2 Read the customer�s message, using the scroll bar if necessary to see the entire message. Be 
sure you understand what the customer is asking.

3 Click the Reply button to begin your reply to the customer.
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4 If you see a Suggested Responses folder, look at the responses with the highest scores first. The 
responses with the highest scores are displayed at the top of the list. 

Note:  If you do not see a Suggested Responses folder, no Suggested Responses have 
been created for this message. 

The scores give an indication of the likelihood that each response is a good one. In other words, 
the higher the score, the more likely it is that this is a proper response to the customer�s 
question. However, only you can decide what is actually the best response. 

Tip:  You can hold your cursor over any Suggested Response to see information 
about it, without opening it. 

5 If the responses have attachments, verify that the attachments are appropriate for the 
customer�s question.

6 Right-click each response and select View Resource. Read the responses one by one, until you 
see one (or more) that you think answers the customer�s question. You may need to read all the 
Suggested Responses to find the response (or the responses) that you think answer the 
customer�s question best.

7 When you have found a response that you want to send to the customer, right-click it and select 
Use. 

The contents of the Suggested Response are inserted into your email reply. 

8 If you want, add some additional text to address your customer directly, or make any small 
changes that you think are necessary to better answer your customer�s question. 

9 If you found other Suggested Responses that you think are appropriate, repeat Steps 7 and 8. 
Each time you select Use for a Suggested Response, that response is added to the message. You 
may need to add or delete text to help your customer understand the multiple responses.

10 When the message is ready, click Send.

Sending an Email to an External Agent
If you do not know how to answer a customer�s question or solve a customer�s problem, you 
should forward the email to a person, usually outside of your company, who has been designated 
as an external agent because of special knowledge or skills.

You use a special type of email when you forward a customer�s email to an external agent. This 
type of email sends you or another agent an alert message if you do not get a response from the 
external agent within a certain period of time. 

To send an email to an external agent:
1 Display the email from the customer in Email Preview mode.
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2 Click the Reply to Customer button.

The window changes to the Email Compose mode. The drop-down menu shows the Normal 
Reply selection. You must change this.

3 Select Send to External Agent from the drop-down menu.

The letters RE: are added to the beginning of the Subject field of the email to indicate to the 
external agent that this message is about an email you received.

4 Click the button beside the To field.

The UAD is displayed in External Agent mode. Only external agents are visible. 

5 If the external agent is not located in your site, select the name of the site from the Site drop-
down menu. If you do not know where the external agent is located, select All Sites.

6 Navigate through the tenants and workgroups on the left side of the UAD for the name of the 
external agent.

7 Double-click the name of the external agent to move the name to the box on the right.

8 Select the name of the external agent in the box on the right.

9 Click Ok to add the email address of the selected agent to your email.

10 Write a message to the external agent in the Message Comments box, explaining briefly what 
information the customer needs.

11 Click OK.

12 Click Send when you are ready to send this email.
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Transferring an Email Contact
In most cases, you try to help your customers yourself (see �Using Resources in Email,� on 
page 100). But in some cases, you may not be able to handle a customer�s problem. In those cases, 
you may want to transfer the email contact to another agent or supervisor. When you transfer a 
contact, it is removed from your task list, and it is no longer your responsibility.

To transfer an email contact:
1 If you are not viewing the email you want to transfer in Email Preview mode, click the Preview 

tab.

2 Click the Transfer button in the email toolbar.

The UAD is displayed in Email Transfer mode. This mode makes it easier for you to find and 
add email addresses.

3 If you are certain that you know the email address of the person to whom you want to transfer 
this contact and do not need the UAD to help you find it, you can enter the address in the To 
field and then click the Blind Transfer button. The email is transferred.

4 If you want to transfer this email to a person with a particular skill, for example to someone 
who speaks a particular language or supports a particular product, use the Find option instead 
of the Queues or Agents tabs described in the following steps. See �Looking Up Agents with 
the Find Option,� on page 62. When you entered the agent or queue on the right side of the hen 
click the Blind Transfer button. The email is transferred.

5 Queues tab � If you want to transfer this email to a queue, click the Queues tab if it is not 
already selected. Then select the name of the queue from the list on the left side of the window. 

6 Agents tab � If you want to transfer this email to a person, click the Agents tab or the 
appropriate workgroup contact list tab. Then do the following:

a If the person you are looking for does not belong to the tenant or workgroups that are 
displayed in the box on the left side of the UAD, make an appropriate selection from the 
Site drop-down menu. If you are not certain which site the person belongs to, select All 
Sites.

b Navigate through the tree structure on the left. Click the plus icon (+) beside the name of 
any tenant or workgroup to display its contents. Use the scroll bars as necessary to see more 
information. 

c When you find the name of a person you want to transfer this email to, double-click the 
name to move it to the right side of the window.

Note:  If you need to delete the name that you moved to the right side of the window, 
double-click the name again to move it back to the left side.

7 If you want, add a comment to the agent who will receive this contact in the Transfer Comment 
box.
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8 Click Blind Transfer. 

The email is transferred and the email contact is removed from your task list.

9 In the box on the right, select the queue or agent and click the Blind Transfer button.

The Email is transferred to the queue or agent that you specified. The contact is removed from 
your Email task list.

Deferring an Email
When you need considerable time to find an answer to a customer�s question or a solution to the 
customer�s problem, you can defer the email contact so that you can work on it at a later time. 
When an email contact is deferred, another email contact can be routed to you in the place of the 
deferred contact. 

To defer an email:
1 Click the Defer button in the email Status Bar.

The message you have composed is saved as a draft. The email contact remains in your Email 
task list. You are available for another email to replace this one. The wait time for the contact 
continues to count while the contact is deferred.

The Email Compose window for this email goes away.

2 When you are ready to finish and send your reply to the deferred email, click it in your Email 
task list. 

The Email Compose window opens with the message that you deferred. This is now an active 
email contact.
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Saving a Draft
When you begin to reply to an email but cannot finish your reply at the moment, you can click the 
Save button to save it as a draft. This saves the contents of your reply, and leaves the Email 
Compose window for the reply as a tab so you can return to it. The email contact remains in your 
Email task list. No new email contact can replace this one until you finish your reply, send it, and 
close the contact.

Forwarding an Email
You may occasionally want to forward a copy of an email that you received to your supervisor or 
another agent, when you do not expect a reply. For example, you may want to forward an email 
expressing a customer�s interest in a product that another agent supports, so that agent can contact 
the customer. 

If you expect a reply from the person to whom you forward an email, forward the email to an 
external agent instead, as explained in �Sending an Email to an External Agent,� on page 103.

If the Unified Agent Directory (UAD) at your contact center uses contact list tabs or an Agents tab, 
you can use the UAD to forward the email to a particular person, or to anyone in a particular 
workgroup or anyone with a particular skill. 

To forward an email:
1 With the email displayed in the Email Preview window, click Forward.

The Information Bar tells you that the email will be forwarded to the specified recipient. The 
Subject field uses the subject of the email you are forwarding, preceded by FW: to indicate that 
this is a forwarded message.

2 Write a message to the recipient or recipients of this forwarded email at the top of the message 
itself. You may want to explain why you are forwarding the email and give any other relevant 
information.

3 Click the button beside the To, Cc, or Bcc fields, according to which of the following address 
fields you want to use:

� To � The main person or persons to whom you want to forward this message.
� Cc (Copy) � Anyone that you want to receive a copy of this email.
� Bcc (Blind Copy) � Anyone that you want to receive a copy of this email without anyone 

else seeing their address.

The UAD opens in Email Addressing mode. This mode makes it easier for you to add email 
addresses. In this mode, the UAD displays only queues and agents that are enabled for email 
and it contains only their email addresses.
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4 If you want to forward this email to a person with a particular skill, for example to someone 
who speaks a particular language or supports a particular product, use the Find option instead 
of the Queues or Agents tabs described in Steps 5 through 6. See �Looking Up Agents with the 
Find Option,� on page 62. Then return to finish the remaining steps of this procedure.

5 If you want to forward this email to a queue, be sure the Queues tab is selected. Then do the 
following:

a Select the name of the queue from the list on the left side of the window. 

b Click the To, Cc, or Bcc button to move the name of the queue to the appropriate box on the 
right side of the window.

Note:  If you need to delete the name of a queue that you moved to the right side of 
the window, click the name and press the Delete key on your keyboard.

c Click OK.

The email address of the queue is added to the appropriate field of the email you are 
composing.

6 If you want to forward this email to a person, click the Agents tab or the appropriate contact list 
tab. Then do the following:

a If the person you are looking for does not belong to the tenants or workgroups that are 
displayed in the box on the left side of the window, make an appropriate selection from the 
Site drop-down menu. If you are not certain which site the person belongs to, select All 
Sites.

b Navigate through the tree structure on the left. Click on the plus icon (+) beside the name of 
any tenant or workgroup to display its contents. Use the scroll bars as necessary to see more 
information. 

c When you find the name of a person you want to forward this email to, select it from the list 
on the right side of the window.

d Click the To, Cc, or Bcc button to move the name of the person to the appropriate box on the 
right side of the window.

Note:  If you need to delete the name of a person that you moved to the right side of 
the window, click the name and press the Delete key on your keyboard.

e Click OK.

The email address of the person you selected is added to the appropriate field of the email 
you are composing.

7 Repeat as desired if you want others to receive this forwarded email.

8 If you want to forward this email to anyone who is not in the UAD, type their address in the 
appropriate field.

9 Click Send when you are ready to forward this email to all the included addresses.
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Spell Checking Your Emails
Spelling errors can make your messages difficult to read and can sometimes lead customers to 
misunderstand what you type. Moreover, they often give customers an unfavorable impression of 
you or the company you represent. Therefore, you should use the Spell Checker to check the 
spelling of emails that you compose. 

You can spell check your email at any time before you send it. You can also set a preference to 
display the Spell Checker automatically whenever you press the Send button. This reminds you to 
check the spelling of each email message you compose. See �Email Preferences,� on page 169 for 
information.

To check the spelling of an email:
1 If you want to check the spelling of an email in another language, select that language from the 

Available Languages drop-down menu.

2 Select Contact > Spell Check. 

The Spell Checker is displayed.

Tip:  The Spell Checker has many features, all of which are labeled. You can see 
what happens when you click any of the buttons on the right side of the dialog box by 
holding your cursor over the button until a tooltip appears.

3 If you composed the message in any language other than your primary language, select that 
language from the Available Languages drop-down menu.

This action changes to the dictionary of that language. Any words that are not in the currently 
selected dictionary are displayed in the �Not in dictionary� text box.

4 If you see a word in the �Not in dictionary� box, look at it to see if you think it is spelled 
correctly. Look at the list of words in the Suggestions box to see if any of those words is the 
correct spelling for the word. If so, select the word and click the Change button.

Tip:  If a word is displayed in this box, it is not included in the currently selected 
dictionary. However, it may be spelled correctly. For example, names of people and 
products are not in the dictionary. You should add any name that you may use again 
to your user dictionary by clicking the Add button.



Chapter 4   Managing Email

110 Avaya Agent User�s Guide

5 You may decide that you do not want the Spell Checker to check certain types of words. Click 
the Options button to bring up a dialog box like that shown in the following illustration in 
which you can select items for the Spell Checker to ignore.

6 When you are finished checking this message, click Cancel.

Your email is sent and the Spell Checker closes.
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Requesting More Information from Customer
Occasionally a customer may send you an email with incomplete information. For example, the 
customer wanted to place an order but forgot to include a ZIP code in the shipping address. In this 
case, you send a special type of email asking for the missing information. 

To request additional information:
1 Display the email from the customer in Email Preview mode.

2 Click the Reply to Customer button.

The window changes to the Email Compose mode. The drop-down menu under the toolbar 
indicates that this is a Normal Reply.

3 Select Request Additional Information from the drop-down menu.

The Information Bar states, �This email will be sent to customer to request more information.�

4 Determine what information is missing from the email.

5 Put your cursor at the top left of the Email Composition Area and compose an email to the 
customer. Explain that you cannot help them or fulfill their request until they complete certain 
information. Tell them exactly what information is missing.

6 When your email reply is finished, read it to verify that everything is correct.

7 Click Send.

The email is sent to the customer. If the customer does not reply within the time limit set by 
administrators, you or another agent will receive an email alert.

Responding to an Email Alert
Occasionally you may receive an email alert. The purpose of this type of email is to remind you 
that a response from a customer or external agent to a previous email is overdue. The Information 
Bar informs you when an email is an email alert.

When you receive an email alert, you must take action to try to get a response. The previous email 
related to this alert may be either of these:
� An email was sent to the customer requesting more information, and the customer did not 

respond within the time limit for this type of email. 
� An email was sent to an external agent requesting information, and the external agent did not 

respond within the time limit for this type of email.

In some cases, you are the agent who sent the original email that requested a response. In other 
cases, another agent sent the email.
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The email alert may be a thread, that is, it may contain the contents of all the emails sent to and 
from the customer about the customer�s question or problem. You should remove any 
inappropriate information from the email thread when you do a reply.

To handle an email alert:
1 Double-click the email alert contact in your Email task list.

The Web Agent is displayed in the Email Preview mode. The Information Bar states, �This is 
an email alert. The recipient of a request for information has not responded to a request.�

2 Read the email thread to see what additional information was needed from the customer or the 
external agent. 

Tip:  If you did not send the email requesting information from the customer or 
external agent, you may want to click the Email History button to learn more about 
this email or previous emails from this customer.

3 Click the Reply button.

4 Write an appropriate message to the customer, requesting the information that is still needed.

5 Click Send to send your email to the customer.

Resolving an Email
You can resolve a message without writing an email response. When you resolve an email, you 
apply a status to it. The status tells the Email Management software how to handle this type of 
email. For example, the software may reply to the customer�s message automatically, using an 
email template. An email template is a complete email response that can be used to reply 
automatically to customer emails that are alike in some way.

For example, your company may set up a Dismiss status. You are to apply this status when all of a 
customer�s problems have been resolved and the customer writes an email to thank you for your 
help. When you apply the Dismiss status, a copy of an email template is sent to the customer. The 
text of the email thanks the customer for contacting your company and invites them to contact the 
company again. 

Your company has defined the list of statuses and the responses that are carried out for each status. 
The statuses and responses may include the following:
� A customer sends an email praising the service or product they received. You apply an 

Acknowledge status. A copy of an email template is sent to the customer to thank them for their 
email. 

� A person sends an email to your company�s email Support address, but the person is not listed 
as a customer. You apply a Rejection status. A copy of an email template is sent to tell the 
customer that they cannot receive support to help them solve their problem until they purchase 
a product.
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� A customer sends a frequently asked question (FAQ) about cameras, for example. You apply a 
Camera status. A copy of an email template is sent to describe the cameras that they may buy.

You may need to ask your administrator or supervisor what types of messages you should resolve 
and what statuses you should apply to them.

To resolve an email:
1 Become familiar with the email statuses that are available to you before you need to use them. 

Ask your administrator for information, or click the Resolve button in the Email Preview mode 
and read the description of each status.

2 When you receive an email contact that you need to resolve because it fits one of the statuses, 
display the email in the Email Preview mode. 

3 Click Resolve.

A dialog box is displayed asking you to select a status to apply to this message.

4 If the email is in a language that is not the primary language used at your company, select the 
language from the Filter by Language drop-down menu. 

5 Read the description of each status. 

6 If an email template is displayed in the scroll box at the bottom of the dialog box, read the 
message for each status to see if it is an appropriate response to this email. 

Tip:  You may see strings of characters within the messages that you do not 
understand. These character strings may be variables, that is, character strings that 
stand for information that changes automatically when the template is used. For 
example, the %date% character string may be a date variable that will change to the 
current date and %customername% may change to the current customer�s name 
whenever you use this resource.

7 Select the status that is appropriate for this email, and click Resolve.

The Email Management software carries out the action that is associated with this status. The 
dialog box closes and the email contact is removed from your Email task list.

Originating an Outbound Email
You may occasionally want to originate an email, that is, to send an email that is not a reply to an 
incoming customer email. For example, you may want to ask a question of your supervisor or 
another agent. 

To originate an outbound email:
1 If the Web Agent is not currently displayed, click the Web Agent button in the task bar. 

2 In the Web Agent, select Tools > Compose Email.
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3 The window is displayed in the Email Compose mode.

The Information Bar informs you that this is a new outbound email.

4 If you want to use the UAD to address this email to a queue or a person, click the button beside 
the field you want to use, as follows:

� To � The main person or persons to whom you want to address this message directly.
� Cc (Copy) � Anyone that you want to receive a copy of this email.
� Bcc (Blind Copy) � Anyone that you want to receive a copy of this email, without anyone 

else seeing their address. 

The UAD opens in Email Addressing mode. This mode makes it easier for you to add email 
addresses. In this mode, the UAD displays only queues and agents that are enabled for email 
and it contains only their email addresses.

5 If you want to address this email to a person with a particular skill, for example to someone 
who speaks a particular language or supports a particular product, use the Find option instead 
of the Queues or Agents tabs described in Steps 6 and 7. See �Looking Up Agents with the Find 
Option,� on page 62. Then return to finish the remaining steps of this procedure.

6 If you want to address this email to a queue, be sure the Queues tab is selected. Then do the 
following:

a Select the name of the queue from the list on the left side of the window. 

b Click the To, Cc, or Bcc button to move the name of the queue to the appropriate box on the 
right side of the window.

Note:  If you need to delete the name of a queue that you moved to the right side of 
the window, click the name and press the Delete key on your keyboard.

Note:  If you need to delete the name of a queue that you moved to the right side of 
the window, click the name and press the Delete key on your keyboard.

Tip:  If you need to delete the name of a queue that you moved to the right side of the 
window, click the name and press the Delete key on your keyboard.

c Click OK.

The email address of the queue is added to the appropriate field of the email you are 
composing.

7 If you want to address this email to a person, click either the Agents tab or the appropriate 
contact list tab. Then do the following:

a If you are using the Agents tab and the person you are looking for does not belong to the 
tenant or workgroups that are displayed in the box on the left side of the window, make an 
appropriate selection from the Site drop-down menu. If you are not certain which tenant or 
workgroup the person belongs to, select All Sites.
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b Navigate through the tree structure on the left. Click on the plus icon (+) beside the name of 
any tenant or workgroup to display its contents. Use the scroll bars as necessary to see more 
information. 

c When you find the name of a person you want to address this email to, select it from the list 
on the right side of the window.

d Click the To, Cc, or Bcc button to move the name of the person to the appropriate box on the 
right side of the window.

Note:  If you need to delete the name of a person that you moved to the right side of 
the window, click the name and press the Delete key on your keyboard.

e Click OK.

The email address of the person you selected is added to the appropriate field of the email 
you are composing.

8 Repeat as desired to add other email addresses.

9 If you know an email address of someone else to whom you want to address this email, type the 
address in the appropriate address field.

10 Put your cursor in the Email Composition area and type your message. 

11 Use the Add Attachment or Spell Check buttons as desired. 

12 When you are ready to send your message, click Send.

13 If a dialog box asks you for the information, specify the language to be used and the queue to 
be used for any replies to your email. 

14 If a dialog box asks for confirmation, click OK.

Your email is sent to the recipients.
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Approving or Rejecting an Email
The email replies that you and other agents send, or a certain percentage of them, may be sent to an 
Approver for Quality Assurance before the emails are sent to customers. You may be a designated 
Approver, even if you are not a supervisor. This section assumes that you are a designated 
Approver.

When you receive an email that needs Quality Assurance, the Email task list displays a Quality 
Assurance icon. You should give high priority to an email needing Quality Assurance because the 
customer is waiting for a reply and the approval process may take time.

When you click on an email contact that has been sent to you for Quality Assurance, the 
Information Bar also alerts you to the fact that the email was sent to you for your approval or 
rejection.

To handle an email sent to you for Quality Assurance:
1 Double-click the email contact in your Email task list.

Notice that the Information Bar informs you that this message needs Quality Assurance. 

2 Look at the customer�s message at the bottom of the email.

3 Click the Quality Assurance button.

The email is displayed as a reply to the customer in Quality Assurance mode. Depending on the 
way the Quality Assurance feature was set up by your administrator, the reply you compose to 
the customer here may be sent for approval again or it may be sent directly to the customer.

4 Carefully read the agent�s reply to the customer�s email. Read any attachments as well. Look 
for the following things:

� Did the agent respond appropriately to all of the customer�s questions and problems?
� Did the agent use polite language?
� Did the agent use reasonably correct grammar and spelling?
� Did the agent include company promotional information, if applicable?
� If the email used any resources, are they entirely appropriate? 
� If the email has attachments, are they appropriate?

5 If your answer to all of the previous questions is yes and you do not see any other problems 
with the email, do the following:

a Click Accept from the drop-down menu.
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b Click Send.

The email is sent directly to the customer.

6 If you see problems with the email, do the following:

a Click Reject from the drop-down menu.

The Information Bar changes to indicate that you rejected the agent�s message.
b Write a message explaining to the agent exactly what they need to do to make the email 

reply acceptable.

Note:  You may want to ask your administrator whether the agent who receives this 
rejected email is always the agent who wrote the reply. In some cases, the 
administrator has set up the software so that an Approver�s comments and a copy of 
the original email reply are sent to any available agent.

You may want to ask your administrator whether the agent who receives this rejected email 
is always the agent who wrote the reply. In some cases, the administrator has set up the 
software so that an Approver�s comments and a copy of the original email reply are sent to 
any available agent.

c Click Send.

A confirmation dialog box is displayed. 

d Click Yes.

This message is sent to the agent for correction. When the agent corrects the message and sends 
it again, the reply may be sent directly to the customer or it may be routed to you or another 
Approver, depending on the setup at your contact center.
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Handling a Rejected Email
Some or all of the emails you and other agents write to customers may be sent for approval (also 
known as Quality Assurance) to another agent or a supervisor who has been designated as an email 
Approver. This person reads the email and takes one of the following actions:
� Approves the email and sends it to the customer.
� Makes corrections to the email, marks it as Approved, and sends the corrected email to the 

customer.
� Marks the email as Rejected, along with a message explaining what needs to be done to make 

the message acceptable and sends the email for correction. It may be routed back to the original 
agent who wrote the rejected email or to any agent, depending on the setup at your contact 
center.

If you receive a rejected email in your Email task list, the email icon contains an X to indicate that 
it is a rejected email. You should usually select this contact before other email contacts in the list 
because the customer is still waiting for a reply. 

To edit a rejected email:
1 Double-click the rejected email contact in the Email task list.

The Web Agent window displays the rejected email in Email Preview mode. The Information 
Bar identifies this as a rejected message. 

2 Read the message carefully, noting the comments that the Approver put in the email. Note what 
changes are required to make the email to the customer acceptable.

3 Click the Reply button.

At this time, this email becomes a normal reply. 

4 Edit the email according to the changes recommended by the Approver.

5 When you are finished, reread the message from the Approver and check that you made all the 
desired changes. 

6 Remove the message from the Approver and the original reply that was rejected.

Caution:  The previous step is crucial. You must remove everything from this reply except the new 
message to the customer.

7 Read the entire message to check it again. Make any necessary changes.

8 When you are ready to send the message, click Send.

Depending on the setup at your contact center, the message is either sent back to an Approver 
or sent to the customer.

!
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Using Multiple Languages with Email
You may receive emails in a language that is not your primary language. If you know the language 
well, you may reply in that language. Check with your administrator if the language is not 
displayed properly.

You can also spell check your reply in that language. When you open the Spell Checker (select 
Contact > Spell Check), select the appropriate language from the Language drop-down menu. 

Below is a Web Agent displaying an email an agent is replying to in Chinese:

If you use another language, you may want to create some Agent Resources in that language. See 
�Managing Resources,� on page 155.
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Wrapping Up and Completing an Email Contact
When you have sent a normal email reply to a customer, you need to wrap it up and then you need 
to complete it.

When you click the Wrap button, you are in WrapUp state. While in WrapUp state, you cannot 
receive another email contact to replace this one. While in this mode, you may need to perform the 
following tasks:
� Log information about the session in a WrapUp dialog box.
� Follow a WrapUp script in Prompter.

To wrap up and close an email contact:
1 Click the Wrap button in the email toolbar.

2 If a dialog box asks if you want to confirm, click Yes.

Tip:  You can set a preference to control whether this dialog box is displayed 
whenever you wrap up an email contact. See �Setting Preferences,� on page 165.

3 If you see a WrapUp dialog box or a Prompter script, fill in the questions about this email 
contact. For information about the dialog box or script, see �Wrapping Up Contacts,� on 
page 67.

4 After completing any required wrap-up tasks, you can finish any optional follow-up tasks that 
are appropriate while you are in WrapUp state. No new email contact can replace this one until 
you click the Complete button.

See Chapter 6, �Performing Chat & Email Tasks� for information on tasks you may want to do 
while in WrapUp state. For example, you may want to submit information you used with this 
customer to the Web Self-Service database. (See �Using Web Self-Service,� on page 172.)

5 Click the Complete button in the email toolbar.

The email contact is completed. It is removed from your Email task list.
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CHAPTER 5
MANAGING CHAT SESSIONS

If your account is enabled for Web Management, you use the Web Agent to chat with customers 
(that is, to exchange typed messages with them in real-time). 

Customers visiting your company�s Web site who have a question or want help can click a button 
to request a chat session (or a chat session with a phone call or VoIP call). A request for a chat 
session becomes a chat contact and is routed by the Avaya� Interaction Center (Avaya IC) to 
agents who are available to handle chat. Chat contacts that are routed to you are displayed in your 
Chat task list.

This chapter explains how to receive and manage your chat contacts and the related collaboration 
features included with Web Management. The chapter contains the following topics:
� Being Alerted to a New Chat Contact
� Using the Chat Task List
� Handling a Basic Chat Session
� Sharing Browsers with a Customer
� Using Resources in a Chat Session
� Spell Checking Your Messages
� Using the Phone in a Chat Session
� Transferring a Chat Contact
� Handling a Join Us Conference
� Handling Simultaneous Chat Sessions
� Monitoring a Chat Session (Supervisors Only)
� Starting a Lotus Sametime Session
� Viewing the Customer�s DataWake Record
� Using Multiple Languages in Chat Sessions
� Wrapping Up and Completing a Chat Contact

Collectively, these and other chat-related capabilities are referred to as Web Management. 
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Being Alerted to a New Chat Contact
Chat requests sent by customers who click the Chat button on the company Web site may be routed 
to you whenever you are available for email. 

With chat, it is particularly important to respond quickly. Depending on how the Avaya IC 
software has been set up at your contact center, you may be alerted to a new chat contact in two 
ways:
� By a sound. A Contact preference lets you determine whether you are alerted with a sound. For 

information, see �Setting Preferences,� on page 165.
� By a screen pop. This is a dialog box that asks if you want to suspend your other contacts to 

begin handling the new chat contact. The �Wait for confirmation before accepting a contact� 
preference lets you determine whether screen pops are displayed when new contacts arrive. For 
information, see �Setting Preferences,� on page 165.

Note:  When a screen pop informs you that a new chat contact has arrived, clicking 
OK or pressing the Enter key begins the chat session with the customer. Be careful 
not to click OK or Enter accidentally when a screen pop appears. To be sure that you 
do not do this, you can turn off the �Wait for confirmation before accepting a contact� 
preference. 

If you are alerted to a chat contact but do not acknowledge it within a preset amount of time, the 
contact is assigned to another agent and removed from your Chat task list. The amount of time is 
set by the administrator of the WebACD Server configuration.
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Using the Chat Task List
The Chat task list displays all the chats that are currently assigned to you. Your Chat task list may 
be located near the bottom of your Media pane. Your Chat task list may look something like this:

Each entry in your Chat task list relates to a different chat contact. If you have more than one chat 
contact in the Chat task list, you can click each contact in turn to display its customer question. For 
each chat contact, the Chat task list displays the following information:
� Customer question � The text the customer typed when requesting a chat. The question is 

displayed only when you select the chat contact. The question is also displayed in the Web 
Agent when you double-click to make this the active contact.

� Name � The name that the user chose when creating an account, and logging in to the account, 
on the Web site. The user may have logged in as a guest.

� Duration � The length of time the customer has been assigned to you. This time runs 
continuously until you complete the contact.

� Waiting � The length of time the customer has been waiting for a response from you (that is, the 
time that has passed since the customer�s last response or since the customer requested to chat).

� Chat contacts in which a customer requested a phone call (Chat & Phone) or a VoIP call (Chat 
& VoIP) display the icons used for those features in the Web Agent.

Each chat contact has a customer icon. The color on the customer icon changes as the status of the 
chat contact changes. Shirt colors and other symbols indicate status as follows:
� Red � It is your turn to respond. (The customer has been waiting longer than the maximum 

desirable time set up by your administrator.)
� Green � You sent the last chat message and you are waiting for the customer to respond.
� Yellow � It is your turn to respond. (The customer responded recently. The length of time the 

customer has been waiting has not yet exceeded the maximum set by your system 
administrator.)

� Blue (with an arrow symbol) � The contact has been transferred to you.
� Exclamation mark (or another symbol, if this has been customized) � It is the customer�s turn to 

respond.
� The customer has been idle for awhile. 

Customer question (empty when

Chat contacts currently assigned to you

your cursor is not over a contact or
when no chat contact is selected.)

Oldest contact
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Handling a Basic Chat Session
This section presents the basic procedures that you use when you interact with a customer in a chat 
session. Before you go through the procedure, it is important for you to understand a chat session 
from the customer�s point of view.

When customers visit the Avaya� Interaction Center (Avaya IC) Web site that you are supporting, 
they can click buttons to ask for different types of help. If they click a Chat button, they are 
prompted to log in either with their user name and password or as a guest. When they click OK, a 
small computer program, the Customer Chat Applet, is downloaded from the Web site to their 
computer desktop, beside their Internet browser. The customer will type chat messages to you in 
the Customer Chat Applet.

As the request is routed, a message displayed in the Customer Chat Applet informs them that an 
agent will be with them shortly. If the request is routed to you, you see the chat contact in your 
Chat task list. As soon as you double-click the contact, the customer sees a message in the applet 
that you have arrived to help them

You should begin the chat session as instructed by your contact center administrators. For 
example, you may type �Hello� and introduce yourself.

Note:  Before you begin chatting with your first customer, check with your administrator to learn 
whether you send chat messages to customers by clicking the Enter key on your keyboard or by 
clicking the Say button in the Web Agent.

To interact with a customer using chat:
1 Make sure that you are available to handle chat by looking at the Chat button in the Web Agent. 

If the button has a yellow X, click the button to make yourself available for chat. 

When the Agent icon does not have a yellow X, you are available to receive the number of chat 
contacts that is set for you in your channel load. (See �Setting Your Channel Loads,� on 
page 49 for information.) Your channel load for chat is also displayed in the Chat icon in the 
Status Bar at the bottom of the Web Agent. 

2 In the Chat task list, double-click the contact you want to accept for a chat session. Usually this 
is the customer who has been waiting in queue the longest, whose name is at the top of the list.

If this is your first chat contact since you logged in (or the first chat session you are monitoring, 
if you are a supervisor), the File Download dialog box is displayed, asking you to choose what 
to do with aimagentcl.hta file. This dialog box will not appear again until your next login 
session.

Caution:  You must open this file (not save it), as indicated in Step 3. 

Tip:  The aimagentcl.hta file is necessary for Shared Browsing. It opens browsers for 
you to share with your chat customers. 

!
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3 If the File Download dialog box is displayed, click �Open this file from its current location,� as 
shown in the following illustration. Then click OK.

An Internet browser icon is added to your Windows Task Bar. This is the browser you will use 
for Shared Browsing with your first chat customer. For each chat contact that you handle, 
another browser will open and another icon will be added to the task bar. If you are a supervisor 
and do not plan to use Shared Browsing in your monitoring sessions, you may want to select an 
option that keeps browsers from opening for each session. See �Setting Preferences,� on 
page 165 for more information.
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The Web Agent opens in Chat mode, as shown in the following illustration:

4 Read the customer�s question in the scroll box above the Transcript area. You may need to 
scroll to see the customer�s entire question.

5 Consider whether any of the Global Resources or Agent Resources are appropriate to send to 
the customer.

For information on viewing resources, see �Viewing Your Resources,� on page 161. For 
information on adding resources to a chat, see �Using Resources in a Chat Session,� on 
page 133.

6 Put your cursor in the Text Entry area and type a message in response to your customer�s 
question.

Customer�s
question

Type your message here
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7 When you are ready to send your message to the customer, click either the Say button or the 
Enter key, depending on the configuration of Avaya IC on your desktop. 

Note:  If the Spell check before a �Say� preference has been selected (see �Chat 
Preferences,� on page 170), any text you enter in the Text Entry area is spell-checked 
after you click the Say button. If this option is not selected, you can click the Spell 
Check button or select Contact > Spell Check at any time to check a message. For 
more information on the Spell Checker, see �Spell Checking Your Messages,� on 
page 135.

Your customer sees the message you just sent in their Customer Chat Applet. In the Web Agent, 
your message is moved to the Transcript area, beginning with your login ID followed by a 
colon (for example: Mary:). Your Web Agent may look like the following illustration:

When your customer replies, you see their message under yours in the Transcript area, 
preceded by the customer�s user name. 

8 Continue your conversation with the customer. Read the customer�s messages, and type and 
send your responses.

9 Use any of the following buttons to access other features while you are in the chat session:

� Print � Prints a paper copy of the text that is in the Information Bar, Text Entry, and 
Transcript areas at the current time.

Message agent sent

Message agent is about to send
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� Auto-Sync � Starts an Auto-Sync session so that your customer�s browser will display the 
same Web pages as your browser as you navigate through Web pages. See �Using Auto-
Sync,� on page 129 for more information.

� Join-Us � Starts a Join Us session in which friends of your customer can join the chat 
session. See �Handling a Join Us Conference,� on page 144 for more information.

� Sametime � Starts a Lotus Sametime� session with your chat customer. You can only use 
Sametime if it is installed and configured for both you and your chat customer. See �Starting 
a Lotus Sametime Session,� on page 149 for more information.

� Transfer � Displays the Unified Agent Directory (UAD) so that you can transfer this chat 
contact to another agent or supervisor. For information, see �Transferring a Chat Contact,� 
on page 142.

10 When all your customers� questions have been answered and your customer is satisfied, wrap 
up and complete the chat contact according to the instructions in �Sharing Browsers with a 
Customer,� on page 128.

Sharing Browsers with a Customer
The term �Shared Browsing� refers to a set of three features that make it possible for you and your 
chat customer to see, and interact with, the same Web pages at the same time. You can use the 
Shared Browsing features with any customer in any chat session.

Shared Browsing includes the following features:
� Auto-Sync � When you click Auto-Sync and then navigate through a Web site, your customer�s 

browser follows your lead to display the same pages simultaneously. 
� Page Push � You �push� a URL to your customer. Your customer sees the page displayed 

within their browser. The customer can push a URL to you as well.
� Collaborative Form Filling � Whenever you share a Web page with a customer (through Page 

Push or Auto-Sync), you can help your customer fill out forms, such as registration forms, 
shopping cart pages, and checkout pages. You can see what the customer types and the 
customer can see what you type.

Note:  You can use the three Shared Browsing features when multiple agents are in the session. 
The first agent in the chat session is in charge of the Auto-Sync session. All agents can push pages 
and collaborate on form filling. 
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Technical Issues with Shared Browsing
You need to be aware of the technical issues in this section so that you can explain them to your 
customers when necessary.

Customers Using Netscape 6.0 and Netscape 6.2.1

Chat customers who are using Netscape 6.0 through Netscape 6.2.1 cannot share browsers with 
you. When you try to use Auto-Sync or Page Push with a customer who is using those particular 
versions of Netscape, the customer receives a message prompting them to install a later version. 

Privacy Protection for the Customer

A customer can follow your browser when you Auto-Sync but the customer cannot lead. 
Therefore, the customer can visit any other page or Web site, knowing that you are not watching 
them as they navigate. 

Shared Browsing on External Web Sites

Usually when you share browsers with a customer, you and your customer are browsing your 
company�s Web site or a Web site that your company supports. Sometimes, however, your 
customer may want to show you a product on an external Web site (also called an off-domain Web 
site). Or you may want to show your customer a product on an external Web site to show the 
customer that your company�s similar product is better or less expensive. 

However, using Shared Browsing with an external Web site can sometimes cause problems. A 
page may not be displayed properly on your browser or your customer�s browser. Or the page you 
see may not exactly match the page that your customer sees. You may want to ask your supervisor 
or administrator if there is anything you should know about using Shared Browsing on external 
Web sites. 

Using Auto-Sync
With Auto-Sync, you and your chat customer can navigate the Web together, that is, you can see 
the same Web pages at the same time. You are always in the lead. 

Any action that you perform in your browser, such as entering information in a form or following 
links, is reflected in the customer�s browser when you click Auto-Sync. If a customer wants to 
send you a page, such as information they entered on a form, they must click a Send Page button.

You can click a button to stop (and start) the Auto-Sync feature at any time. 

To use Auto-Sync to share browsers with your customer:
1 While in a chat session, tell your customer that you are going to lead them as you navigate 

through some Web pages. Explain that they will see the same pages in their browser that you 
see in yours. 
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2 Click the Internet Explorer icon in the Windows Task Bar to open the Shared Browsing 
browser for this customer.

Tip:  If you are handling two or more chat contacts simultaneously, there is an 
Internet Explorer icon for each customer.

3 Go to a Web page that you want your customer to see.

4 Click the Auto-Sync button.

The Web page in your browser is pushed to the customer. The Auto-Sync button changes to 
show arrows indicating that Auto-Sync is turned on. The Transcript area also states that Auto-
Sync was turned on. 

5 Ask your customer if they can see the Web page you just sent. Chat with your customer about 
the page, as appropriate.

6 If your customer wants to lead you to a different page, tell them to go to that page and click the 
Send Page button (or whatever it is called) in their applet. They can also paste the URL into the 
applet and click Send Page. 

You should see the page your customer sends you on your browser. You can also see the URL 
the customer typed in the Transcript area of the Web Agent.

7 Continue to share Web pages with your customer, until you satisfy their request and answer all 
their questions.

Tip:  You can see the URLs of all the pages you shared with your customer, and any 
pages your customer shared with you, in the Transcript area.

8 Click the Auto-Sync button again when you want to end the Auto-Sync session. 

The button changes to indicate that it is turned off. The Transcript states that Auto-Sync was 
turned off. You can easily start another session with this customer whenever you want by 
clicking the Auto-Sync button again.

Tip:  If you begin a chat session with another customer before you complete the chat 
session you are currently handling, another browser will open for the second 
customer. 
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Pushing a Web Page
At any time during a chat session, you can �push� a Web page to your customer. Your customer�s 
browser opens to that page almost as soon as you push it.

Use this feature when you want to show your customer some information or to help your customer 
find a page they are looking for. 

Tip:  Use Page Push when you want to show your customer a single page. If you want to lead your 
customer to a series of pages, use Auto-Sync instead.

Tip:  If you send the same URL repeatedly, it is easier to create a URL resource and then send the 
resource any time you want. See �Managing Resources,� on page 155 for more information.

To push a Web page to your customer:
1 Type a complete URL in the Text Entry area. It must begin with http://, https://, or ftp://.

Example of an incomplete URL: www.avaya.com

Example of a complete URL: http://www.avaya.com

2 Click the Push URL button.
The Transcript area shows that you have pushed a URL to your customer. Your customer sees a 
message in their applet that a URL was sent to their browser. If you entered the URL correctly 
and the URL is currently working, the customer�s browser opens to the page you pushed.

3 Verify with your customer that the page is displayed in their browser.

Helping Your Customer Enter Information
Any time you are sharing browsers with your customer, you can help the customer fill in 
information on a Web page. This feature is called Collaborative Form Filling. A form can be a 
Web page or any part of a Web page where customers enter information. For example, your 
customer may need help entering information on the following types of forms:
� Registration form
� Shopping cart or order page
� Checkout page

When you or your customer enter information in a form that you are sharing, you both see that 
information immediately. Thus, you can take turns entering information. The customer must 
submit the information when the form is complete. 

To help your customer fill in a form:
1 Verify that your chat customer wants help filling out a form. 

2 Ask if the customer is currently viewing the form.
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3 If the customer is viewing the form, ask them to click the Send Page button. 

The page is displayed on your browser. If the customer has entered any information, you see 
that information.

4 If the customer is not viewing the form, and you know where it is located, you can do one of the 
following:

a Go to the URL with your browser. Click Auto-Sync.

OR
b Type the URL in the Text Entry area. Click Push Url.

The customer should see the page on their browser.
5 If the customer is not viewing the form, and you do not know the URL, ask them to go to the 

page containing the form and click the Send Page button.

6 Take turns with your customer, as needed, to fill out the form. 

Everything you type in the form is displayed immediately on the customer�s browser. 
Everything your customer types is displayed on your browser as soon as the customer clicks the 
Send Page button.

Tip:  Be sure to take turns with your customer. If you and your customer type 
simultaneously, the information you enter will be garbled. If this happens, ask your 
customer to click the Send Page button again.

7 Make sure your customer clicks the appropriate button to submit the form when it is finished.

Tip:  When your customer clicks the button, the page you are viewing may no longer 
be the same as your customer�s page. In this case, ask your customer to click the Send 
Page button again.
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Using Resources in a Chat Session
Resources are previously prepared text, emails, or URLs that you can send repeatedly to different 
customers by chat or email. Resources save you the time and tedium of typing the same things 
again and again. Text and email resources may contain such things as greetings, closings, and 
answers to frequently asked questions. Email resources may have information already entered in 
the To, Cc, Bcc, and Subject fields, and they may contain attachments. URL resources may be 
links to company Web sites, such as a page about exchange policies. 

When you are in a chat session with a customer, you can send text and URL resources. Although 
you cannot send an entire email resource from a chat session, you can send the text of the email 
resource.

When you are in a chat session or when you have selected a chat contact, you see the following 
folders in the Resource Area of the Web Agent:
� Global Resources � Resources that your administrator or supervisor has prepared for you and 

other agents. All agents in the group the resources were prepared for see these resources when 
they log in.

� Agent Resources � Resources you create yourself for your own use. These resources are saved 
with your account. Other agents cannot see the resources that you create.

� Migrated Resources � You see this folder after you import migrated resources. Your 
administrator will inform you if you need to do this. If you do, see �Importing Migrated 
Resources,� on page 164. 

For information and examples of the resource types (text, email, and URL), and instructions on 
creating resources, see �Creating New Agent Resources,� on page 157. 

To send a text resource while in a chat session: 
1 If you want to see all the resources within all folders, click the Expand All Folders button 

above the Resource Area. If you want to see only the main folders, click Collapse Folders. 

Tip:  To expand or collapse the contents of an individual folder, right-click the folder 
and select Expand Folder or Collapse Folder.

2 If you want to limit the resources that you see, select the type of resource you want to see from 
the �Filter by� drop-down menu and select one of the following menu options:

� [Blank � Displays all types of resources for all tenants and all languages.]
� Tenant � Displays only the resources for a specified tenant, which may be any group in an 

organization, such as a company, location, or workgroup.
� Language � Displays only the resources for a specified language.
� Text Resources � Displays only text resources.
� URL Resources � Displays only URL resources.
� Email Resources � Displays only Email resources.
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3 If you only want to view the contents of a resource, do one of the following:

� Select the resource and click the Preview Contents check box. A scroll box opens, 
displaying the resource contents.

� Right-click the resource and select View Resource from the pop-up menu.

4 If you want to send a text resource or the text of an email resource immediately, just as it is, 
right-click the resource and select Say. 

Tip:  You may also be able to send a resource directly to the customer by double-
clicking it, depending on the way Avaya IC has been configured at your contact 
center. If double-clicking sends a resource to the customer, be careful not to double-
click before you are ready.

The text is sent to the customer and is also displayed in the Transcript area, preceded by your 
login ID within brackets and a colon. For example, if your login ID is JackS and you send the 
message �Hello� to your customer, the Transcript area displays the following:

<JackS>: Hello.

5 If you want a URL resource to open in the customer�s browser, click the resource and select 
Push.

The Web page at that URL automatically opens in the customer�s browser. The URL is 
displayed in the Transcript area of the Web Agent, preceded by your name, as described in 
Step 4.

Tip:  You can also type a URL directly in the Text Entry area and click Push URL to 
have the customer�s browser open to a Web page.

6 If you want to modify a resource in the Text Entry area or add a message to the customer or 
before sending the resource to the customer, do the following:

a Right-click the resource and select Insert or Insert Quoted. 

Tip:  By default, Insert Quoted adds an angle bracket (>) to indicate to your customer 
that the text is different from text you write to the customer directly. If you want, you 
can change the character that is used. See �Chat Preferences,� on page 170. 

b �Setting Preferences,� on page 165Modify the text and add any new text you want to send 
your customer in the Text Entry area.

c When the text in the Text Entry area is as you want it, click Say to send it to your customer.
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Spell Checking Your Messages
Spelling errors can make your messages difficult to read and can sometimes lead customers to 
misunderstand what you type. Because you want to type fast, it is difficult not to make many 
spelling errors in a chat session. Therefore, it is a good idea to use the Spell Checker. 

A preference displays the Spell Checker every time you click the Say button so that you can check 
each message before it is sent to the customer. Although it takes time to check every message, it is 
recommended that you turn on this chat preference and see how it works for you. See �Chat 
Preferences,� on page 170.

If you prefer, you can check only those messages that you want to check, as described here. 

To check the spelling of a chat message before you send it:
1 Put your cursor in the Text Entry area where you typed a message you want to check.

2 Select Contact > Spell Check.

The Spell Checker is displayed.

Tip:  The Spell Checker has many features, all of which are labeled. You can see 
what happens when you click any buttons on the right side of the dialog box by 
holding your cursor over the button until a tooltip appears.

3 If you wrote the message in any language other than your primary language, select that 
language from the Available Languages drop-down menu.

This action changes to the dictionary of that language. 

4 If a word is displayed in the �Not in dictionary� box, look at it to see if you think it is spelled 
correctly. Look at the list of words in the Suggestions box to see if any of those words is the 
correct spelling for the word. If so, select the word and click the Change button.

Tip:  If a word is displayed in this box, it is not included in the currently selected 
dictionary. However, it may be spelled correctly. For example, names of people and 
products are not in the dictionary. You should add any name that you may use again 
to your user dictionary by clicking the Add button.
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5 You may decide at any time that you do not want the Spell Checker to check certain types of 
words. Click the Options button to bring up a dialog box like that shown in the following 
illustration where you can select items for the Spell Checker to ignore.

6 When you are finished checking this message, click Cancel.

Your message is sent and the Spell Checker closes.

Using the Phone in a Chat Session
While connected to a customer in a chat session, you can also speak to the customer, using what is 
called Voice Chat. You can use two types of Voice Chat: 
� Chat & Phone (also known as Callback) � You and your chat customer speak to each other over 

your telephones or headsets. The customer can request this type of call from the Web site or 
you can initiate it from the Web Agent.

� Chat & VoIP � You speak to your chat customer over your telephone or headset. Your customer 
speaks to you over the Internet, using their computer�s microphone and speakers. The customer 
can request a Chat & VoIP from the Web site or the customer may ask you for VoIP when you 
are chatting. In both cases, you must initiate the VoIP session. 

The two types of Voice Chat may seem almost the same to you, because you speak to your chat 
customer over your telephone in both types. However, the VoIP call is different for customers 
because they speak to you over their computer�s microphone and speakers, rather than a telephone. 
Customers whose connection to the Internet is over their telephone line may prefer this type of call 
because it makes it possible for them to continue browsing the Web site as they speak to you.
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In both types of Voice Chat, you speak to your chat customer in real-time, just as with an ordinary 
telephone call. Voice Chat can make your interaction with the chat customer faster and more 
satisfying for both of you than chat alone, in the following ways:
� A Voice Chat is easier for customers who do not type well.
� A Voice Chat is usually faster for both you and your customer.
� A Voice Chat makes it possible for you and your customer to hear each other�s tone of voice.
� A Voice Chat can combine other chat features with voice. For example, you can speak about 

the Web pages as you browse them together with Auto-Sync.

Handling a Chat & Phone Session
You and your chat customer can speak to each other over the telephone while you remain in the 
chat session together. You may receive a chat contact with a request for this type of session or you 
may suggest it to a customer with whom you are chatting. Read the appropriate procedure below, 
depending on whether your customer requested a Chat & Phone call or you want to suggest one to 
your customer. 
� Responding to a Chat & Phone Request
� Initiating a Chat & Phone Request

You use the Softphone interface in the Avaya Agent to control the telephone call portion of a Chat 
& Phone session. For information on handling a call with Softphone, see �Handling a Basic Voice 
Contact,� on page 75.

Responding to a Chat & Phone Request

When a customer requests a Chat & Phone call from the Web site, the request becomes a chat 
contact. You must connect the telephone call, as described in the following procedure. If the 
contact is assigned to you, the icon displayed for the contact in your Chat task list indicates that 
this is a Chat & Phone request.

To respond to a Chat & Phone request:
1 Double-click the Chat & Phone contact in the Chat task list. 

The Web Agent opens to the Chat & Phone mode with this contact currently active. The 
telephone number that the customer entered is displayed beside the Telephone button.

2 Type a message to the customer in the Text Entry area and click Say to send the message.

For example, you may say, �Hello, Maria. I see that you want me to call you on the phone. I 
will call you now at the number you entered.�

3 If necessary, put on your headphones.
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4 Click the Chat & Phone button beside the customer�s telephone number.

You hear noises as the telephone number is dialed by the system. Then you hear the customer�s 
telephone ring. (If you need to cancel the call before it is completed, click the Cancel Chat & 
Phone button.)

5 When your customer answers the telephone, say �Hello� and introduce yourself as the agent 
who is in a chat session with them. Begin helping your customer.

Tip:  Because you are still in a chat session with the customer, you may also be able 
to do the following things while you are on this telephone call:

� Use Auto-Sync, Page Push, or Collaborative Form Filling. However, you cannot use these 
Shared Browsing features if your customer is using this telephone line to connect to the 
Internet. (See �Sharing Browsers with a Customer,� on page 128.)

� Send text and URL resources to your customer. (See �Using Resources in a Chat Session,� 
on page 133.)

� Transfer the chat session to another agent, supervisor, or external agent. (See �Transferring 
a Chat Contact,� on page 142.)

� Invite another person into the chat session. (See �Handling a Join Us Conference,� on 
page 144.)

6 When you are certain that the customer is satisfied, say good-bye and hang up the telephone.

7 Click the Wrap button in the Web Agent to wrap up the chat contact.

The chat contact enters WrapUp state. For information on wrapping up contacts, see �Wrapping 
Up Contacts,� on page 67.

The voice contact continues until you click the HangUp button in the Softphone.

8 Click the Complete button in the Web Agent when you are ready to complete the chat contact. 

9 Finish speaking to the customer on the telephone. Then click the HangUp button.

10 Wrap up the voice contact.

Initiating a Chat & Phone Request

Any time you are chatting with a customer, you can suggest that you call them while you remain 
connected to each other in the chat session.

To add Chat & Phone (callback) to a chat session:
1 Ask your current chat customer if they would like you to call them. Explain why you think that 

this is a good idea. 

For example, you may type, �I think it will be easier for you to explain how I can help you over 
the telephone. Would you like me to call you?�
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2 If necessary, put on your headphones.

Tip:  You may want to make yourself unavailable for voice contacts in the Avaya 
Agent. This ensures that you will not receive another call while you set up this Chat 
& Phone session.

3 Click the Chat & Phone button in the Avaya Agent. 

4 Click the Telephone button (Request Callback Information). 

This action causes a dialog box to be displayed in your customer�s applet asking them to enter 
their telephone number. After the customer enters the number and presses the Enter button, you 
see the number in the Web Agent beside the Activate Chat & Phone button.

Tip:  If the customer is registered or the customer entered their telephone number 
from the Web site, their telephone number is pre-entered. You may want to verify 
with your customer that this is the correct telephone number. If necessary, you can 
change the number in the text box or enter a new one. 

5 Look at the Phone channel button in the Avaya Agent. If the button has a yellow X, click the 
button to make yourself available.

6 When you know the telephone number in the Caller Number box is correct, click the Activate 
Callback button. 

You hear noises as the telephone number is dialed by the system. Then you hear the customer�s 
telephone ring. (If you need to cancel the call before it is completed, click the Cancel Callback 
button.)

7 When you hear the customer answer the telephone, say �Hello� and introduce yourself as the 
agent helping them in the chat session.

8 Help your customer with their question or problem. 

Tip:  Because you are still in a chat session with the customer, you may also be able 
to do the following things while you are on this telephone call:

� Use Auto-Sync, Page Push, or Collaborative Form Filling. However, you can only use these 
Shared Browsing features if your customer does not use this telephone line to connect to the 
Internet. (See �Sharing Browsers with a Customer,� on page 128.)

� Send text and URL resources to your customer. (See �Using Resources in a Chat Session,� 
on page 133.)

� Transfer the chat session to another agent, supervisor, or external agent.
� Invite another person into the chat session (See �Handling a Join Us Conference,� on 

page 144.)

9 When you are certain that the customer is satisfied, say good-bye and hang up the telephone.
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10 Click the Wrap button in the Web Agent to wrap up the chat contact.

The chat contact enters WrapUp state. For information on wrapping up contacts, see �Wrapping 
Up Contacts,� on page 67.

The voice contact continues until you click the HangUp button in the Softphone.

11 Click the Complete button when you are ready to complete the chat contact. 

12 Finish speaking to the customer on the telephone. Say good-bye when you are ready to hang 
up. Then click the HangUp button.

13 Wrap up the voice contact. 

Handling a Chat & VoIP Session
Many customers who are browsing your company�s Web site cannot use their telephone while they 
are connected to the Internet. If they have a question, they may click a VoIP button so they can 
continue browsing the Web site as they speak to an agent. If you are enabled to receive this type of 
contact, this request may be routed to you and appear in your Chat task list. You must initiate the 
Chat & VoIP feature from the Web Agent.

Customers must meet certain requirements to be able to engage in a voice chat session with you. 
These requirements may be on the Web site but some customers may not read them, or understand 
them. When you start the VoIP call, the customer�s computer will be checked and the customer 
will receive a message if the computer does not meet the requirements. However, it is a good idea 
to ask your customer to check certain items before this happens, as described in the following 
procedure. 

After you connect to your chat customer through VoIP, you will speak to the customer over your 
telephone.

To respond to a VoIP request:
1 Click the Chat & VoIP contact in your Chat task list.

The Web Agent opens in the VoIP mode.

2 Type a message to the customer in the Text Entry area and click Say to send the message.

For example, you may say, �Hello, Maria. This is John at XYZ Tech Support. I see that you 
want me to call you with VoIP. Are you familiar with VoIP calls?�
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3 If the customer is not familiar with this type of call, ask them to check that the following 
statements are true:

� They are using the Windows operating system.
� They are using one of the following Internet browsers:

Internet Explorer 4.01, 4.5, 5.0, 5.01, 5.5, or 6.0
Netscape Communicator 4.01, 4.08, 4.5, 4.7, 4.75, 6.0, or 6.1
AOL 6 or 7

� Speakers, microphone, and sound card on their computer exist. The speakers are turned on 
and the microphone is plugged in to the computer. 

� Their audio device is not already in use, such as playing music.

4 If necessary, put on your headphones.

5 Look at the Phone channel button in the Avaya Agent. If the button has a yellow X, click the 
button to make yourself available.

6 Click the Initiate VoIP button:

The Avaya� Interaction Center software sends a dialog box to your customer. The customer 
can click the Run Test button to check their computer to see if it meets all the requirements.

If the customer�s computer is not able to use VoIP, the customer receives an error message, 
explaining the problem. You can also see the error message in the chat transcript.

If the customer�s computer meets the requirements, a connection is made between your 
computer and your customer�s computer. The customer�s applet and your Web Agent show the 
status of the connection as it occurs.

7 When the status message informs you that the connection has been made, say �Hello� and ask 
if your customer can hear you.

Tip:  If the connection breaks during the session, you receive a message to help you 
troubleshoot the problem. 

8 Help your customer with their original question or problem. 

Tip:  Because you are still in a chat session with the customer, you can use any of the 
following features in this VoIP call:

� Use Auto-Sync, Page Push, or Collaborative Form Filling. (See �Sharing Browsers with a 
Customer,� on page 128.)

� Send text and URL resources to your customer. (See �Using Resources in a Chat Session,� 
on page 133.)

� Transfer the Chat & VoIP session to another agent or supervisor.
� Invite another person into the chat session. (See �Handling a Join Us Conference,� on 

page 144.)



Chapter 5   Managing Chat Sessions

142 Avaya Agent User�s Guide

9 When you are certain that the customer is satisfied, say good-bye and hang up the telephone.

10 Click the Wrap button in the Web Agent to wrap up the Chat & VoIP contact.

The chat contact and the VoIP contact are both wrapped up as a single contact. Your customer�s 
applet informs them that the session is finished. 

11 Click the Complete button when you are ready to complete the contact. 

The chat contact and the VoIP contact are both completed as a single contact.

Transferring a Chat Contact
Occasionally may want to transfer a chat contact to another agent who is more qualified to handle 
it or to your supervisor to handle a customer who needs more attention.

You can use the Unified Agent Directory (UAD) to transfer the chat contact to someone who is 
currently available to handle the session. You can use the following features to transfer the contact:
� Blind Transfer - Transfer the contact and have it immediately removed from your Chat task list 

and the Web Agent. The transferred chat waits in queue until the person to whom you 
transferred the contact clicks the contact in their task list. If the agent does not answer soon 
enough, you can cancel the transfer or continue to chat with the customer until the second agent 
is available.

� Cons (Consultative) Transfer - Transfer the contact and chat with your customer and the other 
agent as you make the transfer. You can introduce the customer to the other agent and explain 
the nature of the call.

� Conference - Transfer the contact and remain in the chat session as long as you want after the 
other agent arrives. You can add more people to the conference by repeating conference 
procedures for each additional agent.

You can also transfer a Chat & Phone or Chat & VoIP session. If the agent you transfer is available 
for both chat and telephone, both the chat session and the call are transferred. If the agent is not 
available for the call, the chat session alone will be transferred.

If you want to transfer a chat contact to agents with specific skills, follow the instructions in 
�Looking Up Agents with the Find Option,� on page 62 to find the agent. Then return to Step 4 of 
the procedure below to complete the transfer.

You can transfer a chat to a person but not to a queue. 
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To transfer a chat contact:
1 Tell your chat customer that you are going to transfer them to someone who will be able to help 

them.

2 Click the Transfer Current Contact button in the Web Agent to display the UAD. 

If the UAD has an Agents tab, that tab is selected in the scroll box on the left. The site to which 
you belong may be open, displaying the people who belong to that site. A site is typically a 
location or a workgroup. If the UAD has a contact list tab for a workgroup, you may use that 
tab for your search.

Tip:  The UAD may display only the names of people who are currently logged in 
and available. If you want to see the name of agents in other agent states, use the 
Filter or Find items in the UAD�s View menu.

3 If you do not find the person and think that they may be in a different group, click the Site drop-
down menu to make another selection, or select All Sites.

Tip:  If you are not certain about the login ID of the person to whom you want to 
transfer the chat session, right-click the person�s name. Then click the Properties pop-
up menu. A dialog box with information about this person is displayed. 

4 When you find the name you want, double-click the name (or select it and click the >> button).

The name you selected is displayed in the box on the right side of the UAD, along with 
information about the person.

Tip:  If you need to remove a person�s name from the right side of the UAD, select 
the name and click the Delete button on your keyboard.

5 Repeat as desired if you want to transfer the session to more than one person.

6 If you see a Transfer Comment field and want to address a comment to the person to whom you 
are transferring the chat session, enter your message here. 

7 Click any of the following buttons:

a Blind Transfer � To transfer the contact and leave the chat session immediately. The chat 
session is removed from your Chat task list and from the Web Agent.

b Cons Transfer (Consultative Transfer) � To chat with the person to whom you are 
transferring the chat contact and to the customer. This makes it possible for you to introduce 
the customer and the person who will handle the contact and to explain the customer�s 
problem or question. 

Note:  If you are transferring a Chat & Phone or Chat & VoIP session, you must enter 
the agent�s name in the To field before clicking the Cons Transfer button. Otherwise, 
a message will say �Destination Busy� and you will not be able to transfer the 
contact. The UAD attempts to transfer both the chat session and the call. However, if 
the agent is speaking on the phone, the chat session may be transferred without the 
call.
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If available, the agent or supervisor enters the session. You can stay in the session as long as 
you want. 

Note:  If the agent is busy with another contact, your customer waits in a queue until 
the agent or supervisor can begin this contact. 

c Whenever you decide to leave the session, click Wrap. 

You are dropped from the chat session. The other agent or agents continue to interact with the 
customer. 

8 Complete the chat contact as usual. (See �Wrapping Up and Completing a Chat Contact,� on 
page 153.)

The first agent to whom you transferred the chat contact must also wrap up and complete their 
contact when they are finished.

Handling a Join Us Conference
You may occasionally have a customer who would like to invite one or more others to join the chat 
session. This type of session is called a Join Us Conference.

To create the Join Us Conference, you first create a Join Us password. You send this password with 
a special URL to anyone who is to enter the Join Us session. These people go to that URL and 
enter a handle (user name) and password. You can then all share browsers and type messages to 
each other about what you see.

For example, say that you have a customer who is thinking about buying an item on the company 
Web site but wants the advice of his wife before making a decision. You suggest that his wife join 
the session and he agrees. You follow the instructions below to create the password and to convey 
the URL and instructions to your customer�s wife. She then goes to that location and enters her 
name and the password. A Customer Chat Applet for typing and viewing chat messages is then 
downloaded to the wife�s browser. Now the three of you can exchange chat messages in a three-
way session.

The following instructions explain how to have a person of your customer�s choice join a 
conference. (In the instructions, the person is called a �friend,� but of course it may be a spouse or 
an acquaintance.) If your customer wants more than one person to join, repeat the instructions as 
needed.

Before you begin, ask your administrator for the URL for Join Us conferences.

To handle a Join Us conference:
1 Chat with your customer about having someone they know join the chat session. (These 

instructions refer to this person as your customer�s �friend.�)
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2 Explain to your customer that their friend must visit a chat room on at a specific Web address 
(URL) and must enter a specific password. Ask your customer which of the following methods 
they want you to use to give their friend the URL and the password they will need to join the 
chat:

� You send the information to your customer and the customer passes it on to their friend.
� You send the information to your customer�s friend through the friend�s email account. 
� You call your customer�s friend on the telephone and give them the information.

3 Ask your customer to send the friend�s email address or telephone number. (You must be 
enabled for the voice media channel to make a call.)

4 Click the Join Us button in the Web Agent window.

The Join Us dialog box is displayed. It may display a password chosen for you or the password 
field may be empty.

5 If the password field is empty, enter a password.

Tip:  Write down the password and the customer�s name in case you forget it later.

6 If your customer sent their friend�s email address, initiate an email to your customer�s friend, 
using that address. For information, see �Originating an Outbound Email,� on page 113.

7 Whether by email or telephone, tell the friend the URL for the Join Us Conference and the 
password. Explain that they must enter the password when their browser is displaying the Web 
site and they must then click the Submit button.

When the friend does this, the Join Us program is downloaded to their browser. You, your 
primary customer, and your customer�s friend are in the same chat room. You can each see 
what the other two people type. 
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8 Manage the JoinUs conference as appropriate, by using Auto-Sync or pushing URLs to your 
customer and their friend, or watching your browser as they send pages to you and each other. 
Everyone in the session can see the same pages and chat about them. 

Tip:  You may want to tell your customer and friend that they can also lead the others 
to a Web page by going to the page (or pasting the URL of the page in the URL box), 
and clicking Send Page in their applet.

Note:  If your customer or their friend closes their browser or clicks the End Chat 
button, the session continues between you and the other person.

9 When your customer and their friend indicate that they are finished, tell them that you will 
close the session. Say good-bye.

10 Wrap up and complete the Join Us session. 

Handling Simultaneous Chat Sessions 
You can handle more than one chat session at the same time. For example, you could chat with a 
new chat customer while your other chat customers are reading material you sent them, trying out 
your suggestions, filling out forms, and so forth.

Tip:  If you plan to handle multiple sessions, it is a good idea to set the �Away from Desk� 
message, as described in �Setting Preferences,� on page 165. The �Away from Desk� message is 
sent to the customer whenever you do not respond within a period of time you specify. 

To handle simultaneous sessions with multiple customers:
1 Be sure you are available for the number of simultaneous sessions you want to handle. (See 

�Changing Your Agent State,� on page 46 and �Setting Your Channel Loads,� on page 49.)

2 While handling a chat session, double-click the name of another customer from the Chat task 
list (usually the next in line from the top). 

The Web Agent changes to display your chat session with the new customer. An icon for a new 
Internet Explorer browser is added to the Windows Task Bar, beside the icon for your previous 
chat customer. 

3 Type and send a message to the new customer.

4 Whenever you have a chance to return to the original customer, click that customer�s contact in 
the Chat task list. 

The Web Agent changes to display information about this contact, including the transcript of 
your previous conversation.
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5 If your current chat contact load allows you to handle more chat customers and you want to add 
another, repeat Steps 2-4. (Your contact load for chat is the maximum number of chat contacts 
you can handle simultaneously. This number, which can change during your login session, is 
displayed in the chat icon at the bottom right of the Web Agent.)

Tip:  If you find that one of your chat customers needs more attention, you can 
transfer that contact to another agent by clicking the Transfer button.

6 Return to interact with your other customer by clicking the name in the Chat task list. 

Tip:  You can double-click any currently active contact in the Chat task list to have 
the Web Agent window display that chat session.If you are handling multiple 
contacts simultaneously, the logo in the Web Agent window may change when you 
select a different contact from the Chat task list. This can help you distinguish 
between different customers quickly. (If you double-click an inactive contact, a new 
session begins.)

Tip:  You can use the Shared Browsing features with each chat contact. Use the 
Internet Explorer icons in the Windows Task Bar to switch between the browsers. 

7 When you are finished with any of the chat customers, select the name from the Chat task list. 
Wrap up and close this session as usual. (See �Sharing Browsers with a Customer,� on 
page 128.)

The other chat sessions remain active until you wrap up and close them.

Monitoring a Chat Session (Supervisors Only) 
If you are a supervisor, one of the most important ways that you can ensure quality is to monitor 
your agents� chat sessions. You can enter a chat session and �view� the interaction between the 
agent and the customer in real time. You can also have other supervisors join you in observing an 
agent. 

When you first enter the chat session, neither the agent nor the customer can see you. You can 
allow both of them to see you by clicking the Visible option and �speaking� (sending text 
messages). When you are visible, both the agent and the customer can also see you if you leave.

If you want to monitor a session without anyone knowing you are there, you can leave yourself 
Invisible. This makes it possible for you to observe natural interactions for training purposes. It 
also helps ensure that your agents perform well because they know that you may be monitoring 
them at any time.

To monitor a chat session: 
1 If you want to give your full attention to monitoring a chat session, you may want to set your 

availability for voice, chat, and email to 0 in Avaya Agent. 

Tip:  If you prefer to monitor while you handle a chat session of your own or reply to 
an email, you can do this. Use the Chat Management and Email Management buttons 
in the main toolbar to switch between contacts, as desired.
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2 Click the Supervisor Mode button in the main toolbar of the Web Agent. 

If you have not participated in or monitored a chat session since you last logged in, the File 
Download dialog box is displayed, asking you to choose what to do with the aimagentcl.hta 
file. This dialog box appears the first time you begin to handle a chat contact or monitor a chat 
session during your login session. It does not appear again until the next time you log in and 
begin to interact with a chat customer or monitor an interaction.

Caution:  The aimagentcl.hta file is necessary for Shared Browsing. It opens a separate Internet 
browser for each session that you monitor or participate in. If you do not plan to use Shared 
Browsing in sessions that you monitor, you may want to select an option that keeps browsers from 
opening for each monitoring session. See �Setting Preferences,� on page 165 for more information.

3 If the File Download dialog box is displayed, click �Open this file from its current location.� 
Then click OK. 

An Internet Explorer icon is added to your Windows Task Bar. This is the browser you will use 
if you monitor a chat session in which the agent and customer share browsers.

A Monitoring panel is added to the Web Agent, above the Resource area. It displays a tree 
showing your workgroup, the agents who are in chat sessions currently, and the customers with 
whom they are chatting, as shown in the following illustration.

Tip:  To expand the window and see more of this tree, hold your cursor over the 
bottom edge of the Monitoring panel. When you see a small arrow with a point at 
each end, drag the edge of the panel down, as far as you want. You can drag the edge 
back in similar manner. 

!

Arrow used to increase or 
decrease the size of the 
Monitoring panel. See the tip 
below for instructions.

Workgroup

Chat customer
Agent

Current chat sessions
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4 Click the chat customer whose session with an agent you want to monitor. 

A transcript of the session is displayed in real time in the Transcript area of the chat window for 
you to observe. 

Note:  By default, when you begin monitoring, you are invisible to the agent and to 
the customer you are monitoring. You cannot type in the Text Area unless you make 
yourself visible.

5 If you want to become visible, right-click the name of the customer. Then select Make Visible.

In the Transcript area, the system announces your presence. Typically, a line says, �Supervisor 
is available on the call.�

Tip:  If you make yourself visible, remember to make yourself invisible again before 
monitoring another session.

6 If you want to become invisible again, right-click the name of the customer. Then select Make 
Invisible.

The system announces that you are not available. However, you can continue monitoring the 
session without typing messages.

Note:  If you click another chat session, the system will announce that you left the 
first session. You can only monitor one session at a time.

7 To end your monitoring session without switching to another session, click the Supervisor 
Mode button to close the panel, or click an icon at the root level in the Monitoring panel.

Starting a Lotus Sametime Session
Lotus Sametime� is a real-time collaboration program that is integrated into Avaya IC. If your 
administrator indicates that you are to use Sametime, you can start a Sametime session with your 
current chat customers. With Sametime, you can share applications, use a white board, and share 
audio and video with the customer. 

If you want to use Sametime with multiple customers, start a Join Us session as explained in 
�Handling a Join Us Conference,� on page 144. Then begin the Sametime session. Sametime may 
not work if a Join Us customer enters a Sametime session that has already begun.

Note the following requirements: 
� Sametime must be installed and configured on your desktop.
� You will need a login ID and password, assigned to you by your administrator.
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� Other agents may not be able to join the Sametime session. 

For more information about Sametime, see the Sametime user guide.

To begin a Lotus Sametime session:
1 Assure that the person with whom you are in a chat session has Lotus Sametime installed and 

wants to join you in a Sametime session.

2 Click the Lotus Sametime button.

A browser opens with a drop-down menu of services.

3 Select the type of service you want.

4 Enter your Sametime login ID and password.

Your customer�s browser and your browser connect in a Sametime session.

5 See the Sametime help system for information on handling the session.

Viewing the Customer�s DataWake Record
The customer�s DataWake� record is a list of the Web pages that the customer has navigated 
since they last opened their browser and visited the company Web site. The DataWake record 
includes links to two types of pages that the customer visited: 
� Escalation pages � Pages from which customers send an email or request a chat session. 
� Browse pages � Other pages in the company Web site, such as the Web Self-Service pages, 

support pages, and product information pages.

Escalation Page
If your company supports multiple escalation pages from different companies (often classified as 
�tenants�), you may want to know which Web site the customer was visiting when they sent an 
email or requested the chat that you are handling. 

To access the customer�s escalation page:
1 Display the contact in the Chat Management window.

2 Select Tools > DataWake or click the DataWake button. 

A dialog box is displayed with a link to the escalation page from which the customer requested 
the chat session.

Note:  When no chat contact is being handled, the DataWake option is disabled, and 
nothing happens when you click the DataWake button. 

3 Click the link to see the page.
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Browse Pages
You may also want to see the browse pages the customer was visiting before they requested a chat. 
Typically, these are your company�s Web Self-Service pages, the pages from which a customer 
sent an email or requested a chat session, or product description pages. In some cases, they may 
include sites external to the company Web site.

A customer�s DataWake may tell you what type of information the customer is interested in. It 
may also indicate to you what pages not to show the customer because the customer has already 
seen them. A customer�s DataWake record may not include links to all URLs (Internet addresses) 
that the customer has visited in this session. Your administrators determine which URLs can be 
included in DataWake records. 

To access the customer�s DataWake browse pages:
1 From the Web Agent, click Tools > DataWake. 

Your browser is launched and opens to the DataWake� Summary page

2 You can narrow your search by entering any or all of the following information:

� User Name � The user name of the customer whose DataWake you want to see. If you are 
not certain of the exact name, enter letters you are sure of and click Contains. You can enter 
multiple names to see DataWake records of multiple customers.

� Restrictions � If you want to refine your view further, enter information into one of the 
following:

- Start Date and Time � The date and time you want to begin and end your query. If you 
entered a user name, this information is displayed only for that particular customer. If you 
did not enter a user name, you see the query for all customers.
- Last N Sessions � The number of sessions you want to see, such as the last 5 sessions, of 
the user or users you chose in the User Name field.
- List of Session IDs � A list of Session IDs, separated by commas, to view a selected 
session. You see only the Session IDs of the customer or customers you chose in the User 
Name field.

3 Click Display Full DataWake. 

A Full DataWake page is displayed showing the customer�s full DataWake history, based on 
your criteria. The DataWake record usually includes the following columns:

� Time � The time of day when the customer accessed the page.
� Priority � The significance of a particular URL accessed by the customer, as defined by your 

administrator in IC Manager.
� Type � Pages are classified as either escalation pages (pages from which a customer can 

send an email or request a chat session) or browse pages (all other pages in the DataWake 
database).

� Description � The URL of the page. You can click this to access the page on your browser.
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You can also view your own DataWake record or that of other customers and other agents. See 
�Viewing Your Own DataWake Record,� on page 176. 

Using Multiple Languages in Chat Sessions
Your customer may want to chat with you in a language that is not your primary language. If you 
are assigned a chat contact in another language and the language is not displayed properly, check 
with your administrator.

You can spell check your chat messages in a secondary language before you send them. When you 
open the Spell Checker (select Contact > Spell Check), select the appropriate language from the 
Language drop-down menu. 

Below is a Web Agent displaying a chat session an agent is having with a customer in Chinese:

Tip:  If you use another language, you may want to create some Agent Resources in that language. 
See �Managing Resources,� on page 155.
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Wrapping Up and Completing a Chat Contact
When you finish interacting with a customer in a chat session, you wrap up the session. This puts 
you in WrapUp state. While in WrapUp state, you cannot receive another chat contact to replace 
this one. You may need to enter information about the chat session while in this state.

To wrap up and complete a chat contact:
1 When you are certain that you have addressed all of your customer�s questions or problems, 

make sure the customer understands that the session is about to end. Say thank you and good-
bye.

2 Click the Wrap button in the chat toolbar.

3 If you see a dialog box asking you to confirm your action, click Yes. 

A WrapUp dialog box may be displayed for you to fill in information about this contact. Or you 
may see a Prompter script displayed in the Avaya Agent.

Tip:  You can set a preference to control whether this dialog box is displayed 
whenever you wrap up a chat contact. See �Setting Preferences,� on page 165.

4 If you see a dialog box or a Prompter script, answer all the questions appropriately. For 
information about the dialog box or the script, see �Wrapping Up Contacts,� on page 67.

5 If you want to finish any follow-up tasks while you are in WrapUp state, do them now. 

For example, you may want to submit information you used with this customer to the Web Self-
Service database. (See �Using Web Self-Service,� on page 172.)

6 Click the Complete button in the chat toolbar.

The chat contact is completed. It is removed from your Chat task list.
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CHAPTER 6
PERFORMING CHAT & EMAIL TASKS

This chapter explains how to perform tasks related to email or chat that you generally perform 
when you are not actively handling an email or chat contact. 

The tasks are managing your resources, importing migrated resources from a previous release of 
the Avaya� Interaction Center, setting preferences, and using Web Self-Service.

The chapter includes the following topics:
� Managing Resources
� Importing Migrated Resources
� Setting Preferences
� Using Web Self-Service
� Viewing Your Own DataWake Record

Managing Resources
Resources are previously prepared text, emails, and URLs (Internet addresses) that you can send to 
customers whenever the information is needed. This saves you the time and the tedium that it 
would take to type the same information repeatedly. For example, text resources may consist of 
boilerplate text and small pieces of text that you can use in your chat sessions, such as common 
phrases, greetings, closings, and answers to questions you receive frequently. Email resources may 
contain answers to commonly asked questions and may contain attachments. URL resources may 
lead your customer to corporate Web sites, such as a page on exchange policies. 

Some resources may have already been set up for you and other agents to use, such as �global 
resources.� You cannot change or delete these resources, unless you are an administrator. You can 
create agent resources for your own use. No one else can see your agent resources. 

When you are responding to email, you may also have a list of �Suggested Responses� in your 
Resource Area. These are temporary resources related to an email contact. For more information, 
see �Using Suggested Responses,� on page 102.



Chapter 6   Performing Chat & Email Tasks

156 Avaya Agent User�s Guide

This section contains the following topics:
� Resource Types and Examples
� Creating New Agent Resources
� Creating New Global Resources (Supervisors Only)
� Editing Your Resources
� Deleting a Resource
� Viewing Your Resources
� Organizing Your Resources

For information on sending resources to a customer, see �Using Resources in a Chat Session,� on 
page 133 or �Using Resources in Email,� on page 100.

Resource Types and Examples
Global and agent resources come in three types: email, text, and URL. This section explains each 
type and gives an example.

Email 

An Email resource contains the subject and text of an email message that you can use to respond to 
customers quickly. You can add an attachment to this message as well. When you send the 
resource to a customer, you can add to or modify the message as needed. 

For example, you could create an email resource to respond to a question customers frequently ask 
about the safety of a product.

Text Files

You can use text files to store �canned� or �boilerplate� greetings and responses. This saves you 
time and tedium when you are responding to email or when you are engaged in a chat session. You 
can add to or modify the message before you send it to a customer.

For example, You could create a �Welcome� text file containing text like the following: 

Hello. Welcome to XYZ support. My name is Joe, and I am here to assist you.

URLs 

A URL resource is a resource that contains a linked address to a Web site. When you send this 
resource to a customer in a chat session with you, the customer�s browser opens to display that 
Web site. In most email programs, if you send the resource to an email customer, the customer�s 
browser opens to the Web site when they click the URL.

Example:

A URL resource named �Shopping Mecca Catalog� might be 

http://www.shoppingmecca.com/catalog/
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Tip:  You can use a File Transfer Protocol (FTP) site as a URL resource, so that customers can go 
to the site to download files. When you create such a URL, begin it with ftp://.

Example:

A URL resource named �XYZ ftp site� could take the customer to an ftp site at your company. The 
contents of the URL resource might look like the following:

ftp://ftp.XYZsupport.com/special

Creating New Agent Resources
You can create your own resources and store them in the Agent Resources folder. These are saved 
with your user account and are available to you every time you log in. Other agents cannot see or 
use the resources you create.

You can create resources for specific tenants. A tenant may be a company, a location (such as New 
York or Boston), or a workgroup (such as Sales or Support). You can create resources in different 
languages, which is useful if you interact with customers in more than one language.

If you need to, you can edit a resource just before you send it to a customer. This makes it possible 
for you to adapt the prewritten resources to meet your customer�s individual needs.

Tip:  You can drag and drop a copy of any resource to a new location. For example, you can copy 
a resource in your Global Resources folder into your Agent Resources folder. Then you can 
modify the copied resource if you want. In some cases, this is faster than creating a new resource 
from the beginning.

To create a resource: 
1 Right-click the Agent Resources folder or any of its subfolders in the Resource Area of the 

Web Agent. 
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2 From the pop-up menu, select Create Resource and the type of resource you want to create. For 
information on each type of resource, see �Resource Types and Examples,� on page 156.

The New Resource dialog box is displayed, as shown in the following illustration, with your 
Login ID and today�s date and time already entered. This read-only information will be 
displayed as a tooltip when you hold your cursor over this resource.

3 If you want to create the resource for a specific tenant, select that tenant from the Tenancy 
drop-down menu.

4 If you want to create the resource in a language other than your primary language, select the 
language from the Language drop-down menu. 

5 Enter a unique name to identify this resource in the Name field. 

6 Press the Tab key to place your cursor at the top left of the scroll box. Follow the step below 
that applies to the type of resource you are creating.
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7 URL resource � Type the entire URL, beginning with http://, https://, or ftp://. Do 
not type any text other than the URL. 

If you do not begin the address correctly, you will not see an error message at this time. 
However, you will see an error message when you try to send it to a customer. If you send a 
URL with an incorrect address, the customer who receives it will see an error message when 
their browser attempts to locate the Web site.

Tip:  When creating a URL resource, you can copy a URL from your browser and 
paste it into a resource. Select the entire address from the browser�s Location or 
Address box and click Ctrl-C. Put your cursor in the scroll box of the New Resource 
dialog box and click Ctrl-V. The URL is pasted into the dialog box. 

8 Text resource � Type the message that you want customers to see.

9 Email resource � Fill in the fields as follows: 

Tip:  Click the buttons beside the To, Cc, and Bcc fields to look up the email 
addresses of other employees of your company or External Agents in the Unified 
Agent Directory (UAD). See the description of the fields below. When you find the 
name of a person you want to add to the field, double-click the name.

Enter information into the Header fields according to this information:
To � When agents use this resource in emails they compose, any addresses you add to this 
field will be added to any recipient addresses already in the To field.
Cc � Any addresses you enter here will be entered in the Cc field of emails using this 
resource. If the agent does not delete an address in this field, copies of the email will be sent 
to that address.
Bcc � The agent will see any addresses you enter here when viewing the resource. However, 
when recipients receive this email, any addresses entered here will be invisible.
Subject � If the agent has already typed a Subject in an email before using this resource, the 
Subject in the resource will replace any Subject the agent has already typed.

a To: You should probably leave this field blank. Your current customer�s address will be 
filled in here automatically each time you send this resource. 

b Cc: If you want another person or persons to receive a copy of this email whenever it is sent 
to a customer, type the email address or addresses here. You may include an address to 
inform someone in your company that a customer is seeking help on this topic. Your 
customer will see the address or addresses that you include here.

c Bcc: If you want another person or persons to receive a copy of this email whenever you 
send it to a customer, but you do not want your customers to see the address or addresses, 
type the email address or addresses here.

d Subject: Type the subject of this email. Your customer will see this in their email display 
window before they open the email. 
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10 If this is an email resource and you want to attach a file or files to the resource, do the 
following:

a Click the Attachments tab and then the Add Attachments (paper clip) button. 

b Use the drop-down menu and the buttons at the top of the Open dialog box to locate a file 
you want to attach. The file can be on your local hard drive or on any drive on the network 
to which you have access. 

c If you want to attach more files, click the Add Attachments button again. 

d Click OK.

11 Read carefully everything that you have entered in the New Resource dialog box. 

Tip:  To spell check your resource, select the text that you have entered and click 
Ctrl-C to copy it. Then select Tools > Compose Email. Put your cursor in the Text 
Composition Area of the email and click Ctrl-V to paste the text. Click the Spell 
Check button from the email toolbar and run the Spell Checker. After you correct any 
errors, you can copy the message and paste it back into the New Resource dialog box.

12 Click OK.

If you need to change anything in this resource after you click OK, right-click it and select Edit 
Resource menu.

13 Click the Save Resources button in the Resources toolbar.

The resource is saved with your login ID so it will continue to be available to you until you 
delete it.

Creating New Global Resources (Supervisors Only)
If you are a supervisor, you can create Global Resources for agents or groups of agents. You may 
want to create separate resources for different tenants or agents in different language groups. 
Follow the instructions in �Creating New Agent Resources,� on page 157, adapting them as 
necessary. Begin by selecting the Global Resources folder or any of its subfolders.

When you click Save in the Resources toolbar, the resources you created or modified in the Global 
Resources folder are saved on a shared drive that has been set up for this purpose. Usually, this is 
the Global_resources.xml file. Agents should be able to see the resources you create the next time 
they log in. 
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Editing Your Resources
You can change any part of a resource that you have created, such as the tenancy, language, name, 
or contents. (You can only change Global Resources if you are a supervisor.)

To edit a resource:
1 Right-click the resource you want to edit.

2 Select Edit Resource.

The Edit Resource dialog box is displayed with all the information contained in this resource. 
Use the drop-down menus if you want to change the tenancy or language.

3 Change the resource name or contents as you want, selecting any text you want to delete or 
replace. If this is an email resource, you can also change the header fields (To, Cc, Bcc, and 
Subject), or add or delete an attachment.

4 Click OK. 

The resource is updated.

Deleting a Resource
You can delete any resource you created yourself. Only supervisors and administrators can delete a 
Global Resource.

To delete a resource:
1 From the Web Agent, select the resource.

2 Right-click the resource and select Delete Resource from the menu that appears. 

The resource is removed from the Resource Area.

Viewing Your Resources
Resources are organized in a hierarchy of folders and subfolders in the Resource area of the Web 
Agent. In this area, you can view the folders, subfolders, and the resources they contain by 
selecting commands from three places. Most of the same commands are available in all three 
places.
� A toolbar and drop-down Filter menu at the top of the Resource area
� The Resources menu
� Pop-up menus displayed when you right-click a folder 

The following steps present the features you can use to display your resources. You do not need to 
follow them in order.
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To display different views of resources:
1 To show the contents of all folders and subfolders in the Resource area, use the Expand All 

command (by selecting Expand All from the toolbar or from the Resources menu). To show 
only the folder or folders that contain all the other folders, use the Collapse All command. 

Note:  You may have only one main folder, called Resources, that contains all the 
other folders. In this case, the Collapse All command displays only that folder.

2 To hide the subfolders and contents of any folder that is currently open, right-click the folder 
and click Collapse Folder from the pop-up menu. To show the subfolders and contents of any 
folder that is currently closed, right-click it and select Expand Folder from the pop-up menu.

Tip:  Keyboard characters to the side of the folder icons indicate whether folders are 
open, closed, or empty. As in the Microsoft® Windows operating system, a closed 
folder has a plus character (+), an open folder has a minus character (-), and an empty 
folder does not have any character. You can use the �Filter by� drop-down menu to 
display only the type of resources that you want to see, as follows:

3 To display only a particular type of resource within the open folders, click one of the following 
items from the �Filter by� drop-down menu: 

� [Blank � Displays all types of resources for all tenants and all languages.]
� Tenant � Displays only the resources for a specified tenant, which may be any group in an 

organization, such as a company, location, or workgroup.
� Language � Displays only the resources for a specified language.
� Text Resources � Displays only text resources.
� URL Resources � Displays only URL resources.
� Email Resources � Displays only Email resources.

Note:  You cannot filter Suggested Responses or Email Templates.
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To view the contents of a resource without opening it, click the Preview Content check box at the 
lower part of the Resources area, as shown in the following illustration. Use the vertical and 
horizontal scroll bars to see more of the resource. 

Organizing Your Resources
You can create folders and subfolders to keep your Agent Resources organized. If you are a 
supervisor, you can do this for Global Resources also. After you create a folder or subfolder, you 
can drag and drop resources into it.

To organize your resources:
1 If you want to display the contents of all the resource folders, including subfolders and 

resources, right-click the word �Resources� at the top of the Resource area. Then click Expand 
Folder in the pop-up menu. 

2 Check the Filter by drop-down menu to be sure you are displaying all the resources that you 
plan to organize into folders. If no text is displayed until you open this drop-down menu, you 
are displaying all the resources, regardless of type.

3 To create a new folder, right-click the existing folder in which you want to create your folder. 
Then click Create Folder in the pop-up menu, as shown in the following illustration. 

The new folder, with the name �New resources,� is added under the folder you selected. 
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4 Right-click the new folder and click Rename Folder in the pop-up menu.

Tip:  Another way to change the name of the folder is to put your cursor in the text 
that says �New resources� and type a new name. Then press Enter.

The name you typed is displayed next to the folder icon.

5 If you have already created the resources for this folder, drag and drop them one at a time into 
the new folder. You can also drag a folder or resource from an open folder and drop it into 
another folder. 

Importing Migrated Resources
Administrators of your contact center may have set up resources with version 5.6 of Avaya IC. If 
your administrator asks you to import these �migrated� resources, take the following steps. 
Otherwise, you should ignore this section.

If you previously worked with version 5.6, you may import the agent resources you created as well 
as the global resources that were prepared for you. Your agent resources are located in a folder that 
has the name of your login ID. Your administrator should tell you where the resources you will 
import are located.

To import migrated resources:
1 Select Resources > Import.

The window at the right side of the Web Agent displays the Import resource file button.
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2 Click the Import resource file button.

The Open dialog box is displayed. 

3 If you had agent resources in the previous version of Avaya IC, do the following:

a Navigate through your folder until you find your resource file. Agent resources have a 
.WAC at the end of their filenames.

b Double-click the filename when you find it.

4 Use the drop-down menu to find the folder where the global resources are located.

5 Locate the global resources file. Global resources have a .rsc at the end of their filenames. 

The resources are imported and displayed in the Resource area.

Setting Preferences
You can use the Preferences dialog box to set certain options about the display of the Web Agent 
and the way you handle your email and chat contacts. 

Note:  Except for User Interface settings, all preference changes you make take place immediately. 
User Interface changes, such as changes to the size of the font or icons, take place only when you 
exit the Web Agent and start it again. 

To set your preferences:
1 If the Web Agent is not currently displayed, click the Web Agent button in the task bar. 
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2 In the Web Agent, select Tools > Preferences.

The Preferences dialog box opens. Note that it contains five tabs and opens to the Client tab.

3 Click the tab with the category of preferences that you are interested in seeing or changing. Go 
to the appropriate section, shown below, to learn about the options in that tab.

� �User Interface Preferences,� on page 166 
� �Contact Preferences,� on page 168
� �Email Preferences,� on page 169
� �Chat Preferences,� on page 170
� �Other Preferences,� on page 171

User Interface Preferences
When you open the Preferences dialog box, the User Interface tab is displayed, as shown in the 
following illustration:

User Interface preferences are related to the display of the Web Agent. The changes you make in 
the User Interface tab do not take effect in the Web Agent until you log out and log back in again. 
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You may see two parts of this dialog box, Client Settings and Font Settings. The Client Settings 
include:
� Use large icons for menus and buttons � With large icons, it is easier to see what the icons 

represent.
� Word-wrap text � This selection makes the text you write in email or chat move to the next line 

automatically whenever the text reaches the edge of the window.

Tip:  To see a sample of the different font options, make selections from the drop-down menus. 
The sample text in the changes according to your selections. The selections are saved only when 
you click OK. You will see the changes in the Web Agent the next time you log in.

The Font Settings section contains tabs and drop-down menus for you to choose the way the text 
looks in different parts of the interface. 

The Font Settings include:
� Font Name � The name of the type face. You may see the following choices:

� Serif � A font with decorated letters, that is, letters with little strokes on their edges. 
� SansSerif � A font with plain letters, that is, letters without little strokes on their edges. The 

font in this sentence is a SansSerif font.
� Monospaced � A font in which all letters have the same width. Many newspapers use a 

monospaced font. The font in this sentence is monospaced.
� Style � Whether the font is bold or plain.
� Size � The size of the font. Typically, the smallest size you can choose is 8 and the largest is 20.
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Contact Preferences
The options in the Contact tab apply to both email and chat contacts. The options, as shown in the 
following illustration, are as follows:

� Wait for agent confirmation before accepting a contact � If you select this option, a dialog box, 
called a �screen pop,� is displayed whenever a new email or chat contact arrives, allowing you 
to accept or reject the contact. If you reject the contact when the dialog box is displayed, the 
contact is assigned to another agent. 

� Alert with sound when a new contact arrives � If you select this option, a sound is played 
whenever a new email or chat contact is assigned to you. The sound is the Microsoft® 
Windows default beep, defined in the properties for system sounds in the Windows Control 
Panel. 

� Display a confirmation before wrapping a contact � If you select this option, whenever you 
click the Wrap button, a dialog box asks you to confirm that you want to wrap up the email 
contact or chat contact. This prevents you from accidentally ending the session with your 
customer.
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Email Preferences
The options in the Email tab apply only to email you send from the Web Agent. The options are as 
follows:

� Spell check before sending an email � If you select this option, the Spell Checker is displayed 
whenever you press the Send button, reminding you to check the spelling of each email 
message and enabling you to correct any errors before the Email Management software sends 
the message to the customer.

� Confirm before sending an email � If you select this option, after you click the Send button to 
send an email, a dialog box asks if you are certain that you want to send this message. This 
gives you a last chance to check your emails before you send them.

� Quote original message in email response � This option inserts the customer�s original message 
into your email replies. With this option, you can see what you are responding to and your 
customer can see what they wrote you in their original message. If you select this option, you 
can also select the following:
� Quote prefix to be used � You can change the keyboard character that is entered in the text 

box at the start of each line in the original message. The default character is a closed angle 
bracket (>).
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� Default character set for outbound email � You can change the character set used by default 
in your outbound email to the character set of another language.

� Wrap contact after a �Normal Reply� response � If you select this option, your normal email 
replies (that is, your email responses in which you leave Normal Email Reply selected in the 
drop-down menu) are automatically wrapped up after you send them. 

� Wrap contact after a �Send to External Agent� response � If you select this option, your email 
replies when you select Send to External Agent from the drop-down menu are automatically 
wrapped up after you send them. 

� Wrap contact after a �Request Additional Information� reply � If you select this option, your 
email replies when you select Request Additional Information from the drop-down menu are 
automatically wrapped up after you send them. 

Chat Preferences
The options in the Chat tab, which apply only to chat sessions, are as follows:

� Spell check before a �Say� � If you select this option, the Spell Checker is displayed whenever 
you press the Say button, so that you can check the spelling of each chat message and correct 
any spelling errors before the Web Management software sends the chat message to the 
customer. 
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� Enable �Away from Desk� message � If you select this option, whenever you have not 
responded to the customer within the specified period of time, a message is sent to the 
customer. This is useful if you plan to be available to handle multiple chat sessions or multiple 
channels (chat and email, for example) simultaneously. After you click this check box, you can 
change the time interval and you can specify what the message says in the text box.

� Time interval between �Away from Desk� messages � The message referred to in the 
description of the previous preference is sent each time the specified amount of time passes, 
until you type a chat message to the customer. 

� �Away from Desk� message text � This option lets you can change the text that is sent to the 
customer whenever you do not respond within the time interval specified above.

Other Preferences
The options in the Other tab are as follows:

� Internet Explorer Browser Path � If you want to use a different installation of Internet Explorer, 
click the button and navigate to the program.

� Default mode �Visible� when monitoring a chat session � (Supervisors only) If you are a 
supervisor and you select this option, whenever you begin to monitor a chat session, the system 
announces your presence to the agent in the Transcript area. 
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� Start collaboration automatically when monitoring a chat session � (Supervisors only) If you 
are a supervisor and you monitor multiple sessions and you do not use Shared Browsing in the 
sessions, you may want to select this option. Otherwise, every time you start to monitor a 
session, a browser opens to enable Shared Browsing in that session, and every time you leave a 
session, the browser closes.

� Automatically save resources during logout � If you select this option, any new resources are 
always saved when you log out, and you do not get a message asking if you want to save them.

� Confirm before deleting a resource or folder � If you select this option, whenever you start to 
delete a resource or a folder, a dialog box asks if you are certain you want to do this.

� Leave copy of original when copying resource to new location � If you select this option, 
whenever you drag and drop a resource from one folder to another, the original resource 
remains in the original location while a copy of that resource is created in the new location.

� Use resource when double-clicked � If you select this option, whenever you double-click a 
resource, its contents are inserted into the email or sent to the chat customer immediately. If 
you do not select this option, when you double-click a resource in a chat session, the resource 
moves to the Text Entry area, where you have a chance to view or change it before sending it to 
the customer.

 Using Web Self-Service
The Web Self-Service database contains commonly requested information about products and 
services that your contact center supports. This makes it possible for your customers to find 
answers to their questions by themselves. The database is also referred to as the FAQ (frequently 
asked questions) database.

You can also help your customers find answers in this database, in the following ways:
� For your chat customers:

� Use the Auto-Sync feature to lead them to the appropriate documents
� Push URLs of the documents to them

� For your email customers:
� Email them the URLs of the appropriate documents
� Paste the contents of the documents in your email responses

� For your telephone customers:
� Read to them the URLs or the contents of the appropriate documents
� Email them the URLs or the contents of the documents

� For all your customers:
� Create resources using the contents of the document



Using Web Self-Service

Issue 1.0 June 2002 173

Finding Documents in Web Self-Service
It is a good idea to learn your way around the Web Self-Service database so you can help 
customers quickly. You can find topics and documents in the following two ways:
� �Navigating the Topic Hierarchy,� on page 173
� �Searching the Web Self-Service Database,� on page 174

Navigating the Topic Hierarchy

One way to find specific topics and documents in the Web Self-Service database is to navigate the 
topic hierarchy, as described in the following procedure.

To navigate the topic hierarchy:
1 From the Web Agent, click the Tools > Submit FAQ button. 

2 Click Manage FAQ on the left side of the page. 

Your browser opens to the Manage FAQ page, asking you to select a tenant. A tenant may be a 
company, a location (such as New York or Boston), or a workgroup (such as Sales or Support). 

Tip:  By default, your browser is displayed inside the Avaya Agent. To see more of 
your browser, open the Avaya Agent menu and select Always on Top to remove the 
check mark.

3 If the document you want to view is related to a specific tenant or language, make the 
appropriate selection from the drop-down menu. If there is only one tenant or language in the 
menu, leave that selection. Then click Manage FAQ. 

The FAQ Database page displays the root folders in the database of FAQ documents.

4 Navigate through the folder hierarchy in the FAQ Database section to find the desired topic. 

Topics are indicated by folder icons. Folders may contain other folders, which may contain still 
more folders, and so on. When you open a topic folder containing documents, the documents 
are displayed under a line separating them from the folder. Documents are marked by a folder 
icon.

5 Click the name of any document that you want to see. 

Tip:  If there are many documents in a folder, use the First, Previous, Next, and Last 
buttons to navigate easily through the documents.

The contents of any text document you select are displayed beneath a line separating it from the 
list of documents. If you clicked a URL document, a Web page opens to display the document.

If the document is a URL, click the link beneath the topic title to display the Web page 
containing the information.
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Searching the Web Self-Service Database

You can search the Web Self-Service database for any available topics or documents that match 
your search criteria. 

To search the Web Self-Service database:
1 From the Web Agent, click Tools > Search Web Self-Service. 

Your browser opens to the Search FAQ page, asking you to select a tenant and language.

2 If the document you want to view is related to a specific tenant or language, make the 
appropriate selection from the drop-down menu. If there is only one tenant or language in the 
menu, leave that selection. Then click Search FAQ.

3 In the Query Builder page, enter a term in the Search field. 

Note:  The term you enter can be a phrase or a single keyword. You cannot use any 
wildcards.

4 Click Go. 

All documents containing the term you entered are displayed in the Search page.

Submitting Documents to Web Self-Service
You can submit a document for addition to the Web Self-Service database, which is then subject to 
your administrator�s approval or rejection. You can create the document on the Submit a 
Document page, paste an existing document into that page, or enter a URL that displays an HTML 
document located in the Avaya IC Web site directory. 

To submit a document for the Web Self-Service database:
1 In the Web Agent, click Tools > Submit FAQ.

2 Click Manage FAQ on the left side of the page. 

The Manage FAQ page is displayed, asking for you to select a tenant. A tenant may be a 
company, a location (such as New York or Boston), or a workgroup (such as Sales or Support).

3 If the document you want to submit is related to a specific tenant, make the appropriate 
selection from the drop-down menu. If there is only one tenant in the menu, leave that 
selection. Then click Manage FAQ. 

4 If this document will be in a different language than the one used for currently displayed topics, 
click Change Tenant and Language. Select the desired language from the page that is displayed 
and click Manage FAQ.

5 Navigate to the topic to which you want to submit a document.

6 At the bottom of the Manage FAQ page, click Submit. 

The Submit a Document page is displayed
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7 Write unique title for this document in the Title field.

8 If the Language Specific Document Parts section, write a title for the document. 

9 If the document is an HTML page set up for the Web site, click Internet Link. Then enter the 
URL with the complete address, such as http://<machine name>.<fully qualified 
domain name> 

10 If the document will be text, leave the Text button selected. Enter your text for the Web Self-
Service database in the Text box.

Tip:  If you want, you can copy from an existing document, such as a Microsoft® 
Word document or an email, and then paste the copy into the text box.

11 Read what you have written to check it for errors.

Tip:  You can use the following trick to spell check your document. Copy the 
document from the Text box by selecting all of the text and clicking Ctrl-C. Then go 
to the Web Agent and select Tools > Compose new email. Click Ctrl-V to paste what 
you copied into the Text Entry area. Click the Spell Check button and check the 
spelling. After you correct any errors, select and copy the message. Return to your 
browser and the Submit a Document page. Paste the text back into the Text box. 
(Later you can delete the email composition text from the Web Agent.) 

12 Scroll to the bottom of the Submit a Document page and click Submit. 

Your document is added to the Proposed Documents list, which is the list of documents waiting 
for approval from your supervisor. If you want to view, edit, or delete a document you have 
submitted, see �Viewing, Editing, or Deleting Your Proposed Documents,� on page 175.

Viewing, Editing, or Deleting Your Proposed Documents
You can make changes to a document that you have proposed for the FAQ database, or remove it 
before your supervisor has approved or rejected it. 

If you are a supervisor, you can view, edit, and delete the proposed documents that agents in your 
workgroup submit. In addition, as supervisor, it is your responsibility to read the documents that 
agents in your submit to the database and either approve or reject them. For information, see 
�Approving or Rejecting Documents (Supervisors Only),� on page 176.

To view, edit, or delete proposed FAQ documents:
1 From the Web Agent, click the Agent Home button. 

Your browser opens to the Welcome page.

2 Select Manage Proposed FAQ from the left side of the page. 

3 If the proposed FAQ that you want to see was entered for a different tenant or in a different 
language, make an appropriate selection. Then click the Manage Proposed FAQ button. 

A list of pending FAQ documents for this tenant and language is displayed.
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4 To view a proposed document, click its title.

5 In the Approve Document page, read the document. Make any desired changes to the text or 
title of the document. 

6 When you have finished, click the Update button.

7 Click Submit. 

Your changes take place immediately.

Approving or Rejecting Documents (Supervisors Only)
As a supervisor, you must approve or reject documents submitted by members of your workgroup. 

To approve or reject proposed FAQ documents:
1 From the Web Agent, click the Agent Home button. 

Your browser opens to the Welcome page.

2 Select Manage Proposed FAQ from the left side of the page. 

3 Select the tenant or language of the proposed documents you want to see and click Manage 
Proposed FAQ. 

A list of pending FAQ documents for this tenant is displayed.

4 To view a proposed document, click its title in the Pending column.

5 In the Approve Document page, read the document. 

6 Click Approve or Reject from the drop-down menu.

If you rejected the document, it is removed from the drop-down menu.

Viewing Your Own DataWake Record
A DataWake� record is a list of Web pages that someone has navigated since they opened their 
browser in their current session and visited the company Web site. The section �Viewing the 
Customer�s DataWake Record,� on page 150 explains how to see your customer�s DataWake. At 
times, you may want to see your own DataWake record, in order to see pages that you browsed 
earlier.

To view your own DataWake record:
1 From the Web Agent, click Tools > DataWake. 

Your browser opens to the DataWake� Summary page.
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2 In the Agent�s Current DataWake section, click Display Session. 

The DataWake record of your current browser session is displayed.

3 Click the links to view the desired information.
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CHAPTER 7
MANAGING OUTBOUND CONTACT CALLS

Your company may assign you the responsibility of making telephone calls to customers using the 
Avaya� Outbound Contact Management feature. If so, you use information displayed in the 
Outbound Contact tab to handle automated outbound calling. 

Note:  Do not confuse Outbound Contact with Outbound List Processing. You handle automated 
outbound calls using the Outbound Contact tab. You make outbound calls manually using the 
Outbound Lists tab, described in Chapter 8, �Managing Outbound Lists�.

Outbound Contact Management initiates calls to customers while automatically displaying the 
customer information. The software guides you through the process of managing each call, from 
initiating the call to recording its outcome. 

This chapter provides you with step-by-step instructions on how to manage Outbound Contact 
calls, under the following topics:
� Using Avaya Agent with Outbound Contact
� Getting Started with Outbound Contact
� Proceeding Through Agent Tasks
� Agent Blending
� Task Summary
� Performing an Outbound Contact Job

Using Avaya Agent with Outbound Contact
If you are assigned to use Outbound Contact Management, your supervisor has set up your calling 
activities, called �jobs.� A job includes a list of customers to be called. 

As you carry out these jobs, you use areas of the Avaya Agent to help you manage your calls to 
customers. For example, you can view information about the customers in CallCenterQ and the 
Contact History Browser as you speak with them.
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The following illustration shows the Outbound Contact pane. 

Note:  Your system administrator can customize the appearance, behavior, and positioning of 
Avaya Agent. Therefore, your desktop may look and function differently from the examples 
presented in this manual.

The following frames in Avaya Agent help you manage your outbound calling activity:
� Outbound Contact pane � Shows the available jobs you can join and the activities you can 

complete during each call. You can sort the list of job names in ascending order (A-Z and 0-9) 
or descending order (Z-A and 9-0) by clicking the Job List bar.

� CallCenterQ pane � Displays information about the customer. Customer information can 
include the customer's name and address, the product the customer is interested in, and 
previous contacts with the customer. Depending on your system configuration, you may be able 
to update the customer information.

� Prompter tab (on Contact History Browser) � Displays the script you follow during your 
conversation with the customer. You enter information and select the appropriate responses 
from drop-down lists, check boxes, or radio buttons. Your script may include command buttons 
such as Yes, No, OK, Cancel, Next, or Back.

� Contact History Browser � Lists information about previous contacts your company has had 
with the same customer.

Outbound Contact 
tab

Job List bar 
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Getting Started with Outbound Contact
Outbound Contact Management displays the jobs your supervisor associated with a campaign 
(marketing goal) and your skills. In Outbound Contact Management, you speak with customers 
and manage the call whether you are learning how to use this software, handling sensitive calls 
that require time to review the customer information, or calling customers with a quick reminder.

When your supervisor sets up a job, they assign a dialing mode to the job. When setting up your 
user account, your supervisor also identifies a dialing mode that complements your skills. The 
dialing mode determines how the software:
� Dials customer numbers
� Connects you with customers
� Displays customer information

Outbound Contact Management has three dialing modes:
� Preview dialing mode � Outbound Contact notifies you of the call before it dials the customer�s 

telephone number. You can prepare for the call and review the customer�s information in 
CallCenterQ and the Contact History Browser.

� Automatic dialing mode � Outbound Contact calls the customer and notifies you about the call 
as it dials the number. The customer information and script appear on your desktop when you 
hear the ringing tone. You can review the customer�s information only after Outbound Contact 
connects you with the customer.

� Predictive dialing mode � Outbound Contact does not notify you before the call. The software 
dials the customer telephone number, displays the customer information, and connects you with 
the customer. You receive the call as the customer's information is displayed in the CallCenterQ 
and Contact History Browser, and the script is displayed in the Prompter pane.

During the job, Outbound Contact uses the appropriate dialing mode for your skills and the job. 
For example: 
� If the outbound job is set to the predictive mode and you are set to the preview mode, Outbound 

Contact uses the preview mode to connect you with the customer information before dialing.
� If the outbound job calls customers who scheduled a call from the Web, Outbound Contact uses 

the preview mode to connect you with the customer before calling.

Logging In to Outbound Contact
After you log in to Avaya Agent, you log in to Outbound Contact by making yourself unavailable 
to handle the other media channels.

Note:  To use Outbound Contact, you must log in to Avaya Agent at the workstation that has the 
Phone Type assigned to your login ID. Contact your supervisor if you cannot log in to Outbound 
Contact.

To log in to Outbound Contact:
1 Click the Media tab.
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2 Click Agent until the button changes to Busy (Aux-work or unavailable for all media channels).

Making Yourself Available for Outbound Contact Calls
To make yourself available: 
� Click the Off Break button (the coffee cup).  

Outbound Contact displays customer information on your screen, as follows:
� If the job is in preview dialing mode, you can preview the customer information before 

accepting or rejecting the call. 
� If the job is in automatic or predictive dialing mode, you see the customer information as 

Outbound Contact connects you with the customer.

Joining Outbound Jobs
Using the Outbound Contact tab, you select one or more jobs, join the jobs, and �go off break� to 
become available to handle calls. Outbound Contact begins the process of connecting you with 
customers. 

To join a job:
1 Click the Outbound Contact tab.

2 Select the jobs your supervisor tells you to join on the Job Name list. 

Tip:  To display the list of jobs in ascending (A-Z and 0-9) or descending (Z-A and 9-
0) order, click the bar above the list of job names.

� To select a series of consecutive jobs, press the Shift key. Then click the first and the last job 
name. 

� To select more than one job individually, press the Control key while you click each job 
name.

3 Click Join Job.

The icon preceding the job name changes from a closed red lock to a coffee cup ready for you 
to go off break, as shown in the following illustration:

 After you join one or more jobs, you are ready to manage Outbound Contact calls.
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Previewing a Customer�s Information
When the Outbound Contact calls a customer using the preview dialing mode, the software 
notifies you of the call and displays the customer information and script. This makes it possible for 
you to prepare for the call. 

You decide whether to accept or reject the call before the Outbound Contact calls the customer. If 
you reject the call, the software passes you information for the next customer that matches your 
profile.

Proceeding Through Agent Tasks
After you log in to Avaya Agent, you log in to the Outbound Contact channel. You handle most of 
the calling activity from the Status Control bar on the Outbound Contact tab. 

As you proceed through each task, Outbound Contact enables and disables buttons that show the 
tasks you can do next. Your outbound calling tasks include the following:

Button Button Name Action

Accept Use to accept the call to the customer. Outbound Contact 
dials the customer�s telephone number and connects you 
with the customer.

Reject Use to reject the call to the customer. Outbound Contact 
Management retrieves the next appropriate customer 
information and displays it on your screen. 

Button Action

Join Job

Select and join one or more jobs that your supervisor started. Select jobs from 
the Available job list.
Click Join Job.

Off Break

Click Off Break on the toolbar to tell Outbound Contact you are changing from 
an unavailable (coffee cup) state and are ready to handle calls. The cup 
changes to the pressed coffee cup.

  

Accept Reject

If the job is set to the preview dialing mode, you can accept or reject talking to 
customers by previewing the customer information in CallCenterQ and the 
Contact History Browser. 
Click Accept to dial the number and speak with a customer. Outbound Contact 
enables the appropriate toolbar buttons.
Click Reject to not make this call. Outbound Contact enables Proceed. To 
continue with the next call, click Proceed.
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OK

Cancel

Next

Back

During the job, you can read the script in the Prompter pane to greet your 
customer and ask questions. During your conversation, you move from 
question to question by clicking the appropriate button. You can record the 
customer's responses and update the customer information in the 
CallCenterQ pane.

During your conversation, you may need to record information about calling the customer in the future.

Reschedule 

OK

To reschedule the call for a different day or time of day, click Reschedule on 
the toolbar to specify the time, date, and an agent to handle the call.

Do Not Call

OK

If the customer asks not to be called again, click Do Not Call on the toolbar. In 
the Do Not Call dialog box, you can add a reason for the customer�s request. 
Click OK to continue with the next call.

 

No Contact

OK

During the calling activity, you may handle an outbound call that did not 
connect with a customer. 
Outbound Contact displays the No Contact dialog box with a notice about the 
unsuccessful call, and prompts you to confirm the reason. When you click OK, 
Outbound Contact records the call result for you.

 
Close

OK

When you complete your conversation, click Close on the toolbar. 
Outbound Contact displays the Wrapup Code dialog box for you to record the 
call result. Click OK.
Complete the customer information, if necessary. 

Proceed

Click Proceed on the toolbar to record the call result, and indicate that you are 
ready to speak with the next customer. 

Button Action
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Identifying an Unsuccessful Call
Occasionally, Outbound Contact Management cannot contact the customer. If you are in preview 
or automatic mode when this occurs, you hear a telephony tone through your headset. 

Instead of speaking with the customer, you click the reason for the unsuccessful call in the No 
Contact dialog box and click OK. Outbound Contact marks the customer�s information to call the 
customer at a later time during the job. The No Contact dialog box looks like this.

The call is unsuccessful when Outbound Contact Management detects one of the following tones:

During the day, you can take a break, join additional jobs, or leave one or more jobs without logging out of 
the Outbound Contact. 

On Break

Click On Break on the toolbar to indicate that you want to change your calling 
activity from available to unavailable.

Leave Job

To log off from a job, select one or more jobs from the Available jobs list, and 
click Leave Job. Outbound Contact no longer connects you with calls on the 
job you leave. 

Tone Description

Answering machine An answering machine answered the telephone call.

Busy The telephone number was in use.

Fast Busy The public switched telephone network (PSTN), rather than the telephone, was 
busy.

Button Action
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To record the No Contact call:
1 Click the No Contact button. 

2 Verify or correct the selected reason from the No Contact dialog box, and click OK. 

3 Click Proceed when you are ready to speak with another customer. 

Outbound Contact connects you with the next customer.

Managing the Conversation
After you receive a call, begin your conversation with the customer by reading the script 
associated with the job and recording the customer�s responses. Avaya Agent displays the script in 
the Prompter. You may need to click the Prompter to begin. The script text is based on your 
conversation and the customer�s responses to your questions. 

During the conversation, the customer may ask that you reschedule the call or that you do not call 
again. 

Rescheduling a Call

You can reschedule a call to occur later in the day or on another day. You can also specify whether 
a specific agent or any agent can handle the call. The Outbound Contact Management records the 
customer�s request after you end the conversation.

Note:  Outbound Contact calls the customer based on the customer�s local time.
 

Special Information 
Tone (SIT)

You heard a SIT code when connected.

No Answer No one answered the telephone call.

Fax machine A fax machine answered the telephone call.

Modem A telephone modem answered the telephone call.

Tone Description
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To reschedule a call:
1 Click the Reschedule button. 

The Reschedule Call dialog box is displayed, as shown in the following illustration:

2 On the Date and Time tab:

� To set the date, click the date on the calendar. To select a different month, click the left or 
right arrow button to scroll to the preceding or following month.

� To set the time, click the up or down arrow button to scroll to an earlier or later time of day. 
You can also type the time in the hour and minute fields. 

Note:  The Outbound Contact displays time based on the 24-hour clock. For 
example, 1:30 p.m. is 13:30.

3 On the Required Agent tab, select an agent to handle the rescheduled call.

Select a specific agent or select Any to have Outbound Contact assign the rescheduled call to 
the next available agent. 

4 Click OK to close the Reschedule dialog box.

5 Click Proceed. 

Outbound Contact marks the call result and connects you with the next customer.

Tip:  When you or another agent speak with a customer who requested to reschedule a call, 
Outbound Contact displays a message that indicates that this is a rescheduled call. You may want 
to mention to the customer that they requested this rescheduled call. 
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Adding the Customer to the Do Not Call List

If the customer requests never to be called again, follow this procedure.

To add the customer to the Do Not Call list:
1 Click the Do Not Call button.

The Do Not Call dialog box is displayed.
 

2 In the text box, add a description to explain why the customer wants to be added to the Do Not 
Call list. 

3 Click OK.

Outbound Contact Management ends the call, adds the customer�s telephone number to the Do 
Not Call list, and records the customer�s request in the database.

Handling Stray Calls

Occasionally, Outbound Contact passes you an unexpected call, referred to as a stray call. This is 
an inbound call that is not related to the job or jobs you joined. 

When you receive a stray call, Outbound Contact passes the call to you without the customer 
information. Outbound Contact displays the Stray Call dialog box and prompts you to click OK. 

A stray call can occur under the following conditions:
� You are not actively speaking with a customer, and a customer calls your extension
� Avaya Agent passes an inbound call to your extension through the Private Branch Exchange 

(PBX)
� You are reviewing customer record information
� You are on a break
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Outbound Contact completes the fields on the Stray Call Information dialog box, as shown in the 
following illustration:

The following table describes each field in the dialog box:

The way you can handle the stray call depends on what you are doing and on whether you are 
using Auto Answer. Follow the directions in the appropriate section below.

To handle a stray call when you are handling an outbound call:
1 When the Stray Call dialog box informs you that a stray call has come in, excuse yourself to the 

customer you were talking to, and put that customer on hold.

2 Click OK in the dialog box.

You hear a ringing tone for the stray call.

3 Complete the outbound call with the customer.

4 Click Close to end the call.

5 In the WrapUp dialog box, select the outcome of the call and click OK.

Field Description

Dialed Number The number that the caller dialed.

Calling Number The caller's telephone number. The field may be blank if the calling line information 
is unavailable.

Personal 
Identification

The Personal Identification Number that the customer entered before Outbound 
Contact connected you with the call.

Job Name The job that originated the call.
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6 Click the Media tab in the Avaya Agent.

7 Using your desktop telephone, answer the stray call.

8 Click Close to end this call.

9 In the WrapUp dialog box, select Stray Call and click OK.

10 Click the Outbound Contact tab in the Avaya Agent.

11 Click Proceed to prepare for the next call.

Outbound Contact records the event and connects you with the next customer.

If you receive a stray call when you are not handling an outbound call, the way you handle the call 
depends on whether your agent phone is configured for Auto Answer. 

To handle a stray call when you are not handling an outbound call and you are using Auto 
Answer:
� When Outbound Contact displays the Stray Call dialog box, click OK.

Outbound Contact disconnects the stray call.

To handle a stray call when you are not handling an outbound call and you are using Auto 
Answer:
1 When Outbound Contact displays the Stray Call dialog box, click OK.

You will hear a ringing tone for the stray call.

2 Click the Media tab.

3 Using your desktop telephone, answer the stray call.

4 End your call.

5 In the WrapUp dialog box, select Stray Call and click OK.

6 Click the Outbound tab.

7 Click Proceed to prepare for the next call.

Caution About Transferring a Call

Do not transfer an outbound call to another outbound agent or create a conference call. Instead, 
you can reschedule the call and assign the agent that you would like to work with the customer 
concerning the current call. Explain to the customer that you would like for another agent to call 
them and ask the customer for a convenient time for the call. Then select the agent�s name and 
enter the time for the rescheduled call. 
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Completing the Call

Before you complete the call, you must end your conversation, record the customer�s responses, 
and update the customer information. To complete the call, you record the result of the call using 
an outcome code. 

To complete and end the call:
1 Click the Close button.

Outbound Contact displays the WrapUp dialog box, open to the Outbound Result category.

Note:  The list of outcomes that you see may be different from those shown in the 
illustration. Contact your system administrator for help with your company�s 
customized outcomes.

2 Select the appropriate outcome that describes the result of the call, and click OK. 

Caution:  You must select the outcome and click OK (Step 2) before clicking the Proceed button 
(Step 3). If you do not do this, your contact center will not have a record of the call.

Outbound Contact marks the customer�s information in the database with the appropriate 
outcome code and disables all buttons except Proceed.

!
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3 Click the Proceed button when you are ready for the next call. 

Outbound Contact ends the script and connects you with the next customer.

Depending on the dialing mode, you can preview the next customer�s information before 
connecting with the customer.

Managing Nuisance Calls

If you see �Nuisance Call� in the message box when you speak with a customer, Outbound 
Contact previously called the customer during the job but could not connect the customer with an 
agent.

Tip:  During your conversation, you can apologize for the problem that caused the nuisance call. 
Your supervisor can tell you exactly what you should say to customers who have received a 
nuisance call.

Pausing Outbound Contact Calling

When you �go on break,� you signal the Outbound Contact that you are unavailable to handle 
outbound calls. When you want to resume handling outbound calls, you �go off break� to signal 
the software that you are available for calls. 

Taking a Break

You can indicate that you want to �go on break,� any time during the job. Your break becomes 
effective after you complete the conversation and end the call. 

To take a break:
� Click the On Break button.

Outbound Contact enables the Status Control button indicating that you are unavailable to handle 
outbound calls or speak with customers. The icon preceding the job in the Job Name list changes 
from a lock to a coffee cup.

Returning to Work

After your break, you resume handling calls by �going off break.�

To return to work:
� Click the Off Break button.  

Outbound Contact deactivates the button. The icon preceding the job in the Job Name list changes 
from a coffee cup to a lock.
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Leaving Outbound Jobs
You can leave one or more jobs at the same time. For example, you would leave a job when your 
supervisor wants you to concentrate on a specific calling activity, you are going on a break, or your 
workday is ending. 

To leave a job:
1 Complete the current call.

2 Click On Break. 

3 Click the job or jobs you want to leave.

� To select a series of consecutive jobs, press the Shift key. Then click the first and the last job 
name. 

� To select more than one job individually, press the Control key while you click each job 
name.

4 Click Leave Job on the Outbound Contact tab.

The icon preceding the job in the Job Name list changes from an open blue lock to a closed red 
lock.

Note:  You are still logged in to Avaya Agent. You can continue to use the channels 
on the Avaya Agent Media pane channels and Avaya applications. 

To return to outbound calling:
1 Click the Off Break button. 

2 Click one or more jobs. 

3 Click Leave Job on the Outbound Contact tab.

The icon preceding the job in the Job Name list changes from a coffee cup to a closed red lock.

You are still logged in to Avaya Agent. You can continue to use the channels on the 
Avaya Agent Media pane channels and Avaya applications. 

To return to outbound calling:
1 Click the Off Break button. 

2 Click one or more jobs. 

3 Click Leave Job on the Outbound Contact tab.
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Logging Out of Outbound Contact
After you leave one or more outbound jobs, you can log out of Outbound Contact using the Media 
tab and Agent menu. For more information on logging out of Avaya Agent, see �Logging Out of 
Avaya Agent,� on page 45.

To log out of Outbound Contact:
1 Leave each outbound job.

2 On the Media tab, click Agent until the icon changes to Agent Aux status.

3 On the Agent menu, click Exit.

Agent Blending
You may have been assigned to handle both inbound calls (using the Media tab) and Outbound 
Contact calls (using the Outbound Contact tab). If you are available for both types of calls, 
Outbound Contact Management suspends you from handling inbound calls when you are handling 
outbound calls. Then you can handle the outbound call without being disturbed.

Outbound Contact blends the activities you can do based on your skills and outbound jobs. 
Outbound Contact uses the Agent Blending parameters set for the jobs to help determine:
� Whether you can blend your work across Outbound Contact and other media channels 
� When you move out of the Outbound Contact channel
� When you return to the Outbound Contact channel

Releasing You from Outbound Contact
During a job, when one of the media channels requires more agents than the automated outbound 
calling requires, Outbound Contact begins to move you and other agents from the outbound calling 
activities. 

In this case, after you complete your current call, Outbound Contact performs the following 
actions:
� Places you �on break�
� Releases you from each outbound job you joined
� Makes the Media tab active

When you are released, you can receive incoming media contacts or manage outbound lists. 
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�Acquiring� You from Media Channels
When the automated outbound calling activities require more agents than the other media channels 
require, Outbound Contact �acquires� agents (makes the agents available for outbound calling 
again).

Avaya Agent performs the following actions so that Outbound Contact can acquire you:
� Displays the word �Outbound� below the Status Control bar on the Media tab
� Resets your channel load for each channel to zero
� Moves you to the Outbound Contact tab
� Rejoins you to the jobs you originally joined

Note:  To join additional jobs, click each job. Then click Join Job.

To resume your Outbound Contact activities:
� Click the Off Break button.

You can now resume handling automated outbound calls.

For more information, see �Joining Outbound Jobs,� on page 182 and �Making Yourself Available 
for Outbound Contact Calls,� on page 182. 

Task Summary
The following table summarizes the tasks you complete during your calling activities:

Task Button Action

Start calling activities

 
Join Job

Off Break

Select one or more jobs. 
Click Join Job. 

Click the Off Break button. 

Take a rest

On Break

Click the On Break button. 

Resume calling activities

Off Break

Click the Off Break button. 
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Performing an Outbound Contact Job
In the following example, your supervisor assigned you to the Automobile Preference campaign. 
One of the jobs you joined is named Auto Manufacturer. This name is displayed in the field below 
the list of job names. During this job, you speak with a potential customer who attended the annual 
Automobile Show. 

This job is set for predictive dialing. Outbound Contact calls each customer and connects you with 
the customer and their information immediately. During your conversation, you record their 
responses to the Show script.

As you begin the day, you log in to Avaya Agent from the Start menu.

Join more jobs

On Break

 
Join Job

Off Break

Click the On Break button. 

Select one or more jobs.

Click Join Job. 

Click the Off Break button. 

Leave one or more jobs

On Break

 
Leave Job

Off Break

Click the On Break button. 

Select one or more jobs.

Click Leave Job. 

Click Off Break to resume outbound calling 
activities.

Log out of Outbound 
Contact

Available

Click the Media tab.
Click the Agent button until the Agent State 
changes to Available. This makes you available 
for inbound Voice, Email, and Chat.

Exit Avaya Agent Click Avaya Agent > Exit to log off Avaya Agent. 
If a logout dialog box is displayed, select a 
reason code and click OK.

Task Button Action
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1 Double-click the Avaya Agent icon on the Windows task bar, or click Start > Programs > Avaya 
Interaction Center 6.0 > <name of the Business Application, such as CallCenterQ, CustomerQ, 
or HRQ>.

The Avaya Agent Login dialog box is displayed.

2 On the Avaya Agent Login tab, type your login ID and password. 

The Avaya Agent displays the agent desktop as follows: 

� CallCenterQ displays customer information agents can update.
� Contact History Browser displays prior contacts with the customer.
� EDU Viewer displays call information. 
� Prompter displays the script you use during the job.

3 Click the Outbound Contact tab to begin your calling activities.

Outbound Contact displays a list of jobs that match your skills.

4 Select three predictive dialing mode jobs and click Join Job. 

Outbound Contact joins you to the jobs and begins calling customers.

The customer's information is displayed in the CallCenterQ, Contact History Browser, 
Prompter, and EDU Viewer panes, just as the customer's data is displayed in the email and Web 
channels.

The Status Control bar buttons (Call Back, Reschedule, Do Not Call, Close, and Proceed) 
become enabled. The customer number is displayed in each pane.

5 Greet the customer and click the Prompter tab in the Contact History Browser.

The Show script, a simple survey of prospective car buyers, is displayed in the Prompter.

6 During your conversation, you read the script and record the customer�s answers. Soon after 
you begin your conversation, the customer asks you to reschedule the call later in the week, any 
time after 5 p.m. The customer asks to speak with you, not another agent, on the rescheduled 
call.

7 Before closing your conversation, click the Reschedule button on the Status Control bar to set 
up when the customer would like to be called back later in the week (any time after 5 p.m.). 
Indicate that the customer would like to speak with you.

a Reschedule the date and time of the call on the Date and Time tab.
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b Click your name on the list on the Required Agent tab, and click OK.

8 To complete the call and speak with the next customer, click the Proceed button. 
Outbound Contact displays new customer information on the desktop as it connects you with 
the customer.

9 During the next call, the customer requests to be put in the contact center�s Do Not Call list for 
this campaign. 
a End the conversation.

b Click the Do Not Call button.

c Provide an explanation for this request and click OK.

10 To complete the call and speak with the next customer, click the Proceed button. 

11 After two hours, it is time for your morning break. You want to make yourself unavailable to 
speak with customers but you do not want to leave any of the jobs.

From the Status Control bar, click the On Break button. 

Outbound Contact updates the icons that are associated with each job you joined. A coffee cup 
replaces the blue open lock. 

12 When you return from your 10-minute break, click the Off Break button from the Status 
Control bar. 

Outbound Contact updates the icons that precede each job replacing the coffee cup with the 
blue open lock. 

13 When you complete your calling activity, you complete your call, make yourself unavailable 
for outbound calls, and leave the jobs, as follows:

a From the Status Control bar, click the Proceed and On Break buttons.

b On the Outbound Contact tab, click Leave Job. 

Outbound Contact removes you from each job. As you leave a job, the software changes the 
icons that precede each job from a blue open lock to a red closed lock. 
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CHAPTER 8
MANAGING OUTBOUND LISTS

The Outbound List Processing component of Avaya Agent handles customer lists for outbound 
campaigns that you dial manually. With Outbound List Processing, you initiate telephone calls 
using Softphone.

Note:  Do not confuse Outbound List Processing with Avaya� Outbound Contact Management. 
You make outbound calls manually using the Outbound Lists tab. You handle automated outbound 
calls using the Outbound Contact tab, described in Chapter 7, �Managing Outbound Contact 
Calls�. 

This chapter contains the following topics:
� Overview of Outbound List Processing
� Making Calls with Outbound Lists

Overview of Outbound List Processing
Your system administrator can create multiple customer lists in CallCenterQ. These lists pass to 
the Outbound Lists tab. Each outbound list contains a group of customers who are related, such as 
customers who are located in the same area or who purchased the same product. Use the Outbound 
Lists during outbound campaigns to call customers and notify them about upcoming sales and 
marketing events. 

When you select an outbound list, Outbound List Processing selects the first customer on the list 
and displays basic information about that customer on the Outbound Lists tab. 
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The Avaya Agent Outbound Lists tab looks like this: 

As you complete calls to customers, Outbound List Processing cycles through the next customers 
in the list. The Outbound Lists tab displays the name of the associated campaign, the marketing 
event, the list name, and the customer information. Depending on how your system administrator 
configured Avaya Agent, Outbound List Processing may also do the following:
� Sort the lists by priority and select a customer from the highest priority list
� Set the maximum number of times to call a customer for a specific list, and when that limit is 

reached, set the customer�s status to Unreachable and not call the customer again
� Set the length of time between attempts to call a customer if the result of a call is Busy, 

Answering Machine, or No Answer

Note:  If your system administrator set up the list to coordinate with CallCenterQ, Avaya Agent 
also displays the associated CallCenterQ focus and the customer�s record information.

List management icons

The name of the marketing campaign 
associated with this list

The name of the specific marketing 
event associated with this list

The name of the list

Customer�s name with some brief details 
selected by the system administrator

The number of times this 
customer has been called 
from this particular list

Information about the previous call 
made to this customer

When the call is completed, click a 
result from this drop down list

Next Customer Place Call Done

Cancel
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Making Calls with Outbound Lists 
If you are using Outbound List Processing, you use a list of customers in the Outbound Lists tab 
and Softphone to make calls. 

To use Outbound List Processing to contact customers:
1 Log in to Avaya Agent. For logging in details, see �Logging In and Logging Out,� on page 41.

2 Click the Outbound Lists tab and bring that component to the front.

3 To start your call, click Next Customer. 

Outbound List Processing selects the first customer from the list and fills the Outbound Lists 
tab with the customer�s information. Depending on your system configuration, Avaya Agent 
may display the customer record information or leave the customer list information visible in 
the appropriate CallCenterQ focus.

4 To dial your call to the customer, click the Place Call icon.

5 When the customer answers, read the script in Prompter. 

6 Record the customer�s information and responses in the script fields.

7 Click the appropriate outcome of the conversation from the Result list.
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8 When you are finished, click the Done icon.

9 To call the next customer on your list, repeat from Step 3.
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CHAPTER 9
USING AVAYA AGENT WITH SIEBEL

If your contact center uses Avaya Agent with a Siebel eBusiness Application, you can use most of 
the instructions in previous chapters. However, some Avaya Agent tasks function differently with 
Siebel eBusiness Applications. Those tasks are presented in this chapter.

The chapter includes the following topics:
� Comparing Avaya IC and Siebel Terms
� Logging In to Siebel Call Center
� Answering Contacts with Siebel Call Center
� Viewing Contact Information with Siebel Call Center

Note:  The examples and illustrations in this chapter use the out-of-the-box implementation of 
Avaya Agent and Siebel Call Center. If your contact center uses a different Siebel eBusiness 
Application, contact your administrator for help with the custom implementation.

If you have Siebel Call Center in your Avaya Agent desktop, whenever you answer a contact 
(Voice, Email, or Chat) in Avaya Agent, the contact information is displayed in Siebel Call Center. 
You then enter and save information about the contact in Siebel Call Center. When you close the 
Avaya� Interaction Center (Avaya IC) contact, Avaya Agent maintains a history for the contact 
and links it to the activity and contact record in Siebel Call Center.
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Avaya Agent looks like this with Siebel Call Center in the desktop:

For information about using Siebel Call Center, see your Siebel Call Center documentation and 
online help.
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Comparing Avaya IC and Siebel Terms
The Avaya� Interaction Center (Avaya IC) and Siebel eBusiness Applications use the following 
similar terms that are applied differently in the two systems:

Logging In to Siebel Call Center
The Login dialog box for Avaya Agent has several tabs, including one for your Siebel application. 
When you enter your login ID and password to log in to Avaya Agent, the information is 
automatically entered into the other tabs. Your Siebel application automatically opens and 
minimizes.

If you have a login ID or password for Siebel Call Center that is different from the login ID or 
password for Avaya Agent, you enter the Siebel login ID and password in a tab of the Avaya Agent 
Login dialog box.

Note:  For information about your login ID and password, see your system administrator.

To log in to Siebel Call Center with a different login ID and/or password:
1 Click Start > Programs > Avaya Interaction Center 6.0 > Avaya Agent.

If you have an Interaction Center application icon on your desktop, you can start Avaya Agent 
by double-clicking the icon.

2 Enter your Avaya Agent login ID and password in the Avaya Agent Login tab.

3 In the Siebel Application tab of the Avaya Agent Login dialog box, enter your Siebel login ID 
and password. 

Term in Avaya IC
Term in Siebel 
eBusiness 
Applications

Description

Customer Contact Person initiating the interaction into Avaya Agent.

Contact Activity A single interaction with an Avaya IC customer, in any of the 
following media channels:
� Telephone call (Voice contact)

� Email message (Email contact)

� Chat session (Chat contact)

With Siebel eBusiness Applications, the term Activity also 
includes any interaction or any action performed for a contact 
(or any other object in Siebel).



Chapter 9   Using Avaya Agent with Siebel

206 Avaya Agent User�s Guide

4 Click OK.

If your login ID and password are valid, Avaya Agent and Siebel Call Center are started on 
your desktop. Siebel Call Center opens minimized.

Logging Out of Siebel Call Center with Pop-Up Menu
You can use the Avaya Agent pop-up menu to log out of Siebel Call Center. You access the menu 
by right-clicking in a grey area of Avaya Agent.

The login and logout options in the Avaya Agent pop-up menu change, depending on whether you 
are currently logged in to Siebel Call Center. For example, if you are logged in to a media channel, 
you see the Logout option in the menu, not the Login option. The pop-up menu with the Logout 
option looks like this:

To log out of Siebel Call Center from Avaya Agent:
1 Right-click a blank area of Avaya Agent.

2 From the menu, click Siebel Application > Logout.

Logging In to Siebel Call Center with Pop-Up Menu
From within Avaya Agent, you can use the pop-up menu to open, or log in to, Siebel Call Center. 
You access the menu by right-clicking in a grey area of Avaya Agent.

To log in to Siebel Call Center from Avaya Agent:
1 Right-click a blank area of Avaya Agent.

2 From the menu, click Siebel Application > Login.

3 In the Interaction Center Client Login dialog box, enter your login ID and password in the 
Siebel Application tab.

4 Click OK.

Login/logout menu option when 
logged in to Siebel Call Center
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Answering Contacts with Siebel Call Center
When a contact arrives in your contact center, Interaction Center creates an EDU
(electronic data unit) for that contact. It then forwards the contact to the first available agent (using 
the rules set up by your system administrator). 

All of your contacts are delivered to the appropriate task list of your Media pane. When you 
answer a contact, Avaya Agent looks up the record. It then places the information in a Contact 
record in Siebel Call Center for the contact. For email and chat contacts, Avaya Agent uses the 
subject line that customers typed in their email or their chat request. 

If your system has no previous record for that contact, the Siebel contact opens as an Unknown 
Contact. You must update that record with contact information before wrapping up the contact. For 
more information, see �Updating a Siebel Contact Record,� on page 208.

Avaya Agent automatically links the new Siebel contact with the Avaya IC contact. After you 
close the contact, the system creates an Avaya IC contact history for the Siebel contact.

For more information about handling contacts in Avaya Agent, see:
� �Handling a Basic Voice Contact,� on page 75
� �Composing a Normal Email Reply,� on page 94
� �Handling a Basic Chat Session,� on page 124

Handling Screen Pops
Screen pops are dialog boxes that are displayed on your screen when an incoming Avaya IC 
contact is assigned to you. The dialog box asks if you want to accept the contact at this time. When 
the contact is a Siebel Call Center contact, if you click Yes in the screen pop, the Siebel contact 
and associated activities are displayed in the Contact screen of Siebel Call Center, along with 
customer information from the Avaya IC contact. 

Depending on how the system administrator configured your system, Avaya Agent automatically 
displays screen pops in Siebel Call Center with any of the following events:
� First incoming contact � When the first contact is assigned to you after you logged in or after 

you wrapped another contact. Screen pops are not automatically displayed for subsequent 
contacts until you wrap the first contact. 

� Contact activation � When you activate a contact in Avaya Agent by double-clicking the 
contact in your task list, or you take a voice contact off hold. 

� Any incoming contact � When a contact arrives in a task list, whether you have another active 
contact or not.

If your system restricts automatic screen pops to the first incoming contact or to contact activation, 
you can perform a manual screen pop for other new and inactive contacts in the Avaya Agent task 
lists. Siebel Call Center automatically displays the contact record for the contact that is active in 
Avaya Agent.
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To perform a manual screen pop on an Avaya IC contact:
� Press Alt+S.

OR

� Right-click a grey area of Avaya Agent and click Screen Pop from the pop-up menu, as shown 
in the following illustration.

If you only have one contact, Avaya Agent automatically displays a screen pop. If you have more 
than one contact, Avaya Agent opens a dialog box where you can choose from a list of all contacts 
in your task lists.

Updating a Siebel Contact Record
If your contact center has no previous record for a Siebel contact, Avaya Agent uses a pop-up of a 
contact record and associated activities called Unknown Contact in Siebel Call Center. The 
Unknown Contact information appears in the Contact area, as shown in the following illustration:
 

You update the Unknown Contact record to ensure that Avaya Agent can maintain a contact 
history for the Siebel contact. How you create the new record depends on the type of contact. For 
telephone and email contacts, where Avaya Agent has a telephone number or email address, you 
can update the record in Siebel Call Center. For chat contacts, where Avaya Agent knows the new 
customer only as �guest,� you create a user with the Prompter pane of Avaya Agent.

Note:  If you are unable to update a Siebel contact record, contact your administrator for 
assistance. This task may not be available to you.

Click this menu option to 
perform a screen pop
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For voice and email contacts, where Avaya Agent displays a contact record in Siebel Call Center, 
the record opens with the following:
� Unknown in the First Name field 
� Contact in the Last Name field
� Unique contact information (depending on the type of contact):

� For voice contacts, the telephone number in the Work # field
� For email contacts, the email address in the Email field.

Avaya Agent uses the unique contact information to link the Siebel contact record to the Avaya IC 
contact history.

To update a contact record in Siebel Call Center:
1 In the First Name field, delete Unknown and enter the customer�s first name.

2 In the Last Name field, delete Contact and enter the customer�s last name.

3 Enter the customer�s information in the remaining fields. 

4 Click in an open grey area of the Contact section of Siebel Call Center to save the Siebel 
contact record.

Answering a Chat Contact from a New Customer
In this example, Jane Connor logs in to the company Web site. Because this is the first time Jane 
has asked for help and her license information is not easily available, she logs in as a �guest user.� 
She browses through the Help pages on the company Web site, but cannot find any information to 
resolve her problem.

Jane Connor has a service agreement with the company, which gives her up to 10 hours free 
support each year. Therefore, she decides to get help directly from the contact center, which 
requires her to be a registered user. After a brief search, she locates her license information and 
creates a customer record for herself on the company Web site. She then requests a chat contact 
with an agent.

You are available for a chat, and Jane Connor�s contact is routed to your Chat task list.

To answer the chat contact:
1 Double-click the chat contact in your Chat task list.

� The Web Agent opens on your desktop and displays Jane Connor�s chat contact.



Chapter 9   Using Avaya Agent with Siebel

210 Avaya Agent User�s Guide

� Avaya Agent builds an activity for Jane Connor in Siebel Call Center, as shown in the 
following illustration.

2 In the Web Agent, read the customer�s question in the scroll box above the Transcript area. You 
may need to scroll to see the customer�s entire question.

The Contact pane of Avaya Agent, shown in the following illustration, displays the following:

� An empty history in the Contact History Browser 
� Information about the current contact in the EDU Viewer.

3 In Siebel Call Center, review the activity built by Avaya Agent for information about Jane 
Connor and the contact, in the following two areas:

� The Contact area shows the information stored in the system about Jane Connor. 
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� The Activity area includes the details about the contact provided by Avaya Agent and a link, 
under Activity Type, to the contact in the Web Agent.

4 Search the Siebel Call Center for customer activity records that match the information by Jane 
Connor. 

For the purposes of this example, you do not find an activity record for Jane Connor.

5 In the Text Entry area of the Web Agent, respond to Jane Connor by asking her for more details. 
Ask her whether she ever had this problem before.

6 Click Say to send your response to Jane Connor.

Jane Connor responds with the requested details, saying that she never had any problems with 
the product before. 

7 Avaya Agent links the activity in Siebel Call Center to Jane Connor�s current contact and 
begins a contact history for Jane Connor.

8 You find the answer to Jane Connor�s question in the Self-Service FAQ, including the location 
of the information on your company Web site. You type the URL to the Web page in the Text 
Entry area of the Web Agent and click Send URL.

9 To end the chat contact, you click Wrap and record the wrap-up information for the contact.

Siebel Call Center closes the activity. Avaya Agent closes the contact and saves the contact 
history details in the Avaya� Interaction Center database.

Viewing Contact Information with Siebel Call Center
Siebel activities and associated Siebel contact records are linked to an Avaya IC contact by Avaya 
Agent. When you wrap up a contact, Avaya Agent saves certain details of that contact in IC 
Repository, including:
� Type of contact (Voice, Email, or Chat)
� Date and time that the contact was received
� Subject line (for email and chat contacts)
� A unique tracking number

If you receive a contact from the same Siebel contact, Avaya Agent does the following:
� Displays a screen pop of the Siebel contact in Siebel Call Center, filling the Contact and 

Activities areas with the contact information.
� Displays details of the current Avaya IC contact in a tab of the EDU Viewer in Avaya Agent.
� Displays details of previous contacts from the Siebel contact in a tab of the Contact History 

Browser in Avaya Agent.
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The EDU Viewer and the Contact History Browser are located in the Contact pane of Avaya 
Agent, as shown in the following illustration. To view details of a previous contact, double-click a 
contact in the Contact History Browser. Avaya Agent displays the linked Siebel activity into Siebel 
Call Center, in addition to the actions described in �Viewing Contact Information with Siebel Call 
Center,� on page 211.

Note:  Current information about an active Avaya IC or Siebel contact does not appear in the 
Contact History Browser until you have wrapped up that contact.

Contact History Filter

Active Contact ViewerContact History Browser

EDU Viewer
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216 Avaya Agent User�s Guide



Index
tab 22, 180
unsuccessful calls 185
Web Scheduled Calls 181

Outbound List Processing 199
calling customers 201
overview of 20
tab 14

outcome information 68
overview of Avaya Agent 14

P
Page Push 131
panes 14

CallCenterQ 180
history 180
Outbound Lists 20
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